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Introduction

Safety precautions
The following precautions ensure the proper use of the product and prevent the product from being
damaged. Follow these precautions at all times.
●

Use the power supply voltage specified on the label. Avoid overloading the product's electrical
outlet with multiple devices.

●

Ensure the product is well-grounded. Failure to ground the product may result in electrical shock,
fire and susceptibility to electromagnetic interference.

●

Do not disassemble or repair the product yourself. Contact your local HP Service Representative
for service, see Contact HP Support on page 191.

●

Use only the electrical cord supplied by HP with the product. Do not damage, cut or repair the
power cord. A damaged power cord has risk of fire and electric shock. Replace a damaged
power cord with an HP-approved power cord.

●

Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of
the product. Doing so may cause fire, electric shock or other serious hazards.

●

Turn off the product and unplug the power cable from the power outlet in any of the following
cases:
◦

When placing your hands inside the product

◦

If there is smoke or an unusual smell coming from the product

◦

If the product is making an unusual noise not heard during normal operation

◦

A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal
parts of the product

◦

During a thunderstorm

◦

During a power failure

Product models
This guide covers the following product models, normally referring to them by their short names for
brevity.
Full name

Short name

Part number

HP Designjet T2300 eMFP

T2300

CN727A

HP Designjet T2300 PostScript® eMFP

T2300 PS

CN728A

HP Start-up Kit
The HP Start-up Kit is the DVD that comes with your product; it contains the product's software and
documentation.

Using this guide
This guide can be downloaded from the HP Knowledge Center (see Knowledge Center on page 189).
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Introduction
This chapter provides a brief introduction to the product and its documentation for new users.

Use and maintenance
These chapters help you carry out normal product procedures and include the following topics.
●

Installing the software on page 14

●

Setting up the product on page 25

●

Personalizing the product on page 36

●

Printer paper handling on page 41

●

Working with two rolls on page 54

●

Printing on page 56

●

Scanning on page 74

●

Copying on page 77

●

Job queue management on page 79

●

Color management on page 87

●

Practical printing examples on page 100

●

Retrieving usage information on page 123

●

Handling ink cartridges and printheads on page 127

●

Maintaining the product on page 138

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.
●

Troubleshooting printer paper issues on page 155

●

Troubleshooting ink cartridge and printhead issues on page 168

●

Troubleshooting other printer issues on page 176

●

Troubleshooting scanner issues on page 178

●

Troubleshooting print-quality and scan-quality issues on page 180

●

Troubleshooting general product issues on page 181

●

Front-panel error messages on page 185

Accessories, support and specifications
These chapters, Accessories on page 148, HP Customer Care on page 188 and Product
specifications on page 193, contain reference information, including customer care, the product
specifications and part numbers for paper types, ink supplies and accessories.

ENWW
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Glossary
The Glossary on page 197 contains definitions of printing and HP terms used in this documentation.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions
The following symbols are used in this manual to ensure the proper use of the product and to prevent
the product from being damaged. Follow the instructions marked with these symbols.
WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal
injury or death.
CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal
injury or damage to the product.
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Main features
Your product is a color inkjet printer designed for printing high-quality images on paper up to 1118
mm (44 in) wide, with an integrated color scanner capable of scanning images up to 914 mm (36 in)
wide and 2378 mm (93.62 in) long. Some major features of the product are shown below:

ENWW

●

Print resolution of up to 2400 × 1200 optimized dpi, from a 1200 × 1200 dpi input, using the
Best print-quality option, the Maximum Detail option and photo paper

●

Scan resolution of up to 600 dpi, in RGB color with 24 bits per pixel, or grayscale with 8 bits per
pixel, or black and white with 1 bit per pixel

●

The product can be controlled from its front panel or from a remote computer using the Embedded
Web Server or the HP Utility

●

Touch-sensitive front panel in color, with an intuitive graphical user interface

●

Job previews in the front panel and on remote computers

●

Driverless printing: files in common graphical formats can be printed directly without needing a
printer driver

●

Walk-up printing: just insert a USB flash drive or connect a laptop computer containing your files

●

Walk-up scanning: just insert a USB flash drive to receive your scanned images, or scan to a
network folder

●

Paper flexibility and automatic easy load, see Printer paper handling on page 41

●

The printer handles cut-sheet and roll paper; the scanner handles cut-sheet paper

●

Six-ink system

●

Accurate and consistent color reproduction with automatic color calibration

●

Color emulations, see Printer emulation on page 91

●

Economode for printing economically

●

Two rolls loaded at once provide fast and easy switching between different rolls, or long runs of
unattended printing

●

Job management, see Job queue management on page 79

●

High productivity features such as job previewing and nesting

●

Ink and paper usage information available

●

Printer and scanner calibration if required

●

Access to the online HP Knowledge Center (see Knowledge Center on page 189)

Main features
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Main components
The following front and rear views of the product illustrate the main components.

Front view

1.

Blue lever

2.

Ink cartridge

3.

Scanner

4.

Printhead

5.

Printhead carriage

6.

Front panel

7.

Paper alignment lines

8.

Front scanner deflectors

9.

Output tray

10. Basket
11. Ink cartridge slots
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1.

Scanner

2.

Roll cover

3.

Communication ports

4.

Power switch

5.

Power socket

6.

Foot extension

7.

Spindle

8.

Spindle stop

9.

Paper roll

Introduction

Rear view

10. Quick Reference Guide holder
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Communication ports

1.

Hi-Speed USB device port, to connect a computer

2.

Gigabit Ethernet port, to connect to a network

3.

Diagnostic LEDs, to be used by service engineers

4.

Hi-Speed USB host port, intended for connecting an accessory

There is another Hi-Speed USB host port on the other side of the printer, beside the front panel,
intended for connecting a USB flash drive.

8
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The front panel
The front panel is located on the front right of the product. It gives you complete control of your
product: from the front panel, you can copy, scan or print, view information about the product, change
product settings, perform calibrations and tests, and so on. The front panel also displays alerts (warning
and error messages) when needed.

1.

A Hi-Speed USB host port, intended for connecting a USB flash drive. This can provide files to be
printed, or receive scanned files from the scanner. When a USB flash drive is inserted, a USB icon
is displayed on the front panel's home screen.

2.

The front panel itself: a touch-sensitive screen with a graphical user interface.

3.

The Power key, with which you can turn the product on or off. The key is illuminated when the
product is on. It flashes when the product is in transition between on and off.

The front panel has a large central area to display dynamic information and icons. On the left and right
sides you can see up to five fixed icons at different times. Normally they are not all displayed at the
same time.
Left and right fixed icons

ENWW

●

Press

to return to the home screen.

●

Press

to go to the previous item.

●

Press

to go to the next item.

The front panel
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●

Press

to go back to the previous screen. This does not discard any changes made in the

current screen.
●

Press

to cancel the current process.

Home screen dynamic icons
The following items are displayed only on the home screen.
●

Press

to view information about product status, change product settings, or initiate actions

such as loading paper or replacing ink supplies. A smaller warning icon appears if there are
actions that need to be performed.
●

To the right of the above button is a message showing the product status or the most important
current alert. Press this message to see a list of all current alerts.

●

to eject the paper from the scanner. If there is no paper in the scanner, this button is not
Press
displayed.

●

Press

to print a file. See Printing on page 56.

●

Press

to scan a sheet of paper and store the image in a file, either in a network folder or

in a USB flash drive. See Scanning on page 74.
●

●

Press
Press

to copy a sheet of paper (scan and print). See Copying on page 77.
to view information about the USB flash drive(s). This icon appears only when one or

more USB flash drives are inserted.
●

Press

to view and manage the print and scan job queues. A smaller warning icon appears if

there are jobs on hold. See Job queue management on page 79.
If the product is left idle for some time, it goes into sleep mode and switches off the front-panel display.
, then
, then Setup > Front
To change the time that elapses before sleep mode, press
panel options > Sleep mode wait time. You can choose various times between 30 and 240
seconds.
The product wakes from sleep mode and switches on the front-panel display whenever there is some
external interaction with it.
Information about specific uses of the front panel can be found throughout this guide.

Printer software
The following software is provided with your product:

10

●

The HP-GL/2 and HP RTL driver for Windows

●

The PCL3GUI raster driver for Mac OS (T2300)

Chapter 1 Introduction
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The PostScript drivers for Windows and Mac OS (T2300 PS)

●

The Embedded Web Server and (alternatively) the HP Utility allow you to:
◦

Manage the product from a remote computer

◦

View the status of the ink cartridges, the printheads and the paper

◦

Access the HP Knowledge Center, see Knowledge Center on page 189

◦

Update the product's firmware, see Update the firmware on page 145

◦

Perform calibrations and troubleshooting

◦

Manage the job queue, see Job queue management on page 79

◦

View job accounting information, see Retrieving usage information on page 123

◦

Change various product settings

Introduction

●

See Access the Embedded Web Server on page 37 and Access the HP Utility on page 37.

Turn the product on and off
TIP: The product can be left powered on with minimal use of electricity. Leaving it on improves
response time and overall system reliability. When the product has not been used for a certain period
of time (the default time is determined by Energy Star), it saves electricity by going into sleep mode.
However, any interaction with the front panel, or starting a new job, returns it to active mode, and it
can resume working immediately. To change the sleep mode time, see Change the sleep mode setting
on page 38.
NOTE: In sleep mode, the printer performs maintenance service to the printheads from time to time.
This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to
leave the product powered on or in sleep mode to avoid wasting ink and time.
The product has three levels of power consumption.
●

Plugged in: the power cord is plugged into the back of the product

●

Switched on: the switch at the back of the product is in the on position

●

Powered on: the Power key on the front panel is illuminated

If you wish to turn the product on or off or reset the product, the normal and recommended method is to
use the Power key on the front panel.
However, if you plan to store the product indefinitely or the Power key does not seem to work, you are
recommended to power it off using the Power key, and then also switch off the power switch at the
rear.

ENWW
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To turn it back on, use the power switch at the rear.
When the product is powered back on, it takes about three minutes to initialize and check and prepare
the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the
product has been off for six weeks or more, preparing the printheads could take up to 45 minutes.

Internal prints
The internal prints give various kinds of information about your product. They can be requested from
the front panel.
Before requesting any internal print, check that the printer and the paper are ready for printing.
●

The loaded paper should be at least A3 landscape—420 mm (16.53in) wide—otherwise the print
may be clipped.

●

The front panel should be displaying the Ready message.

To print any internal print, press

, then

, then scroll down to Internal prints and press it,

then select the internal print you want. The following internal prints are available.
●

●

●

12

Demo prints
◦

Print drawing demo

◦

Print rendering demo

◦

Print GIS map

User information prints
◦

Print configuration (all the current product settings)

◦

Print usage report: statistics on the usage of the printer and the scanner (the accuracy of these
estimates is not guaranteed)

◦

Print PS font list: prints a list of the available PostScript fonts (T2300 PS only)

◦

Print scanner image quality plot

Service information prints (mainly used by service engineers)
◦

Print usage information

◦

Print event logs

◦

Print calibrations status

Chapter 1 Introduction
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Print connectivity config. (may be useful for network administrators)

◦

Print all pages

Introduction

◦

Internal prints
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Installing the software

●

Choose which connection method to use

●

Connect the product to your network

●

Connect a computer to the product by network (Windows)

●

Connect a computer to the product by USB cable (Windows)

●

Uninstall the printer software (Windows)

●

Connect a computer to the product by network (Mac OS)

●

Connect a computer to the product by USB cable (Mac OS)

●

Uninstall the printer software (Mac OS)

Chapter 2 Installing the software
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Choose which connection method to use
Connection type

Speed

Cable length

Other factors

Gigabit Ethernet

Very fast; varies
according to network
traffic

Long: 100 m (328 ft)

Requires extra equipment (switches)

Jetdirect print server
(optional accessory)

Moderate; varies
according to network
traffic

Long: 100 m (328 ft)

Requires extra equipment (switches)

Software installation

The following methods can be used to connect your product.

Provides additional features
See http://www.hp.com/go/jetdirect/ for
more details

Hi-Speed USB

Very fast

Short: 5 m (16 ft)

A certified Hi-Speed USB cable is necessary
for reliable communication.

NOTE: The speed of any network connection depends on all components used in the network, which
can include network interface cards, routers, switches and cables. If any one of these components
cannot operate at high speed, you will have a low-speed connection. The speed of your network
connection can also be affected by the total amount of traffic from other devices on the network.

Connect the product to your network
The product is able to configure itself automatically for most networks, in a similar way to any computer
in the same network. The first time you connect it to a network, this process may take a few minutes.
Once the product has a working network configuration, you can check its network address from the
, then
.
front panel: press

Network configuration
For more details about the current network configuration, go to the front panel and press

, then

, then Setup > Connectivity > Gigabit Ethernet > Modify configuration; or, for Jetdirect,
Setup > Connectivity > Jetdirect EIO > Modify configuration. From here it is possible, though
not normally necessary, to change the settings manually; this can also be done remotely using the
Embedded Web Server or the HP Utility.
TIP: You may find it helpful to print out the full product network configuration on paper. This can be
done from the front panel: press
, then
, then Internal prints > Service information
prints >Print connectivity config. If you do not print out the full network configuration, consider
making a note of the product's IP address and network name.
If you accidentally misconfigure the product’s network settings, you can restore the network settings to
their factory values from the front panel: press
, then
, then Setup > Connectivity >
Gigabit Ethernet > Restore factory settings; or, for Jetdirect, Setup > Connectivity >
Jetdirect EIO > Restore factory settings. Then you must restart the product. This automatically
provides a working network configuration for most networks. The product’s other settings remain
unchanged.

ENWW

Choose which connection method to use

15

Using IPv6
Your product supports almost all network connectivity features using IPv6, just as it does using IPv4. To
make full use of IPv6, you may need to connect your product to an IPv6 network in which there are IPv6
routers and servers.
In most IPv6 networks, the product will configure itself automatically as follows, and no user
configuration is necessary:

Software installation

1.

The product assigns itself a link-local IPv6 address (which starts with “fe80::”).

2.

The product assigns itself stateless IPv6 addresses as indicated to it by any IPv6 routers on the
network.

3.

If no stateless IPv6 addresses can be assigned, the product will try to obtain IPv6 addresses using
DHCPv6. It will also do so if the routers instruct it to do so.

The stateless and DHCPv6 IPv6 addresses can be used to access the product, and in most IPv6
networks this will be appropriate.
The link-local IPv6 address works only in the local subnet. Although it is possible to access the product
using this address, it is not recommended.
It is possible to assign a manual IPv6 address to the product, using the front panel or the Embedded
Web Server. It is also possible to disable IPv6 completely in the product. However, it is not possible to
disable IPv4 in the product, and therefore it is not possible to configure the product as IPv6-only.
NOTE: In typical IPv6 use, your product will have multiple IPv6 addresses, although it has only one
IPv4 address.
TIP: You will generally find it easier to use IPv4 unless you have a specific need to use IPv6.
Microsoft Windows Vista, Microsoft Windows Server 2008, and the new HP Printing and Imaging
devices will have IPv6 enabled by default. For further information on IPv6, see
http://h20000.www2.hp.com/bc/docs/support/SupportManual/c00840100/c00840100.pdf. This
document discusses how name resolution plays a fundamental role in Dual-Stack transition methods.
Using the name resolution algorithm in Windows Vista, the document goes through various network
environments and studies how the introduction of routable IPv6 addresses will affect network
applications. It also discusses DHCPv6, SLAAC and the impact to DNS, and makes some
recommendations.

Using IPSec
Your product supports IPSec.
However, successful IPSec configuration requires advanced network expertise, and is beyond the scope
of this document. For IPSec to work, the product’s IPSec configuration must exactly match that of the
other devices in your network. Any discrepancy will prevent communication with your product until the
configuration is corrected or IPSec is disabled. For more information on IPsec configuration, download
the file IPsec_Admin_Guide.pdf from http://www.hp.com/go/T2300/manuals/.
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Connect a computer to the product by network
(Windows)
●

The product should be set up and on.

●

The Ethernet switch or router should be on and functioning correctly.

●

All computers on the network should be on and connected to the network.

●

The product should be connected to the network (see Connect the product to your network
on page 15).

Software installation

Before you begin, check your equipment:

Now you can proceed to install the printer software and connect to your product:
1.

Make a note of the product's IP address from the front panel (see Access the Embedded Web
Server on page 37).

2.

Insert the HP Start-up Kit DVD into your computer. If the DVD does not start automatically, run the
setup.exe program in the root folder of the DVD.

3.

Press the Software Installation button.

4.

Press the Express Network Install button, and choose your product from the list of networked
printers that appears, identifying it by its IP address if necessary. The printer drivers and the HP
Utility are installed.

If your computer fails to find any printers on the network, the Printer Not Found window is
displayed, which helps you to try to find your product. If you have a firewall in operation; you may
have to disable it temporarily in order to find the product. You also have the options of searching for
the product by its hostname, IP address or MAC address.
In some cases, when the product is not in the same sub-net as the computer, specifying the product's IP
address may be the only successful option.

Connect a computer to the product by USB cable
(Windows)
You can connect your product directly to a computer without going through a network, by using the
product's built-in Hi-Speed USB device port.
TIP: A USB connection may be faster than a network connection, but the cable is limited in length
and it is more difficult to share the product.
NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified
by the USB Implementor's Forum (http://www.usb.org/) should be used with this product.
The following instructions apply if you intend to print from software applications using a printer driver.
If you intend to print only with HP Direct Print or the Embedded Web Server, you do not need to install
the printer software on your computer; see Printing on page 56.
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1.

Do not connect the computer to the product yet. You must first install the printer software
on the computer, as follows.

2.

Insert the HP Start-up Kit DVD into your DVD drive. If the DVD does not start automatically, run the
setup.exe program in the root folder of the DVD.

Connect a computer to the product by network (Windows)
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Software installation

3.

Press the Software Installation button.

4.

Press the Custom Install button.

5.

In some cases, you may see a message warning you that the installer would need to communicate
through the firewall in order to search the network for printers. As you have no need to do this,
you can check the box Continue installation without searching the network.

6.

If you see a list of networked printers, select Help me find my printer (including network,
USB or parallel connected printers).

7.

Select USB Cable.
NOTE: You can connect your product and complete the installation later if you prefer. To do so,
check the box marked I want to connect my printer after completing the setup
wizard.

8.

When prompted to do so, connect your computer to the product with a certified USB cable. Ensure
that the product is turned on.

9.

The printer drivers and the HP Utility are installed.

TIP: If you would like to share the product with other people connected to your network, press the
Printer Properties button in the Ready to Install window, set Printer Name to the name under
which the product will be shared, then set Shared to Yes.

Printer sharing considerations
●

The HP Utility must be installed on a computer before it can be used from that computer.

●

Any other users sharing your directly connected product will be able to send print jobs, but will not
be able to receive information from the product—which affects alerts, status reports, paper
management, administration and troubleshooting.

●

Any other users sharing your directly connected product will be unable to use the printer's own
print preview facility, although the application's print preview will still be available. See Preview a
print on page 66.

TIP: The best way to share the product over a network is to connect the product not to any computer,
but to the network. See Connect a computer to the product by network (Windows) on page 17.

Uninstall the printer software (Windows)
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1.

Insert the HP Start-up Kit DVD into your DVD drive. If the DVD does not start automatically, run the
setup.exe program in the root folder of the DVD.

2.

Press the Software Installation button.

3.

Press the Modify Installation button, and follow the instructions on your screen to uninstall the
printer software.

Chapter 2 Installing the software
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Connect a computer to the product by network (Mac
OS)
You can connect your product to a network under Mac OS X by using the following methods:
●

Bonjour

●

TCP/IP

Software installation

NOTE: The product does not support AppleTalk.
Before you begin, check your equipment:
●

The product should be set up and on.

●

The Ethernet switch or router should be on and functioning correctly.

●

All computers on the network should be on and connected to the network.

●

The product should be connected to the network (see Connect the product to your network
on page 15).

Now you can proceed to install the printer software and connect to your product.

Bonjour connection
1.

Go to the front panel and press

, then

, then

. Note the mDNS service name of

your product.

ENWW

2.

Insert the HP Start-up Kit DVD into your DVD drive.

3.

Open the DVD icon on your desktop.

Connect a computer to the product by network (Mac OS)
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4.

Open the Mac OS X HP Designjet Installer.

5.

Follow the instructions on your screen.

6.

The printer software is installed, including the printer driver and the HP Utility.

7.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up
a connection to your product. Follow the instructions on your screen.

8.

When you reach the Select Printer screen, look for your product's mDNS service name (which you
noted in step 1) in the Printer Name column.

●

If you find the right name, scroll sideways if necessary to see the Connection Type column,
and check that it shows Bonjour. Then highlight that line. Otherwise, continue searching
further down the list.

●

If you cannot find your product's name with a Bonjour connection type, check the box My
printer is not in the list.

Click Continue.
9.

Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
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If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

ENWW

1.

Go to the front panel and make a note of the product's URL (see Access the Embedded Web
Server on page 37).

2.

Insert the HP Start-up Kit DVD into your DVD drive.

3.

Open the DVD icon on your desktop.

4.

Open the Mac OS X HP Designjet Installer.

5.

Follow the instructions on your screen.

6.

The printer software is installed, including the printer driver and the HP Utility.

7.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up
a connection to your product. Follow the instructions on your screen.

Connect a computer to the product by network (Mac OS)

Software installation

TCP/IP connection
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8.

When you reach the Select Printer screen, look for your product's URL (which you noted in step 1)
in the Printer Name column.
●

If you find the right name, scroll sideways if necessary to see the Connection Type column,
and check that it shows IP Printing. Then highlight that line. Otherwise, continue searching
further down the list.

●

If you cannot find your product's name with an IP Printing connection type, check the box
My printer is not in the list.

Software installation

Click Continue.
9.

Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

Connect a computer to the product by USB cable
(Mac OS)
You can connect your product directly to a computer without going through a network, by using the
product's built-in Hi-Speed USB device port.
The following instructions apply if you intend to print from software applications using a printer driver.
If you intend to print only with HP Direct Print or the Embedded Web Server, you do not need to install
the printer software, and you can ignore these instructions: see Printing on page 56.

22

1.

Make sure the product is either turned off, or disconnected from the computer.

2.

Insert the HP Start-up Kit DVD into your DVD drive.

3.

Open the DVD icon on your desktop.

Chapter 2 Installing the software
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Open the Mac OS X HP Designjet Installer.

5.

Follow the instructions on your screen.

6.

The printer software is installed, including the printer driver and the HP Utility.

7.

Make sure that the product is turned on and connected to the computer with a certified USB cable.

Software installation

4.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this product.
8.

Shortly afterwards, a print queue is created automatically for your printer.

Sharing the product
If your computer is connected to a network, you can make your directly connected product available to
other computers on the same network.
1.

Double-click the System Preferences icon on the Dock menu bar on your desktop.

2.

Under Mac OS X 10.4, enable printer sharing by going to Sharing > Services > Printer
Sharing.
Under later versions of Mac OS X, go to Sharing, select Printer Sharing, and then check the
printer(s) that you want to share.

3.

Your product now automatically appears in the list of shared printers displayed by any other
computer running Mac OS and connected to your local network.

Please bear in mind the following considerations.

ENWW

●

Any other users wishing to share your product must install the printer software on their own
computers.

●

Anyone sharing your directly connected product will be able to send print jobs, but will not be
able to receive information from the product—which affects alerts, status reports, paper
management, administration and troubleshooting.

Connect a computer to the product by USB cable (Mac OS)
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●

The PCL3GUI (raster) driver can drive a shared printer between different versions of Mac OS, but
the PostScript driver does not support printer sharing between Mac OS X 10.4 and Mac OS X
10.5 or 10.6. It does support printer sharing between Mac OS X 10.5 and 10.6.

●

You may find that sharing your directly connected product with other users will slow down your
computer unacceptably.

TIP: The best way to share the product over a network is to connect the product not to any computer,
but to the network. See Connect a computer to the product by network (Mac OS) on page 19.

Software installation

Uninstall the printer software (Mac OS)
1.

Insert the HP Start-up Kit DVD into your DVD drive.

2.

Open the DVD icon on your desktop.

3.

Open the Mac OS X HP Designjet Uninstaller, and follow the instructions on your screen to
uninstall the printer software..

To delete the print queue:
●

●
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Under Mac OS X 10.4 there are two alternative ways of deleting the print queue:
◦

From the system preferences, select the Printing pane of the Print & Fax dialog. Select the
name of the product and click the – button.

◦

From the Print Setup utility, select the name of the product and click the Delete icon.

Under Mac OS X 10.5 or 10.6: from the system preferences, select the Print & Fax dialog.
Select the name of the product and click the – button.
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Setting up the product

●

Introduction

●

Create a scan-to-network folder

●

Paper suitability options

●

Turn nesting on and off

●

Turn alerts on and off

●

Control access to the product

●

Require account ID

●

Set Windows driver preferences

Administrator settings
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Introduction
This chapter describes various product settings that the product administrator may wish to control as
soon as a new product is assembled and ready for use.

Create a scan-to-network folder
A scanned image may be saved in a USB flash drive or in a network folder. The USB flash drive option
requires no preparation, but the network folder option will not work until it has been set up in the
following way.
NOTE: The product accesses shared folders (as a client) using NTLMv1-based authentication. If, for
security reasons, you prefer not to expose user credentials using NTLMv1, you should avoid using a
scan-to-network folder.

Administrator settings

1.

Create a folder on a computer that the scanner can access through the network.

2.

Create a user account on the same computer for the product.

3.

Change the sharing options of the folder so that it is shared with the 'scanner user', and assign full
control of the folder to that user.

4.

Create a share name for the folder.
NOTE: It is important to complete the above steps before starting the remaining steps below.

5.

In the product's Embedded Web Server, select the Setup tab and then Scan to network. See
Access the Embedded Web Server on page 37.
Alternatively, In the HP Utility, select the Settings tab and then Scan to network. See Access
the HP Utility on page 37.

6.

On the Scan to Network page, click Add folder details, and fill in the various fields.
●

Server name should contain the network name of the remote computer.

●

Folder name should contain the share name of the folder.

●

User name should contain the name of the 'scanner user'.

●

User password should contain the password of the 'scanner user'.

●

Domain name should contain the name of the domain in which the user name exists. If the
'scanner user' does not belong to any domain, leave this field empty.

The server and folder names are used to connect to the shared folder by building a network folder
path as follows: \\server name\folder name
7.

Click Apply to save the configuration.

8.

The product automatically checks that it can access the network folder. If not, see Cannot access
the network folder on page 178.

Example: Create a scan-to-network folder under Windows
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1.

Create a new user account for the 'scanner user' on the remote computer. You can use an existing
user account for this purpose, but it is not recommended.

2.

Create a new folder on the remote computer (unless you want to use an existing folder).

Chapter 3 Setting up the product
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Right-click the folder and select Properties.

4.

In the Sharing tab, click the Advanced Sharing button.

5.

Check the Share this folder box.

Administrator settings

3.

Create a scan-to-network folder
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Administrator settings

6.

You need to ensure that the 'scanner user' has full read/write control over the shared folder. To do
this, click Permissions and grant Full Control to the user (or to any suitable group that includes
that user).

7.

If there is a Security tab in the Properties window for your folder, then you must also grant the
same user Full Control over the folder in the Security tab. Only some file systems such as NTFS
require this.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the
product to send scans to the folder.
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8.

In the product's Embedded Web Server, select the Setup tab and then Scan to network.

9.

On the Scan to Network page, click Add folder details.

Administrator settings

NOTE: If the product has already been configured for scanning to the network and you now
want to use a different shared folder, click Modify.

Enter the name or IP address of the remote computer, the name of the shared folder, and the user
name and password of the 'scanner user' that you have already created on the remote computer.
Leave the user domain field empty unless the user is a member of a Windows domain. If the user
is only a local user of the remote computer, leave the field empty.
You can use the name (instead of the IP address) in the server name field only if the shared folder
is on a Windows computer in the same local network. This must be a simple name (up to 16
characters long) without a domain suffix (i.e. without any dots in the name). Fully qualified DNS
domain names are not supported.
If the product and the network folder are in different networks, or if the remote computer is not
running Windows, then you must use the IPv4 address instead of the name of the remote
computer. On IPv6 networks the IPv6 address is also supported.
10. When you click Apply, the product will try to confirm that it can access the shared folder
correctly. If all is well, you can now send scanned images to the shared folder. If not, see Cannot
access the network folder on page 178.
You can check at any later time that the shared folder remains accessible by clicking Verify in the
Embedded Web Server. A correctly configured shared folder can become inaccessible if the user’s
password is changed, or if the shared folder is moved or deleted.

ENWW
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Example: Create a scan-to-network folder under Mac OS
Create a new user account for the 'scanner user' on the remote computer. You can use an existing
user account for this purpose, but it is not recommended.

2.

Create or choose a folder on the remote computer. By default, Mac OS users have a “Public
Folder” that can easily be used for this purpose.

3.

Open the System Preferences application and select the Sharing icon.

4.

Make sure the 'scanner user' has Read & Write access to the folder.

5.

Click Options.

6.

Check the Share files and folder using SMB box, and make sure that the 'scanner user' is
checked in the On column.

Administrator settings

1.
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7.

Click Done. You will now see file sharing enabled and Windows sharing on.

8.

In the product's Embedded Web Server, select the Setup tab and then Scan to network.

9.

On the Scan to Network page, click Add folder details.

Administrator settings

The 'scanner user' can now access the folder and write files to it. Next, you must configure the
product to send scans to the folder.

NOTE: If the product has already been configured for scanning to the network and you now
want to use a different shared folder, click Modify.

Enter the IP address of the remote computer, the name of the shared folder, and the user name
and password of the 'scanner user' that you have already created on the remote computer.
NOTE: You cannot use the remote computer’s host name as the server name, as this is supported
only for computers running Windows. You must use the IPv4 or IPv6 address.
Leave the user domain field empty.
10. When you click Apply, the product will try to confirm that it can access the shared folder
correctly. If all is well, you can now send scanned images to the shared folder. If not, see Cannot
access the network folder on page 178.
You can check at any later time that the shared folder remains accessible by clicking Verify in the
Embedded Web Server. A correctly configured shared folder can become inaccessible if the user’s
password is changed, or if the shared folder is moved or deleted.
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Paper suitability options
Paper mismatch action
If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put
the job on hold until some suitable paper is loaded, or it can ignore the problem and print the job on
the unsuitable paper. There are several ways in which the loaded paper may be considered unsuitable:
●

The paper type is not as specified for the job

●

The paper source (roll 1, roll 2 or sheet) is not as specified for the job

●

The paper size is smaller than specified for the job

You can set the printer's behavior in such cases from the front panel.
●

Press

, then

, then Setup > Job management options > Paper mismatch action

> Print anyway if you want such jobs to print on whatever paper is loaded. This is the default
option when printing from a software application or from the Embedded Web Server; but it does
not work when printing from a USB flash drive, nor when copying.

Administrator settings

●

Press

, then

, then Setup > Job management options > Paper mismatch action

> Put job on hold if you want such jobs to be put on hold. The printer will send an alert
whenever a job is put on hold.
When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded
(in which case, all jobs waiting for that paper type can be printed). Meanwhile, other jobs with
different requirements can continue printing.

Roll switching options
If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your
preferences. These can be set from the front panel: press
, then
, then Setup > Printing
preferences > Paper options > Roll switching options.
NOTE: These options are ignored when printing from USB flash drive and when copying.
There are three available options:
●

Minimize paper waste. If this option is chosen, the printer will choose the narrowest roll that
meets all the criteria, to avoid wasting paper due to trimming. This is the default option.

●

Minimize roll changes. If this option is chosen, the printer will choose the roll that is currently
active, to avoid wasting time with a roll switch.

●

Use roll with less paper. If this option is chosen, the printer will choose the roll that has the
least paper.
NOTE: This option is effective only if you have enabled Printing paper info (see Printing
paper info on page 51). Otherwise, it has the same effect as Minimize paper waste.

Turn nesting on and off
Nesting means automatically printing images or document pages side by side on the paper when
feasible, rather than one after the other. This is done to avoid wasting paper. See Nest jobs to save roll
paper on page 70.
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To turn nesting on or off, you must first make sure that the job queue is enabled (see Turn off the job
queue on page 86 or Turn off the job queue on page 82) and the start of printing is set to After
Processing (see Select when to print a job in the queue on page 84 or Select when to print a job in
the queue on page 80). Then:
●

In the HP Utility for Windows: select Settings > Job Management > Nest.

●

In the HP Utility for Mac OS: select Configuration > Printer Settings > Configure
Printer Settings > Job Management > Nest.

●

In the Embedded Web Server: select Setup > Printer settings > Job management >
Nest.

●

Using the front panel: press

, then

, then Setup > Job management > Nest

options > Enable nesting.
In each case, you will see the following options:

●

●

In order: pages are nested in the order in which they are sent to the printer. The nested pages
are printed as soon as one of three conditions is met:
◦

The next page will not fit on the same row as the other pages already nested.

◦

No page has been sent to the printer during the specified wait time.

◦

The next page is incompatible with the pages already nested (see Nest jobs to save roll
paper on page 70).

Administrator settings

●

Optimized order: pages are not necessarily nested in the order in which they are sent to the
printer. When it receives an incompatible page, the printer holds it and waits for compatible
pages to complete the nest. The nested pages are printed as soon as one of three conditions is
met:
◦

The next page will not fit on the same row as the other pages already nested.

◦

No page has been sent to the printer during the specified wait time.

◦

The incompatible-page queue is full. The printer can queue up to six incompatible pages
while nesting compatible pages. If it receives a seventh incompatible page, the nest is printed
as it is.

Off: nesting is disabled. This is the default option.

NOTE: The product's internal prints are always nested, even if nesting is disabled.
The nesting wait time can be set at the front panel: press

, then

, then Setup > Job

management > Nest options > Select wait time.
TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print
because the printer waits for compatible pages to arrive.

Turn alerts on and off
Alerts warn you when there is a problem that you can correct by taking action, or when one of your
jobs changes its status. The alerts are displayed by the front panel, by the HP Utility, by the printer
driver and by the Embedded Web Server.
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You can tell the product which kinds of alerts you would like to see (if any). To access the alert settings:
●

Select Alert Settings in the Device List page of the HP Utility.

●

Select Alert Settings in any alert page displayed by the HP Utility for Windows.

●

Right-click the system tray icon of the HP Utility for Windows, and select Alert Settings.

You can change the settings in the following ways:
●

Turn all alerts on or off.

●

Turn job status alerts on or off.

●

Turn on or off alerts for problems that prevent the product from working.

●

Turn on or off alerts for problems that do not prevent the product from working.

●

Turn on alerts in all circumstances, or only when you are trying to use the product.

Control access to the product
Administrator settings

From the Embedded Web Server, you can select Setup > Security to control access to the product in
various ways:
●

Specify separate administrator and guest passwords to control access to the Embedded Web
Server

●

Enable or disable Ethernet and USB connections to the product

●

Enable or disable various groups of front panel operations

NOTE: An administrator password may be required.
NOTE: For more information, see the Embedded Web Server's online help.
If you forget the administrator password, you can delete the current password from the front panel:
press
, then
, then Setup > Connectivity > Advanced > Embedded Web Server >
Reset EWS access control.

Require account ID
If you want to keep records of product usage by different user accounts, you can set your product to
require an account ID for each job.
●

In the HP Utility for Windows: select Settings > Accounting > Require account ID.

●

In the HP Utility for Mac OS: select Configuration > Printer Settings > Configure
Printer Settings > Accounting > Require account ID.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be
kept "on hold for accounting".
The account ID can be set in the printer driver when sending the job. If the job is set "on hold for
accounting" by the printer, you can introduce the account ID in the HP Utility by going to the Job
Center > Job Queue and clicking the job that is on hold. A window with a text box will be
displayed and you can enter the account ID into it.

34

Chapter 3 Setting up the product

ENWW

Set Windows driver preferences

Administrator settings

You can change some default settings in your printer driver according to your own preferences, for
instance to set color emulation or paper-saving options. To do this, press the Start button on your
computer's screen, then select Printers and Faxes. In the Printers and Faxes window, right-click your
product's icon, and select Printing Preferences. Any settings you change in the Printing Preferences
window will be saved as default values.
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Set Windows driver preferences
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4

Personalizing the product

●

Change the language of the front-panel display

●

Access the HP Utility

●

Access the Embedded Web Server

●

Change the language of the HP Utility

●

Change the language of the Embedded Web Server

●

Change the sleep mode setting

●

Turn the buzzer on and off

●

Change the front-panel display brightness

●

Change the units of measurement

●

Configure network settings

●

Change the printer's graphic language setting

Personal settings
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Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.
●

If you can understand the current front-panel display language, press

, then

, then Setup

> Front panel options > Select language.
●

If you cannot understand the current front-panel display language, start with the product powered
off. Press the Power key to turn it on. When you see icons appear on the front panel, press
and then

. The front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel
display. Press your preferred language.

Access the HP Utility
The HP Utility enables you to manage your product from a computer with a USB, TCP/IP or Jetdirect
connection.
●

Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs
> Hewlett-Packard > HP Utility > HP Utility. This launches the HP Utility, showing the
printers installed on your computer.

●

Under Mac OS, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK >
Library > Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the
printers installed on your computer.
When you select your product in the left pane, everything that appears in the right pane is specific
to that product.

Personal settings

If you have followed these instructions but failed to get through to the HP Utility, see Cannot access the
HP Utility on page 183.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your product remotely using an ordinary Web
browser running on any computer.
To access the Embedded Web Server directly, you must have a TCP/IP connection to your product.
However, you can access the Embedded Web Server indirectly through the HP Utility, if you connect to
your product with a USB connection.
The following browsers are known to be compatible with the Embedded Web Server:
●

Internet Explorer 6 for Windows XP, and later

●

Safari 2 for Mac OS X 10.5, and later

●

Firefox 2.0 and later

●

Google Chrome 1.0 and later

The Adobe Flash plugin version 7 or later is recommended for viewing job previews.
To access the Embedded Web Server on any computer, open your Web browser and give the IP
address of your product.
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You can see your product's IP address on the front panel by pressing

and then

.

If you have followed these instructions but failed to get through to the Embedded Web Server, see
Cannot access the Embedded Web Server on page 183.

Change the language of the HP Utility
The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows
only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.
●

Under Windows, select Tools > Set Language and select a language from the list.

●

Under Mac OS, the language is changed as for any other application. In System
Preferences, select International and re-launch the application.

Change the language of the Embedded Web Server
The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and
Japanese. It uses whichever language you have specified in your Web browser's options. If you have
specified a language that it cannot support, it works in English.
To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.

Change the sleep mode setting
If the product is left switched on but unused for a certain period of time, it goes automatically into sleep
mode to save power. To change the time the product waits before it goes into sleep mode, go to the
front panel and press
, then
, then Setup > Front panel options > Sleep mode wait

Personal settings

time. Select the wait time you want and then press OK; you can set the time from 1 to 240 minutes.
The default time is 30 minutes.

Turn the buzzer on and off
To turn the product's buzzer on or off, go to the front panel and press

, then

, then Setup >

Front panel options > Enable buzzer, and select on or off. By default, the buzzer is set to on.

Change the front-panel display brightness
To change the brightness of the front-panel display, press

, then

, then Setup > Front panel

options > Select display brightness, and select a value you want. Press OK to set the value. The
default brightness is set to 50.

Change the units of measurement
To change the units of measurement in the front-panel display, press

, then

, then Setup >

Front panel options > Select units, and select English or Metric. By default the units are set to
metric.
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Configure network settings
You can view and configure the network settings from the Embedded Web Server, the HP Utility or the
front panel.
To do so with the Embedded Web Server, select the Setup tab, then Networking.
With the HP Utility under Windows, select the Settings tab, then Network Settings. Under Mac
OS, select Configuration > Network Settings.
The following settings are available.
●

IP Configuration method: specify the way to set an IP address, selecting BOOTP, DHCP,
Auto IP or Manual.

●

Host name: specify the IP name of the product. The name may contain up to 32 ASCII
characters.

●

IP address: specify the IP address of the product. Duplicate IP addresses on a TCP/IP network
will cause communication to fail.
TIP: Make sure that the combination of IP address, subnet mask and default gateway is valid. If
these three fields are inconsistent, you may not be able to connect to the product at all until you fix
the problem from the front panel.

●

Subnet mask: specify a subnet mask, which determines which bits specify the network and
which bits uniquely specify the node within the network.

●

Default gateway: specify the IP address of a router or computer that is used to connect to other
networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the
product.

●

Domain name: specify the name of the DNS domain in which the product resides (for example,
support.hp.com).
NOTE: The domain name does not include the host name: it is not the fully qualified domain
name, such as printer1.support.hp.com.

●

Idle timeout: specify the number of seconds that an idle connection is allowed to remain open;
30 is the default value. If set to zero, the timeout is disabled and TCP/IP connections remain open
until closed by the other node (such as a workstation) on the network

●

Default IP: specify the IP address to use when the product is unable to obtain an IP address from
the network when powered on or when reconfigured to use BOOTP or DHCP.

●

Send DHCP requests: specify whether DHCP requests are transmitted when a legacy default IP
address or a default Auto IP is assigned.

To configure the same network settings from the front panel, press

, then

, then Setup >

Connectivity > Gigabit Ethernet > Modify configuration.
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TIP: If you change the current IP address and click Apply, the browser loses the current
connection to the product because it is pointing to the old address. To reconnect, browse to the
new IP address.

You have various other options available from the Setup > Connectivity > Advanced menu.
●

I/O timeout: specify the number of seconds that an idle connection is allowed to remain open,
270 is the default value, if set to zero, the timeout is disabled

●

Allow SNMP: specify whether SNMP is permitted

●

Embedded Web Server > Allow EWS: specify whether the Embedded Web Server is
enabled

●

Web Services > HP Utility software: view the HP Utility software settings

●

Web Services > Color and paper management: view the color and paper management
settings

Change the printer's graphic language setting
You can change the printer's graphic language setting from the HP Utility with the following steps.
1.

Under Windows, select the Settings tab then Printer settings > Printing preferences.
Under Mac OS, select Configuration then Printer settings > Configure printer
settings > Printing preferences.

2.

Select one of the following options.

Personal settings

●

Select Automatic to let the printer determine which type of file it is receiving. This is the
default setting; it works for most software applications. You should not normally need to
change it.

●

Select HP-GL/2 only if you are sending a file of that type directly to the printer, without
going through a printer driver.

●

Select PDF only if you are sending a file of that type directly to the printer, without going
through a printer driver (T2300 PS only).

●

Select PostScript only if you are sending a file of that type directly to the printer, without
going through a printer driver (T2300 PS only).

●

Select TIFF only if you are sending a file of that type directly to the printer, without going
through a printer driver (T2300 PS only).

●

Select JPEG only if you are sending a file of that type directly to the printer, without going
through a printer driver (T2300 PS only).

You can change the graphic language setting from the front panel. Press

, then

, then Setup

> Printing preferences > Graphics language. Select the desired option.
NOTE: If the graphic language is set from the HP Utility, it overrides the front panel setting.
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General advice
CAUTION: Before starting a paper loading process, ensure you have enough room around the
product, both in front and behind.

CAUTION: Make sure the product wheels are locked (the brake lever is pressed down) to prevent the
product from moving.

CAUTION: All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in
landscape orientation.
TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

CAUTION: Keep the basket closed throughout the loading process.

Paper handling
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Load a roll onto the spindle
1.

Open the roll cover.

2.

Remove the black end of the spindle from the printer, then the blue end.
CAUTION:
black end.

Be sure to remove the black end first. Removing the blue end first could damage the

3.

The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to
mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue
paper stop from the end of the spindle.

4.

If the roll is long; rest the spindle horizontally on a table and load the roll on the table.

Paper handling

WARNING! Do not insert your fingers into the spindle supports during the removal process.

TIP: You may need two people to handle a large roll.
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5.

Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the
spindle showing the correct orientation.
NOTE: From the back of the product, the blue stopper is inserted into the right-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.
6.

Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

7.

Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls
of different paper types on different spindles. Extra spindles are available for purchase, see Accessories
on page 148.

Load a roll into the printer
To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle
on page 43.
TIP: Do not try to open both roll covers at once; this may cause problems. Always close one cover
before opening the other.

Paper handling
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NOTE: You can, if you like, start loading the paper without using the front panel. However, in this
case the printer will not keep track of the length of the roll, and will print no barcode on the roll when it
is next unloaded. So you are recommended to follow all the steps below, unless you have turned off the
Printing paper info option. See Printing paper info on page 51.
1.

From the front panel, press
Alternatively, press

, then

, then the roll icon, then Load.
, then Paper > Paper load > Load roll 1 or Load roll 2.

If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.
You should stand behind the product when loading the lower roll (roll 2). You may stand behind
or in front of the product when loading the upper roll (roll 1).
CAUTION: If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of
the product may cause back pain or other physical problems.
If you start to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn to the standby position,
so that it can be printed on again without reloading whenever required.
2.

If the roll cover is closed, the front panel asks you to open it.
NOTE: If at any time you open a roll cover while that roll is in the standby position, the roll will
be automatically unloaded, and you will have to reload it the next time you want to print on it.
Rest the spindle's black end on the left side roll holder. Do not put the end completely into the roll
holder.

4.

Rest the blue end of the spindle on the right side roll holder.

Paper handling

3.
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5.

With both hands, push the spindle into both roll holders at the same time.

6.

If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll),
pull the paper slightly and cut a straight edge.

7.

Insert the edge of the paper into the printer.
WARNING! Do not push your fingers inside the printer's paper path.

TIP: When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so,
the printer beeps and the front panel asks you to remove the paper.

Paper handling
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8.

Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the
printer detects the paper, it feeds it in automatically.

TIP: If you close the roll cover too soon, the paper load will be cancelled. Wait until the front
panel asks you to close it.
9.

If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode;
you should remove and discard the cut strip of paper.

10. If the leading edge of the paper has no barcode, the front panel asks you to select the paper
category and type.
TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 158.
11. If the Printing paper info option is enabled, the front panel may ask you to specify the length
of the roll. See Printing paper info on page 51.
12. The printer checks the alignment and measures the width, then the front panel asks you to close the
roll cover.
If the roll is not correctly aligned, follow the instructions on the front-panel display.
NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper
cannot be loaded successfully on page 156.

Unload a roll
Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow
the appropriate procedure as described below.

Quick procedure with paper on the roll
NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know
the length of the roll when it is next loaded. See Printing paper info on page 51.
NOTE: If you open the cover of roll 1 while a sheet is loaded, the sheet is also unloaded.
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If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically.

Front panel procedure with paper on the roll
If there is paper on the roll, you can unload it from the front panel.
1.

Press

, then the roll icon, then Unload.

Alternatively, press

, then Paper > Paper unload > Unload roll 1 or

, then

Unload roll 2.
2.

You may need to open the roll cover.

Roll out of paper procedure
If the end of the paper is no longer attached to the core, use the following procedure.
1.

If you have already started the unload process, press

on the front panel to cancel that

procedure.
2.

Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

3.

Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the
product is recommended. You may need to open the roll cover.

4.

Lower the blue lever.

Load a single sheet
1.

Ensure that the cover of roll 1 is closed. If it is opened while a sheet is loaded, the sheet will be
immediately unloaded.

2.

At the front panel, press
Alternatively, press

3.

then the roll 1 icon, then Load > Load sheet.
, then

, then Paper > Paper load > Load sheet.

If a roll is already loaded, you have to wait while it is automatically withdrawn to the standby
position. From there, it can be printed on again without reloading as soon as the sheet paper has
been unloaded.
NOTE: If at any time you open a roll cover while that roll is in the standby position, the roll will
be automatically unloaded, and you will have to reload it the next time you want to print on it.

4.

Select your paper category and type.
TIP: If you have loaded a paper type whose name does not appear in the paper list, see The
paper type is not in the driver on page 158.

Paper handling
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When prompted by the front panel, insert the sheet into the cut-sheet slot on the right side of the
printer.
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Load your sheet aligned with the load line and insert until the paper will not continue; with thicker
sheets, you feel resistance.

WARNING! Do not push your fingers inside the printer's paper path.
6.

Press OK on the front panel to feed the paper into the printer. Guide the sheet into the printer; this
is especially important with thicker papers.

7.

The printer checks the alignment and measures the sheet.
NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

8.

If the length of the sheet is more than 600 mm (23 in), the front panel asks you to check that the
rear of the sheet is hanging backwards over the roll cover (and not forwards over the scanner).

9.

If the sheet is not correctly aligned, you may be asked to correct the alignment. Please follow the
instructions on the front-panel display.

Paper handling

NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper
cannot be loaded successfully on page 156.

Unload a single sheet
To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.
To unload a sheet without printing, go to the front panel and press

then the roll 1 icon, then

Unload > Unload sheet.
Alternatively, press
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, then Paper > Paper unload > Unload sheet.
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The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the
basket.

View information about the paper
To view the loaded paper information, press

then the roll icon.

The following information is displayed on the front panel:
●

Paper type you have selected

●

Roll or sheet status

●

Width of the paper in millimeters (estimated)

●

Length of the paper in millimeters (estimated)

If no paper is loaded, the message Out of paper is displayed.
The same information is displayed in the HP Utility for Windows (Overview tab > Supplies Status
tab), the HP Utility for Mac OS (Information group > Printer Status > Supplies Details) and the
Embedded Web Server (upper-right corner).

Paper presets
Each supported paper type has its own characteristics. For optimum print quality, the printer changes
the way it prints on each different paper type. For example, some may need more ink and some may
require a longer drying time. So the printer must be given a description of the requirements of each
paper type. This description is called the 'paper preset'. The paper preset contains the ICC profile,
which describes the color characteristics of the paper; it also contains information on other
characteristics and requirements of the paper that are not directly related to color. Existing paper
presets for your printer are already installed in the printer's software.
However, as it is inconvenient to scroll through a list of all paper types available, your printer only
contains paper presets for the most commonly used paper types. If you have a paper type for which
your printer has no preset, you cannot select that paper type in the front-panel display.
There are two ways to assign a preset for a new paper type.
●

Use an HP factory paper preset by selecting the closest category and type in the front panel or the
HP Utility. See The paper type is not in the driver on page 158.
NOTE: Colors may not be accurate. This method is not recommended for high-quality prints.

●

Download the correct paper preset from: http://www.hp.com/go/T2300/paperpresets/.

Paper handling

NOTE: HP provides presets for HP paper types only. If you do not find the paper preset you
want on the Web, you may find that it has been added to the latest firmware for your printer. You
can check the firmware release notes for information, see Update the firmware on page 145.
To install the new preset in your printer, go to the Embedded Web Server's Setup tab and select
Paper management > Import paper preset.
If there are some paper types that you never use, you can hide them so that they do not appear in lists
and cannot be selected. Go to the Embedded Web Server's Setup tab and select Paper
management > Show/Hide papers. Select the paper types that you want to hide, click the arrow
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to move them into the hidden paper list, then click Apply. You can move them back into the visible list
at any time.

Printing paper info
Enable the Printing paper info option to record the printer’s estimate of the remaining roll length,
paper width and type. The information is a combination of barcode and text that is printed on the
leading edge of the roll when the paper is unloaded from the printer.

NOTE: The paper-length estimate is available only if the printer registered the amount of paper that
was on the roll when you loaded it. To provide this information to the printer, specify the roll length on
the front panel when loading the paper, or load a roll that has the paper-data barcode printed on it.
NOTE: The barcode and text are printed on the roll only when the loading and unloading processes
are started from the front panel.
NOTE: This option can be expected to work only with papers that are completely opaque. It may fail
with transparent or translucent papers.
To enable the Printing paper info option, go to the front panel and press

, then

, then

Setup > Printing preferences > Paper options > Enable printing paper info.
NOTE: Enabling this option slightly changes the paper loading and unloading procedures.

Move the paper
If the printer is idle (ready to print), you can move the paper forwards or backwards from the front
panel. You may want to do this in order to have more or less white space between the last print and
the next one.
To move the paper, press

, then

, then Paper > Move paper.

NOTE: You cannot use this option to move the paper in the scanner.

Maintain paper
●

Store rolls covered by another piece of paper or cloth.

●

Store cut sheets covered and clean or brush them before loading them into the product.

●

Clean input and output platens.

●

Do not lift the scanner and leave it raised unnecessarily.

Paper handling

To maintain paper quality, follow the recommendations below.

NOTE: Photo and coated papers require careful handling: they can easily be marked or scratched,
especially if touched soon after printing.
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Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints
where time is of higher importance or when you need to be sure ink is dry before handling.
Press

, then

, then Setup > Print retrieval > Select drying time. You can select:

●

Extended, to set a longer than recommended time to ensure ink is completely dry

●

Optimal, to set the default and recommended time for your selected paper (this is the default
setting)

●

Reduced, to set a shorter than recommended time when quality is of lower importance

●

None, to disable the drying time and remove your print as soon as it finishes printing

CAUTION: If the ink is not dry when the print is removed it could leave ink in the output tray and
marks on the print.
NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right
away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts
the paper and then performs the printhead maintenance. However, if the dry time is greater than zero,
the printer does not cut the paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off
To turn the printer's paper cutter on or off:
●

From the HP Utility for Windows, select the Settings tab and change the Cutter option in
Printer Settings > Advanced.

●

From the HP Utility for Mac OS, select Configuration > Printer Settings > Advanced and
change the Cutter option.

●

From the Embedded Web Server, select the Setup tab, then Printer Settings > Advanced,
and change the Cutter option.

●

From the front panel, press

, then

, then Setup > Print retrieval > Enable cutter

and change the cutter option.
The default setting is On.
NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the
paper on loading, unloading and switching between rolls.

Paper handling

TIP: To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper
on page 53.
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Feed and cut the paper
If you go to the front panel and press

, then

, then Paper > Form feed and cut, the printer

advances the paper and makes a straight cut across the front edge. There are several possible reasons
why you might want to do this.
●

To trim the leading edge of the paper if it is damaged or not straight.

●

To feed and cut the paper when the automatic cutter has been disabled.

●

To cancel the waiting time and print the available pages immediately, if the printer is waiting to
nest more pages.

NOTE: The printheads are serviced after each print, and the paper cannot be cut until the process
completes, so you may notice a delay.
CAUTION: Remove the cut piece from the output tray. If strips or short prints are left in the output tray
the printer could jam.

NOTE: Photo and coated papers require careful handling: they can easily be marked or scratched,
especially if touched soon after printing.

Paper handling

TIP: To move the paper without cutting it, see Move the paper on page 51.
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Working with two rolls

The uses of a multiroll printer
A multiroll printer can be useful in several different ways:
●

The printer can automatically switch between different paper types according to your needs.

●

The printer can automatically switch between different paper widths according to your needs. This
enables you to save paper by printing smaller images on narrower paper.

●

If you load two identical rolls into the printer, you can leave it printing unattended for a long time,
because it can switch from one roll to the other automatically when the first is exhausted. See
Unattended printing/overnight printing on page 72.

When working with multiple rolls, bear in mind that a protected roll is protected from use unless the
roll number or its paper type are specifically requested. See Roll protection on page 72.
The current status of both rolls is shown on the front panel if you press

.

NOTE: When you print from a USB flash drive or using HP Direct Print, multiroll printing is
considerably simplified: either you specify manually which roll you want to use, or you can select Save
paper, in which case the printer chooses the narrowest roll on which the print will fit. You cannot
specify the paper type.

How the printer allocates jobs to paper rolls
NOTE: The information in this section applies only when printing from a printer driver, the Embedded
Web Server or the HP Utility.
When you submit a print job, you can specify (using the Paper type or Type is option) that you
want it to be printed on a particular paper type; you can even specify (using the Paper source,
Source is or Paper Feed option) that you want it to be printed on a particular roll (1 or 2). The
printer will try to satisfy these requirements, and it will also look for a paper roll large enough to print
the image without clipping.
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●

If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy.
See Roll switching options on page 32.

●

If just one of the rolls is suitable for the job, it will be printed on that roll.

●

If neither roll is suitable for the job, it will be held in the job queue with the status On hold for
paper, or printed on an unsuitable roll, depending on the paper mismatch action. See Paper
mismatch action on page 32.
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●

●

Two rolls

Here are some settings that might be used in typical situations:
With different paper types loaded:
◦

Type: select the paper type you require

◦

Source: Automatically select / Predetermined

◦

Roll switching policy: doesn't matter

With different paper widths loaded:
◦

Type: Any

◦

Source: Automatically select / Predetermined

◦

Roll switching policy: Minimize paper waste

TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper
economically on page 70.
●

ENWW

With identical rolls loaded:
◦

Type: Any

◦

Source: Automatically select / Predetermined

◦

Roll switching policy: Minimize roll changes

How the printer allocates jobs to paper rolls
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Print from a computer using HP Direct Print

●
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Print from a computer using a printer driver

●

Advanced print settings
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Introduction
There are five different ways in which you can choose to print, depending on your circumstances and
preferences.
Print a TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a USB flash drive. See Print
from a USB flash drive on page 57.

●

Print a file that is already in one of the product's two job queues. See Reprint a job from the queue
on page 81.

●

Print a TIFF, JPEG, HP-GL/2, RTL, PDF, PostScript, PPT, PPTX or DWF file directly from a computer
connected to the product by USB cable. See Print from a computer using HP Direct Print
on page 58.

●

Print a TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a computer connected to the
product, using the Embedded Web Server or the HP Utility. See Print from a computer using the
Embedded Web Server or HP Utility on page 60.

●

Print any kind of file from a computer connected to the product by network or USB cable, using a
software application that can open the file, and a printer driver supplied with your product. See
Print from a computer using a printer driver on page 61.

Printing

●

NOTE: To print PDF or PostScript files, the T2300 PS is required.

Print from a USB flash drive
1.

Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript files
into one of the product's USB ports.
NOTE: To print PDF or PostScript files, the T2300 PS is required.
NOTE: The use of USB flash drives with your product may be disabled in the Embedded Web
Server (Setup > Security > Disable USB drives or Disable USB printing).

2.
3.

ENWW

At the front panel, go to the home screen and press

Press

.

.

4.

; files that cannot be
Select the file to be printed. Files that can be printed are indicated with
printed are indicated with
. You can press folders to browse their contents.

5.

The default print settings are displayed. If you want to change them, press Settings. The
following settings are available:
●

Size allows you to resize the print in two different ways: to a percentage of its original size,
or to fit a particular paper size. The default is 100% (its original size).

●

Color allows you to choose color or grayscale printing.

●

Print quality allows you to set the print quality to Best, Normal or Fast.

Introduction
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●

Roll allows you to specify printing on roll 1 or roll 2, or you can choose Save paper,
which automatically chooses the narrowest roll on which the print will fit.

●

Rotation allows you to rotate the print by any multiple of 90°, or you can choose
Automatic, which rotates the print automatically if that will save paper.

NOTE: If you change the settings in this way, the changed settings apply to the current job but
are not saved permanently. You can change the default settings from the main menu: press
,
then
6.

, then Print from USB preferences.

To display a preview of the printed job on the front panel, press

.

When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.

Printing

7.

When you are satisfied with the print settings, press Start.

8.

If two rolls are loaded, you can choose to print on either roll, or you can let the printer choose
automatically.
NOTE: The printer will automatically rotate the image by 90° if it can save paper by doing so.

9.

After printing, you can choose to print another file or go to the job queue. If you print another file
immediately without returning to the home screen, the temporary settings used for the previous file
are used again.

Print from a computer using HP Direct Print
1.
2.

At the front panel, go to the home screen and press
Press

.

.

3.

Connect the computer to the Hi-Speed USB device port at the rear of the product.

4.

The front panel asks whether you want to print from an application, or using HP Direct Print.
NOTE: If you always select the same response, you can avoid this question before starting this
procedure by pressing
, then
, then Setup > Direct printing preferences > Direct
print.

5.
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Under Windows XP, the HP Instant Printing utility is automatically started.

●

Under later versions of Windows, you must start HP Instant Printing by opening the productas-disk-drive and then double-clicking the hpip.exe file that you will find inside it.

Printing

●

When you see the HP Instant Printing window as above, you can click Add files to select files to
be printed; adjust the print settings in the same window; and then click Print to print the selected
files.
HP Instant Printing allows you to print the following file formats:
●

TIFF

●

JPEG

●

HP-GL/2

●

RTL

●

PDF (T2300 PS only)

●

PostScript (T2300 PS only)

●

PPT (if you have Microsoft Office 2003 or 2007 installed on the same computer)

●

PPTX (if you have Microsoft Office 2007 installed on the same computer)

●

DWF (if this does not work, install HP Instant Printing on the same computer instead of
running it from your T2300 product)

NOTE: HP Instant Printing is designed to be simple, and it offers relatively few print settings. If
you need an explanation of these settings, please see the online help.
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Print from a computer using the Embedded Web
Server or HP Utility
You can print files in this way from any computer that can access the product's Embedded Web Server.
See Access the Embedded Web Server on page 37.
From the Embedded Web Server, select the Main tab and then Submit job. From the HP Utility,
select Job Center > Submit Job. You will see the window below.

Printing
Press the Add files button to choose the files from your computer that you want to print. The files must
be in one of the following formats:
●

HP-GL/2

●

RTL

●

TIFF

●

JPEG

●

PDF (T2300 PS only)

●

PostScript (T2300 PS only)

NOTE: When you print to a file, the file should be in one of the above formats, but its name may
have an extension such as .plt or .prn.
If the files are not in one of these formats, they will not be printed successfully.
If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and they will be sent to the printer.
If you need to specify printing settings, go to the Job settings section and select the options you need.
Each option has explanatory text on the right, so that you can understand the behavior of each setting.
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Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job
contains no setting, the setting in the printer will be used.
If you have chosen some non-default settings and expect to reuse the same group of settings in the
future, you can save them all under a single name from the Manage presets tab, and recall them
using that name later.

Print from a computer using a printer driver

Printing

This is the traditional way of printing from a computer. The correct printer driver must be installed on
the computer (see Installing the software on page 14), and the computer must be connected to the
product by network or USB cable.
If you connect by USB cable, the front panel will ask whether you want to print with a printer driver, or
with HP Direct Print.
When the printer driver has been installed and the computer is connected to the product, you can print
from a software application by using the application's own Print command and selecting the correct
printer.

Advanced print settings
The rest of this chapter explains the various print settings that you can use when printing with a printer
driver, the Embedded Web Server or the HP Utility. These methods offer a relatively large number of
settings in order to satisfy all requirements.
TIP: In general you are recommended to use the default settings unless you know that they do not
meet your requirements.
TIP: If you intend to reuse a particular group of settings repeatedly, you can save those settings under
a name of your own choice and recall them later. A saved group of settings is known as a 'quick set' in
the Windows printer driver, and as a 'preset' in the Embedded Web Server.

Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed,
while fast printing implies some reduction in print quality.
Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed. With some paper types, you can choose a compromise position between the two.
Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you
can also select Economode, which uses a lower rendering resolution and consumes less ink. It
therefore increases printing speed even further, but reduces print quality. Economode can be selected
only from the custom options (not from the slider).
There is also a supplementary custom option that may have an effect on print quality: Maximum
detail. See High-quality printing on page 67.
NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom
Print Quality Options dialog box (select Custom options and then Settings). In the Mac OS Print
dialog, it is displayed in the Summary panel.
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You can select print-quality options in the following ways:

Printing

●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. If you select Standard Options, you will see a simple slider with which you can select
speed or quality. If you select Custom Options, you will see the more specific options described
above.

●

In the Mac OS Print dialog (T2300): go to the Paper/Quality panel and look at the
Quality Options section. If you select Standard quality options, you will see a simple slider with
which you can select speed or quality. If you select Custom quality options, you will see the more
specific options described above.

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): go to the Paper/
Quality panel and look at the Quality Options section. If you select Standard quality options,
you will see a simple slider with which you can select speed or quality. If you select Custom
quality options, you will see the more specific options described above.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): go to the Image Quality
panel. If you select Standard quality options, you will see a simple slider with which you can
select speed or quality. If you select Custom quality options, you will see the more specific
options described above.

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality. If you then select Standard options, you can choose between Speed and Quality.
If you select Custom options, you will see the more specific options described above.

●

Using the front panel: press

, then

, then Setup > Printing preferences > Print

quality.
NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the
front panel.
NOTE: You cannot change the print quality of pages that the printer is already receiving or has
already received (even if they have not started to print yet).

Select paper size
The paper size can be specified in the following ways.
NOTE: The paper size specified here should be the paper size in which the document was created. It
is possible to rescale the document to a different size for printing. See Rescale a print on page 64.
●

In the Windows driver dialog: select the Paper/Quality tab, then select your paper size
from the Document Size list.

●

In the Mac OS Page Setup dialog: select your printer from the Format for list, then select
your paper size from the Paper Size list.
NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Paper > Page size > Standard.

●

Using the front panel: press

, then

, then Setup > Printing preferences >

Paper options > Select paper size.
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NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front
panel.

Custom paper sizes
To choose a non-standard paper size not shown in the list of paper sizes:
Under Windows, there are two different ways:
◦

In the driver dialog, click the Custom button in the Paper/Quality tab, then specify the
name and the dimensions of your new paper size, then click Save to save your new paper
size. To see your new custom size in the list of custom sizes, you need to exit the printer
properties, then reenter them (and use the More button if necessary).
NOTE: The driver will not allow you to create a paper size whose width exceeds its length.

◦

●

From the Start menu, select Printers and Faxes, then from the File menu select Server
Properties. In the Forms tab, check the Create a new form box, specify the name and
dimensions of the new form, then click Save Form.

Under Mac OS: select Paper Size > Manage Custom Sizes in the Page Setup dialog.
NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Paper > Page size > Custom.

Select margins options
By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the
paper (increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in
several ways.
●

In the Windows driver dialog: select the Paper/Quality tab and then the Margins/
Layout button.

●

In the Mac OS Print dialog (T2300): select the Margins/Layout panel.

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): select the
Margins/Layout panel.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): select the Finishing panel
and then Layout.

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Paper > Layout/Margins.

You will then see at least some of the following options.
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Printing

●

NOTE: Under Mac OS, the available margins options depend on the paper size selected. For
instance, for borderless printing you must select a paper size name that includes the words “no
margins”.
Standard. Your image will be printed on a page of the size you have selected, with a narrow
margin between the edges of the image and the edges of the paper. The image should be small
enough to fit between the margins.

●

Oversize. Your image will be printed on a page slightly larger than the size you have selected. If
you cut off the margins, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper.

●

Clip Contents By Margins. Your image will be printed on a page of the size you have
selected, with a narrow margin between the edges of the image and the edges of the paper. In
this case, if the image is the same size as the page, the printer assumes that the extreme edges of
the image are either white or unimportant, and do not need to be printed. This may be useful
when your image already contains a border.

●

Borderless. Your image will be printed on a page of the size you have selected, with no
margins. The image is slightly enlarged to ensure that no margin is left between the edges of the
image and the edges of the paper. If you select Automatically by Printer, this enlargement is
done automatically. If you select Manually in Application, you must select a custom page size
slightly larger than the page on which you intend to print. See also Print with no margins
on page 68.

Printing

●

Print on loaded paper
To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your
printer driver.
●

In the Windows driver dialog: select the Paper/Quality tab, then select Any in the Paper
Type drop-down list.

●

In the Mac OS Print dialog (T2300): select the Paper/Quality panel, then select Any in the
Paper Type drop-down list.

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): select the Paper/
Quality panel, then select Any in the Paper Type drop-down list.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): select the Image Quality
panel, then select Any in the Paper Type drop-down list.

NOTE: Any is the default Paper Type selection.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful:
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●

If your software does not support large formats

●

If your file is too large for the printer's memory—in this case, you can reduce the paper size in
your software and then scale it up again using the front-panel option
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You can rescale an image in the following ways:
In the Windows driver dialog: go to the Features tab and look at the Resizing Options
section.
◦

The Print document on option adjusts the image size to the paper size you have selected.
For example, if you have selected ISO A2 as the paper size and you print an A3-sized
image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer
reduces a larger image to fit the A4 size. This option avoids clipping, but does not guarantee
to maintain the original proportions of the image.

◦

The % of actual size option enlarges the printable area of the original paper size (the
page minus the margins) by the percentage indicated, then adds the margins to create the
output paper size. This option maintains the original proportions of the image, but does not
guarantee to avoid clipping.

Printing

●

●

In the Mac OS Print dialog (T2300): select the Paper Handling panel, then Scale to fit
paper size, and select the paper size to which you want to scale the image. If you want to
increase the size of the image, make sure that the Scale down only box is unchecked.

●

In the Mac OS Print dialog (T2300 PS): select the Finishing panel, then Print document
on, and select the paper size to which you want to scale the image. For example, if you have
selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2
paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

●

On the Embedded Web Server's Submit Job page: select Advanced settings >
Resizing.

●

◦

The Standard and Custom options adjust the image size to the standard or custom paper
size you have selected. For example, if you have selected ISO A2 as the paper size and you
print an A4-size image, it is enlarged to fit the A2 paper. If the ISO A3 paper size is
selected, the printer reduces a larger image to fit the A3 size.

◦

The % of actual size option enlarges the printable area of the original paper size (the
page minus the margins) by the percentage indicated, then adds the margins to create the
output paper size.

Using the front panel: press

, then

, then Setup > Printing preferences >

Paper options > Resize.
If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet,
otherwise the image will be clipped.

Change the treatment of overlapping lines
NOTE: This topic applies only when printing an HP-GL/2 job.
The merge option controls the overlapping lines in an image. There are two settings:
●

Off: where the lines cross, only the color of the top line is printed. This is the default setting.

●

On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and press

, then

, then Setup > Printing

preferences > HP-GL/2 options > Enable merge. You can set the merge option from your
software in some applications. Settings in your software override the front-panel settings.
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Preview a print
Previewing a print on the screen allows you to check the layout of the print before printing, which may
help you to avoid wasting paper and ink on a bad print.
●

●

To preview a print under Windows, you have the following options:
◦

Use your application's print preview option.

◦

Check the Show preview before printing option, which you can find in the driver's
Printing Shortcuts tab, Paper/Quality tab and Features tab. The preview may be
provided in different ways, depending on your printer and printer driver.

To preview a print under Mac OS, you have the following options:

Printing

◦

Use your application's print preview option.

◦

Click the Preview button at the bottom of the Print dialog box. This is the basic print
preview provided by Mac OS.

◦

If you are using the PostScript printer driver, check the Show print preview option, which
you can find in the driver's Printing dialog, in the Finishing panel. This preview is
provided by the Embedded Web Server and will appear in a Web browser window.
NOTE: This option does not work if the product is connected by USB cable to a different
computer (printer sharing).

◦

If you are using the PCL driver, check the Show print preview option, which you can find
in the driver's Printing dialog, in the Finishing panel. This provides a preview with more
features, such as the ability to change paper size, paper type and print quality, and to rotate
the image.
NOTE: This option does not work if the product is connected by USB cable to a different
computer (printer sharing).

●

To preview a print using the Embedded Web Server, select Basic settings > Hold for
preview.

Print a draft
You can specify fast draft-quality printing in the following ways:
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. Move the print-quality slider to the extreme left ('Speed').

●

In the Mac OS Print dialog (T2300): go to the Paper/Quality panel and move the printquality slider to the extreme left ('Speed').

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): go to the Paper/
Quality panel and move the print-quality slider to the extreme left ('Speed').

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): go to the Image Quality
panel and move the print-quality slider to the extreme left ('Speed').

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Standard options > Speed.

●

Using the front panel: press

, then

, then Setup > Printing preferences > Print

quality > Select quality level > Fast.
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●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. Select Custom Options, then set the quality level to Fast and check the Economode
box.

●

In the Mac OS Print dialog (T2300): go to the Paper/Quality panel and set the quality
options to Custom, then set quality to Fast and check the Economode box.

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): go to the Paper/
Quality panel and set the quality options to Custom, then set quality to Fast and check the
Economode box.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): go to the Image Quality
panel and set the quality options to Custom, then set quality to Fast and check the Economode
box.

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Custom. Set Quality level to Fast, and Economode to On.

●

Using the front panel: press

, then

, then Setup > Printing preferences > Print

quality > Enable economode.
NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

High-quality printing
You can specify high-quality printing in the following ways:
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality
section. Move the print-quality slider to the extreme right ('Quality').

●

In the Mac OS Print dialog (T2300): go to the Paper/Quality panel and move the printquality slider to the extreme right ('Quality').

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): go to the Paper/
Quality panel and move the print-quality slider to the extreme right ('Quality').

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): go to the Image Quality
panel and move the print-quality slider to the extreme right ('Quality').

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Standard options > Quality.

●

Using the front panel: press

, then

, then Setup > Printing preferences > Print

quality > Select quality level > Best.
NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

If you have a high-resolution image
If your image has a resolution greater than the rendering resolution (which you can see in the Custom
Print Quality Options box under Windows), print sharpness may be improved by selecting the
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Printing

You can specify even faster draft-quality printing by using Economode, as follows. This is intended
mainly for documents containing only text and line drawings.

Maximum Detail option. This option is available only if you are printing on glossy paper and you have
selected Best print quality.
●

In the driver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality
options, then check the Maximum Detail box.

●

On the Embedded Web Server's Submit Job page: select Basic settings > Print
quality > Custom. Set Quality level to Best, and Maximum detail to On.

●

Using the front panel: press

, then

, then Setup > Printing preferences > Print

quality > Enable maximum detail.

Printing

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not
increase the amount of ink used.

Print in gray shades
You can convert all colors in your image to shades of gray in the following ways:
●

In your application program: many programs provide this option.

●

In the Windows driver dialog: go to the Color tab and look at the Color Options section.
Select Print in Grayscale. You can also select Print in pure black and white if you want
only black and white, without gray shades.

●

In the Mac OS Print dialog (T2300): go to the Color Options panel and select
Grayscale from the Mode drop-down list. You can also select Pure Black and White if you
want only black and white, without gray shades.

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): go to the Color
Options panel and select Grayscale from the Mode drop-down list. You can also select Pure
Black and White if you want only black and white, without gray shades.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): go to the Color Options
panel and select Print In Grayscale. You can also select Print in Pure Black and White if
you want only black and white, without gray shades.

●

On the Embedded Web Server's Submit Job page: select Color, then set Color/
Grayscale to Print In Grayscale. You can also select Pure Black and White if you want
only black and white, without gray shades.

Print with no margins
Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done
only on rolls of glossy paper.
In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink
deposited outside the paper is absorbed by the sponge situated in the platen.
You can request printing with no margins in the following ways:
●

In the Windows driver dialog: select the Paper/Quality tab and press the Margins/
Layout button. Then select Borderless.

●

In the Mac OS Page Setup dialog (T2300): select a paper size name that includes the
words “no margins”. Then, in the Print dialog, select Margins/Layout > Borderless.
NOTE: If your application offers no Page Setup dialog, please use the Print dialog.
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●

In the Mac OS X 10.5 or 10.6 PostScript Page Setup dialog (T2300 PS): select a
paper size name that includes the words “no margins”. Then, in the Print dialog, select
Margins/Layout > Borderless.
NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

●

In the Mac OS X 10.4 PostScript Page Setup dialog (T2300 PS): select a paper size
name that includes the words “no margins”. Then, in the Print dialog, select Finishing >
Layout > Borderless.
NOTE: If your application offers no Page Setup dialog, please use the Print dialog.
On the Embedded Web Server's Submit Job page: select Advanced settings >
Paper > Layout/Margins > Borderless.

Printing

●

When you select Borderless, you must also select one of the following Image Enlargement options:
●

Automatically by printer means that the printer automatically enlarges your image slightly
(normally by a few millimeters in each direction) in order to print over the edges of the paper.

●

Manually in application means that you must enlarge the image yourself in your application,
and select a custom paper size that is slightly larger than the actual paper size.

NOTE: If the first print job after loading paper is a borderless job, the printer may trim the leading
edge of the paper before printing.
At the end of a borderless print, the printer normally cuts the print slightly inside the image area to
ensure that the print is borderless. It then cuts the paper again so that no residual part of the image is
included in the next print. However, if the job is cancelled, or if there is white space at the bottom of
the image, only a single cut is made.

Print with crop lines
Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print
crop lines with individual jobs in the following ways:
●

In the Windows driver dialog: select the Features tab, then Crop lines.

●

In the Mac OS Print dialog: select the Finishing panel, then Crop lines.

●

On the Embedded Web Server's Submit Job page: select Advanced settings > Roll
options > Enable crop lines > Yes.

Alternatively, you can choose to print crop lines with all jobs by default:
●

In the Embedded Web Server: select Setup > Printer settings > Job management >
Use crop lines when printing > On.

●

Using the front panel: press

, then

, then Setup > Printing preferences >

Paper > Enable crop lines > On.
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To print crop lines with nested jobs (see Nest jobs to save roll paper on page 70), you must select a
different option:
●

In the Embedded Web Server: select Setup > Printer settings > Job management >
Use crop lines when nest is enabled > On.

●

Using the front panel: press

, then

, then Setup > Job management > Nest

options > Enable crop lines > On.

Use paper economically
Here are some recommendations for making economical use of paper:

Printing

●

If you are printing relatively small images or document pages, you can use nesting to print them
side by side instead of one after another. See Nest jobs to save roll paper on page 70.

●

You may be able to save some roll paper by using the following options:

●

◦

In the Windows driver dialog: select the Features tab and then Remove top/
bottom blank areas and/or Rotate by 90 degrees. In the PostScript driver, you can
also select Autorotate.

◦

In the Mac OS Print dialog (T2300): select the Finishing panel, then Remove Top/
Bottom Blank Areas.

◦

In the Mac OS PostScript Print dialog (T2300 PS): select the Finishing panel, then
Remove Top/Bottom Blank Areas and/or Autorotate.

◦

On the Embedded Web Server's Submit Job page: select Advanced settings >
Roll options > Remove top/bottom blank areas and/or Rotate.

If you check the print preview on your computer before printing, you can sometimes avoid wasting
paper on prints containing obvious mistakes. See Preview a print on page 66.

Nest jobs to save roll paper
Nesting means automatically printing images or document pages side by side on the paper, rather than
one after the other. This is done to avoid wasting paper.
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1.

Direction of paper flow

2.

Nesting off
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3.

Nesting on

4.

Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true:
●

The printer is loaded with roll paper, not sheet paper.

●

The printer's Nest option is not turned off. See Turn nesting on and off on page 32.

What pages can be nested?
Printing

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or
unless there are too many of them to fit into the remaining length of the roll. A single group of nested
pages cannot be split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all of the following ways:
●

All pages must have the same print quality setting (Economode, Fast, Normal or Best).

●

The Maximum Detail setting must be the same on all pages.

●

The Layout/Margins setting must be the same for all pages.

●

The Mirror Image setting must be the same for all pages.

●

The Rendering Intent must be the same for all pages.

●

The Cutter setting must be the same for all pages.

●

The color adjustment settings must be the same for all pages. See Color adjustment options
on page 91.

●

Pages must be all color, or all grayscale: not some in color and some in grayscale.

●

All pages must be in one or other of the following two groups (the two groups cannot be mixed in
the same nest):

●

◦

HP-GL/2, RTL, TIFF, JPEG

◦

PostScript, PDF

JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some
cases.

How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after a file has been received to check
whether a subsequent page will nest with it or with pages already in the queue. This waiting period is
the nest wait time; the factory default nest wait time is two minutes. This means that the printer waits for
up to two minutes after the last file is received before printing the final nest. You can change this
waiting time from the printer's front panel: press
, then
, then Setup > Job management
options > Nest options > Select wait time. The available range is 1 to 99 minutes.
While the printer is waiting for nesting to time out, it displays the remaining time on the front panel.
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Use ink economically
Here are some recommendations for making economical use of ink.

Printing

●

For draft prints, use plain paper and move the print-quality slider to the left end of the scale
('Speed'). For further economy, select custom print quality options, then select Fast and
Economode.

●

Clean the printheads only when needed, and clean only those printheads that need cleaning.
Cleaning the printheads can be useful, but it uses a small amount of ink.

●

Leave the product permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printheads.

●

Wide prints make more efficient use of ink than narrow prints, because printhead maintenance
uses some ink, and its frequency is related to the number of passes made by the printheads.
Therefore, nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper
on page 70).

Roll protection
If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll
number or the paper type loaded on the roll. This may be useful, for example, in the following cases.
●

To stop people from accidentally printing unimportant jobs on expensive paper.

●

To avoid printing on a particular roll when printing from AutoCAD without interacting with the HP
printer driver.

To protect a roll, go to the front panel and press

, then

, then Setup > Printing

preferences > Paper options > Roll protection.
NOTE: If you protect a roll, then later unload the current roll and load a new one, the new roll
remains protected. You are protecting the roll number, not one specific roll of paper. That roll number
will remain protected until you cancel the protection.
TIP: If you print without specifying a roll number or paper type, you will not be able to print on any
protected roll.

Unattended printing/overnight printing
The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent
image quality.
Here are some recommendations to help you deal with a long queue of printing jobs.
●

If feasible, use brand-new long rolls of paper.

●

If you want to print on partly-used rolls, you can check the paper type and the remaining length in
the Embedded Web Server or in the front panel, to confirm that you have enough paper to print
all your jobs.
NOTE: Information on the remaining length is available only if you told the printer the length of
the roll when you loaded it, or if the printer read the length of the roll from the barcode printed on
it.
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●

Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically
switch to the other.

●

Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may
be put “on hold for paper” if the paper mismatch action is set to Put job on hold (see Paper
mismatch action on page 32).

●

Check the ink levels remaining in your ink cartridges.

●

When you have submitted your print jobs, you can use the Embedded Web Server from a remote
location to monitor their status.

●

Drying time should be set to Optimal.

●

Press

Printing

, then Setup > Printing preferences > Paper options > Roll

, then

switching options > Minimize roll changes or Use roll with less paper.
We recommend the following settings, depending on the paper type and what kind of prints you are
making.
Table 7-1 Recommended settings for unattended printing
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Print type

Print mode

MaxDetail

Drying time

Paper types

Lines

Normal

Off

Optimal

Coated, Bond,
Heavyweight Coated,
Glossy

Lines and fills

Normal

On

Optimal

Coated, Bond,
Heavyweight Coated,
Glossy

Maps

Best

On

Optimal

Coated, Heavyweight
Coated, Glossy

Renderings,
photographs

Best

On

Optimal

Coated, Heavyweight
Coated, Glossy
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Scanning

Paper types suitable for scanning
The scanner does not support the full range of paper types that may be used by the printer.
The following paper types are supported by the scanner.

Scanning

●

White paper to scan any matte original printed with inkjet technology. Choose this option to
scan, for instance, anything printed with this product on any of these paper types: HP Universal
Inkjet Bond Paper, HP Coated Paper, HP Heavyweight Coated Paper, plain paper.

●

Photo paper to scan glossy and satin originals. Inkjet, offset and traditional photo technologies
are supported by this option. Choose this option to scan, for instance, any photo or other image
printed on any of these paper types: HP Universal High Gloss Photo Paper, HP Premium Instant
Dry Gloss/Satin Photo Paper. However, for some specific photo originals, this option may not give
completely accurate results, in which case you could try White paper instead.
CAUTION:

Photo and glossy papers may be scratched while passing through the scanner.

●

Old/recycled paper to scan matte originals printed on recycled paper or very old originals,
the background of which is no longer white. Choose this option to scan, for instance, anything
printed on this product using HP Recycled Bond Paper, or any old print on plain paper that has
become yellowish over the years.

●

Translucent paper to scan semi-transparent tracing papers (> 65 g/m²), including HP Natural
Tracing Paper, HP Vellum and HP Translucent Bond.

●

Blueprints for scanning blueprint originals with optimum results, in grayscale only. This option
greatly enhances the contrast of the resulting image.

For best results, you should select the correct paper type in the scan settings before scanning.
The following paper types are not supported by the scanner.
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●

Film

●

Backlit material

●

Cling material

●

Translucent paper (< 65 g/m²)
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Scan to file
1.

Load the sheet with the printed side facing upwards (you can also load the sheet before step 1, if
you prefer). Align the center of the sheet approximately with the center of the scanner. Use the
standard size markings to help you.

NOTE: The scanner can scan a maximum length of 2378 mm (93.62 in). A longer sheet than
this can be moved through the scanner, but only the first 2378 mm (93.62 in) will be scanned. An
alert is displayed if the maximum length is exceeded.

2.

Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will
automatically grab the sheet and move it into position for scanning. You can press
to eject the
sheet if you feel that it has loaded badly and you want to try again.

3.

At the front panel, go to the home screen and press

Scanning

NOTE: Scanned images may be saved to PDF files with the T2300 PS only.

, then select where you would like to

store the scanned image.
●

In a USB flash drive
NOTE: The use of USB flash drives with your product may be disabled in the Embedded
Web Server (Setup > Security > Disable USB drives).

●

In a network folder (a folder on a computer that is accessible through the network)
NOTE: The network folder option will not work unless the network folder has been correctly
set up and identified in the Embedded Web Server or HP Utility: see Create a scan-tonetwork folder on page 26.
TIP:
then

To check the currently-configured network folder, go to the front panel and press

,

.

NOTE: If the scanner is later unable to store your file in the chosen destination (USB flash drive
or network folder), you are given the opportunity to change your mind and use the other
alternative.
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4.

Some of the default scan settings are displayed. Press Settings to see the complete list of settings,
and check in particular that the Paper type setting corresponds to the paper type that you intend
to scan.
●

Format allows you to specify the format of the file in which the scanned image will be
saved: TIFF, JPEG or (with the T2300 PS only) PDF.

●

Quality allows you to specify the scan resolution: Standard (200 dpi), High (300 dpi), or
Max (600 dpi).

●

Color allows you to choose color, grayscale or black and white scanning.

●

Content type allows you to optimize the scan for a line drawing, a photographic image, or
a mixed image.

●

Original type allows you to specify the paper type on which the original image has been
printed. To optimize scan quality, ensure that this setting is correct.

●

Background removal allows you to remove unwanted background color. You can specify
the strength of this setting, from 0 to 10.

NOTE: If you change the settings in this way, the changed settings apply to the current job but
are not saved permanently. You can change the default settings from the main menu: press
,
then Scan preferences.

Scanning

5.

When you are satisfied with the scan settings, press anywhere on the screen to return to the
previous page, then press Start.

6.

The filename of the scanned image is generated automatically; it is guaranteed not to overwrite an
existing file.

7.

If you are scanning to a USB flash drive, wait until the scanned image has been saved in a file,
on the front panel and press Eject. Remove the USB flash drive when prompted by
then press
the front panel.

8.

Press

9.

After scanning, you can choose to scan again or go to the job queue.

to eject the scanned sheet from the scanner; be ready to pick it up.

TIP: All scan jobs are saved in the scan queue, where they can be accessed by any user. If your job
is private, you may wish to delete it from the queue after recovering the image file.
TIP: If you scan an image to a file and then decide to print it one or more times, you can change the
print settings every time. You can also save it to another location.
NOTE: By default, if the original is skewed in the scanner (not loaded straight), the scanner will try to
correct the skew automatically. To turn off this automatic correction, press
, then
, then Scan
preferences > De-skew > Off.
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Copying

Before starting to copy, see Paper types suitable for scanning on page 74.
1.

Load the sheet with the printed side facing upwards (you can also load the sheet before step 1, if
you prefer). Align the center of the sheet approximately with the center of the scanner. Use the
standard size markings to help you.

NOTE: The scanner can scan a maximum length of 2378 mm (93.62 in). A longer sheet than
this can be moved through the scanner, but only the first 2378 mm (93.62 in) will be scanned. An
alert is displayed if the maximum length is exceeded.

3.

4.

ENWW

Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will
automatically grab the sheet and move it into position for scanning. You can press
to eject the
sheet if you feel that it has loaded badly and you want to try again.
At the front panel, go to the home screen and press

.

Some of the default copy settings are displayed. Press Settings to see the complete list of settings,
and check in particular that the Paper type setting corresponds to the paper type that you intend
to scan.
●

Size allows you to resize the print in two different ways: to a percentage of its original size,
or to fit a particular paper size. The default is 100% (its original size).

●

Copy quality allows you to set the print quality to Best, Normal or Fast.

●

Copy color allows you to choose color or grayscale printing.

●

Roll allows you to specify printing on roll 1 or roll 2, or you can choose Save paper,
which automatically chooses the narrowest roll on which the print will fit.
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2.

●

Content type allows you to optimize the scan for a line drawing, a photographic image, or
a mixed image.

●

Original type allows you to specify the paper type on which the original image has been
printed. To optimize scan quality, ensure that this setting is correct.

NOTE: If you change the settings in this way, the changed settings apply to the current job but
are not saved permanently. You can change the default settings from the main menu: press
,
then

, then Copy preferences.

5.

When you are satisfied with the copy settings, press anywhere on the screen to return to the
previous page, then press Start.

6.

If two rolls are loaded, you can choose to print on either roll, or you can let the printer choose
automatically.
NOTE: The printer will automatically rotate the image by 90° if it can save paper by doing so.

7.

When the scan is complete, press
pick it up.

8.

While the scanned image is being printed, you can perform some other operation: you don't need
to wait for the end of the print.

9.

After printing, you can choose to make another copy or go to the job queue. If you make another
copy immediately without returning to the home screen, the temporary settings used for the
previous copy are used again.

to eject the scanned sheet from the scanner; be ready to

NOTE: By default, if the original is skewed in the scanner (not loaded straight), the scanner will try to
correct the skew automatically. To turn off this automatic correction, press
, then
, then Scan
preferences > De-skew > Off.

Copying
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The job queues in the front panel

●

The print job queue in the Embedded Web Server or HP Utility

Job queue

●
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Introduction
You can manage your product's job queues from the front panel, the Embedded Web Server or the HP
Utility.
●

To use the front panel, you must be standing in front of the product. The front panel gives access to
both of the job queues: the Print & Copy jobs, and the Scan jobs.

●

You can use the Embedded Web Server or the HP Utility from any remote computer with network
access to the product, but you can access only the Print & Copy jobs. The Scan jobs can be
accessed only from the front panel.

The job queues in the front panel
To see the job queues on the front panel, press

on the home screen. You can choose Print &

Copy Jobs or Scan Jobs from the tabs at the top of the screen.

Job queue page
The job queue page shows all jobs that are available in whichever job queue you have selected. The
print & copy queue includes jobs that are being received, parsed, rendered, printed and already
printed. The scan queue includes jobs that are being scanned and jobs that have been scanned.
Each line shows the name of the job and its status. Scan and copy jobs are assigned automaticallygenerated names. For more information on a particular job, including a preview of the job, press the
line showing the job.
Jobs that cannot be completed for any reason appear at the top of the queue.

Job preview
The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the
job. Job preview is available once the job is processed.
NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.
To preview a job, first press the name of the job in the job queue. The front panel displays a page of
information about the job. Then press
to see the preview.
NOTE: Previews may be blocked by an administrator, in which case you will not be able to see
them.
When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.
You can also press

to preview the previous job, or

to preview the next job.

Job queue

Select when to print a job in the queue
NOTE: The When To Start Printing options cannot be used with PostScript jobs.
You can select at what point you want to print a file you have in the queue. Press

, then

, then

Setup > Job management options > When to start printing.
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There are three options you can select:
●

When After Processing is selected, the printer waits until the whole page has been processed
and then it starts to print. This is the slowest setting but ensures the best print quality in large or
complex prints.

●

When Immediately is selected, the printer prints the page as it is processed. This is the quickest
setting, but the printer may stop halfway through a print to process data. This setting is not
recommended for complex images with dense color.

●

When Optimized is selected (this is the default setting), the printer calculates the best time to
begin printing the page. It is usually the best compromise between the After Processing and
Immediately settings.

Prioritize a job in the queue
You can select a job in the queue and make it the next one to be printed. After selecting the job, press
Move to front.
If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to
be printed next, and not nested with others, first turn nesting off and then move it to the front of the
queue as described above.
In the following cases, the Move to front button is not displayed:
●

The job is already at the front of the queue.

●

The job is on hold—in this case the Resume printing button is displayed instead.

●

The job has finished—in this case the Reprint button is displayed instead.

●

The job has some error condition.

Pause a job in the queue
If you select the job in the queue that is currently printing, you will see a Pause button, which you can
press to pause printing. The Pause button then changes to a Resume button, which you can press to
resume printing.
Alternatively, you can press the Options button at the top right of the job queue screen, and then
press Pause printing.

Reprint a job from the queue
To reprint an already-printed job, select the job from the queue, then select Reprint.

Job queue

When reprinting a print job, you cannot change the print settings, because the job has already been
rasterized. However, you can also print a scanned job from the scan queue, and in this case you can
change the print settings.

Delete a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will
just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and
want to avoid printing it, you can simply select the job and then press Delete.
NOTE: An administrator password may be required.
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In the same way, you can delete a job that has not been printed yet.
If the job is currently being printed (its status is printing), you can press Cancel and then Delete.

Delete all jobs
To delete all jobs in a queue, press the Options button at the top right of the job queue screen, and
then press Delete all Print & Copy jobs or Delete all Scan jobs.
NOTE: An administrator password may be required.

Turn off the job queue
To turn off the job queue, press

, then

, then Setup > Job management options >

Enable queue > Off.

Job queue
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The print job queue in the Embedded Web Server or
HP Utility
The HP Utility provides a different way of accessing the Embedded Web Server's job management
facilities, but the facilities are exactly the same whether you use the Embedded Web Server or the HP
Utility.
To see the print queue in the Embedded Web Server, select Job queue in the Main tab.

Job queue page
By default, access to the job queue is open to all users. An administrator can set a password so that
users are required to enter a password for:
●

Seeing job previews

●

Canceling or deleting jobs

The job queue page shows all jobs that are available in the print queue. The print queue includes jobs
that are being received, parsed, rendered, printed and already printed.
The Embedded Web Server displays the following information for each print job:
●

Preview: Click the icon to see the job preview. The job preview is available once the job is
processed.

●

File name: Click the file name to see the properties of the job.

●

Status: Gives the current job status.

●

Pages: Number of pages in the job.

●

Copies: Number of copies printed.

●

Date: Date and time the product received the job.

●

User: The user's name.

●

Cancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job
remains stored in the product, but will not be printed unless you click Reprint.

●

Hold: Holds the select jobs until you click Continue to print.

●

Continue: All selected jobs, which are on hold, continue printing.

●

Reprint: Prints more copies of a job. Type the number of copies (default 1, maximum 99) and
click Print.

●

Move to front: Sends all selected jobs to the top of the job queue.

●

Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is
deleted.

Job queue

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title
of the corresponding column. You can perform the following operations on one or all jobs in the queue:

NOTE: The Delete operation can be disabled by an administrator.
●
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Refresh: Refreshes the page, ensuring the information is updated.
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NOTE: The job queue page does not automatically update.

Job preview
The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the
job. Job preview is available once the job is processed.
NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.
To reach the preview page, click the magnifying glass icon, which appears in the Preview column on
the job queue page. The preview page shows the following job details along with a thumbnail preview
of the job:
●

File name: The file name of the job.

●

Loaded paper: The type of paper loaded in the printer.

●

Job dimensions: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which
appears on the right hand side of the printer image.
NOTE: Browsers without the Adobe Flash plug-in show the job image as yellow shaded. Browsers
that have the Adobe Flash plug-in version 7 and above show an enhanced preview of the job image
inside the paper loaded in the printer.

Select when to print a job in the queue
NOTE: The When To Start Printing options cannot be used with PostScript jobs.
You can select at what point you want to print a file you have in the queue. Select the Setup tab, then
Printer settings > Start printing.
There are three options you can select:
●

When After Processing is selected, the printer waits until the whole page has been processed
and then it starts to print. This is the slowest setting but ensures the best print quality in large or
complex prints.

●

When Immediately is selected, the printer prints the page as it is processed. This is the quickest
setting, but the printer may stop halfway through a print to process data. This setting is not
recommended for complex images with dense color.

●

When Optimized is selected (this is the default setting), the printer calculates the best time to
begin printing the page. It is usually the best compromise between the After Processing and
Immediately settings.

Prioritize a job in the queue
Job queue

You can select any job in the queue and make it the next one to be printed. After selecting the job,
click Reprint.
If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to
be printed next, and not nested with others, first turn nesting off and then move it to the front of the
queue as described above.
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Delete a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will
just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and
want to avoid printing it, you can simply select the job and then select Delete.
In the same way, you can delete a job that has not been printed yet.
If the job is currently being printed (its status is printing), you can select Cancel and then Delete.

Reprint or copy a job in the queue
To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server
and click the Reprint icon, then specify the number of copies you want. The job will be moved to the
top of the queue. To make more than one print of a non-printed job in the queue from the front panel,
select the job and choose Copies, then specify the number of copies required. This overrides any value
set by your software.
NOTE: If Rotate was On when you sent the file, every copy will be rotated.
NOTE: You cannot use this method for PCL3GUI jobs. To reprint old jobs that are PCL3GUI, you may
be able to use your operating system's printer spooler, if you have already set the spooler to save old
jobs. This facility depends on your operating system.
NOTE: When reprinting a print job, you cannot change the print settings, because the job has
already been rasterized.

Job status messages
These are the possible job status messages, approximately in the order in which they may be seen:
●

Receiving: the printer is receiving the job from the computer

●

Waiting to process: the job has been received by the printer and is waiting to be rendered (for
jobs submitted through the Embedded Web Server only)

●

Processing: the printer is parsing and rendering the job

●

Preparing to print: the printer is performing writing system checks before printing the job

●

Waiting to print: the job is waiting for the print engine to become free to proceed with printing

●

Waiting for nest: the printer is set up with Nesting=On and is waiting for other jobs in order to
complete the nest and proceed with printing

●

On hold: the job was sent with the on hold for preview option and is on hold

Job queue

NOTE: Do not send a job for preview with more than 64 pages, this may cause the driver
software to crash.
NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the
partially printed job will appear in the queue as on hold when the printer is next turned on.
When you resume the job, it will start printing at the page at which it was interrupted.
●

ENWW

On hold for paper: the job can't be printed because the right paper is not loaded in the
printer. Load the required paper, see Printer paper handling on page 41, and click Continue to
resume the job
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●

On hold for accounting: the job can't be printed because the printer requires all jobs to have
an account ID: enter the account ID and then click Continue to resume the job
TIP: To set an account ID, see Require account ID on page 34.

●

Printing

●

Drying

●

Cutting paper

●

Ejecting page

●

Canceling: the job is being canceled, but will remain in the printer job queue

●

Deleting: the job is being deleted from the printer

●

Printed

●

Canceled: the job has been canceled by the printer

●

Canceled by user

●

Empty job: the job does not contain anything to print

Reactivate a job on hold
When the printer puts a job on hold you receive an alert, see Alerts on page 184, which explains why
the job is on hold. Follow the instructions on the screen to remove the hold and continue printing.

Turn off the job queue
To turn off the job queue, select the Setup tab, then Printer settings > Job management >
Queue and select Off.

Job queue
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Introduction
Your printer has been engineered with advanced hardware and software features to ensure predictable
and dependable results.
●

Color calibration for consistent colors.

●

One gray and two black inks provide neutral grays on all paper types.

●

The Photo Black ink provides pure blacks when printing on photo papers.

●

Color emulation of other HP Designjet printers.

How colors are represented
All devices that display color use a color model to represent color in numerical terms. Most monitors
use the RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-YellowblacK) color model.
An image can be converted from one color model to another, but in general the conversion is not
perfect. Your printer uses the RGB color model: the same color model that is used by your monitor.
This simplifies but does not completely solve the problem of matching colors. Each device represents
colors a little differently from another device, even if they use the same color model. However, software
can adjust the colors in an image according to the characteristics of the particular device, using a color
profile of the device, in order to achieve correct colors.

A summary of the color management process
To get the accurate and consistent colors that you want, you should follow these steps for each paper
type that you use.
1.

Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now
and then (see Color calibration on page 88). In addition, you may wish to calibrate
immediately before a particularly important print job for which color consistency is vital.

2.

When printing, select the correct color preset for the paper type you are using.

Color calibration
Color calibration enables your printer to produce consistent colors with the particular printheads, inks
and paper type that you are using, and under your particular environmental conditions. After color
calibration, you can expect to get similar prints from any two different printers situated in different
geographical locations.
Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of
the following circumstances:

88

●

Whenever a printhead is replaced

●

Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

●

Whenever the environmental conditions (temperature and humidity) change significantly
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and then
●

on the front panel. The status may be one of the following:

Recommended: the paper has not been calibrated.
NOTE: Whenever you update the product's firmware, the color calibration status of all papers is
reset to Recommended.

●

Obsolete: the paper has been calibrated, but the calibration is now out of date because a
printhead has been replaced, and should be repeated.

●

Done: the paper has been calibrated, and the calibration is up to date.

●

Disabled: this paper cannot be calibrated.
NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent
material.

You can also check the color calibration status by using the HP Utility.
You can start color calibration in the following ways:
●

From the HP Utility for Windows: select Color Center > Calibrate paper, and choose the
paper to be calibrated.

●

From the HP Utility for Mac OS: select Paper Preset Management from the HP Color Center
button and select Calibrate Paper.
group, choose the paper to be calibrated, press the

●

From the front panel: press

, then

, then Image quality maintenance > Calibrate

color..
The calibration process is fully automatic and can be performed unattended after you have loaded
paper of the type you wish to calibrate—which should be A4 or any larger size. If you have more than
one roll loaded, the product will ask which roll you want to use for the calibration.
The process takes about 3–5 minutes and consists of the following steps.
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1.

A calibration chart is printed, which contains patches of each ink used in your printer.

2.

The chart is allowed to dry for a period of time that depends on the paper type, so that the colors
have time to stabilize.

3.

The chart is scanned and measured.

4.

From the measurements, the printer calculates the necessary correction factors to apply for
consistent color printing on that paper type. It also calculates the maximum amount of each ink
that can be applied to the paper.

Color calibration
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You can check the color calibration status of the currently loaded paper at any time by pressing

Color management

Color management from printer drivers
Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that,
when you print an image, you see very similar colors as when you view the same image on your
monitor.
There are two basic approaches to color management for your printer:
●

Application-Managed Colors: in this case your application program must convert the colors
of your image to the color space of your printer and paper type, using the ICC profile embedded
in the image and the ICC profile of your printer and paper type.

●

Printer-Managed Colors: in this case your application program sends your image to the
printer without any color conversion, and the printer converts the colors to its own color space. The
details of this process depend on the graphics language that you are using.
◦

PostScript (T2300 PS): the PostScript interpreter module performs the color conversion
using the profiles stored in the printer and any additional profiles sent with the PostScript job.
This kind of color management is done when you are using the PostScript driver and you
specify printer color management or when you send a PostScript, PDF, TIFF or JPEG file
directly to the printer through the Embedded Web Server. In either case you have to select
the profiles to use as default (in case the job doesn't specify any) and the rendering intent to
apply.

◦

Non-PostScript (PCL, RTL, HP-GL/2): the color management is done using a set of
stored color tables. ICC profiles are not used. This method is somewhat less versatile than the
alternatives, but is a little simpler and faster, and can produce good results with standard HP
paper types. This kind of color management is done when you are using a non-PostScript
driver and you specify printer color management, or when you send a PCL, RTL or HP-GL/2
file directly to the printer through the Embedded Web Server.
NOTE: There are only two color spaces that the printer can convert to its own color space
using the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB
and ColorSync if you are using Mac OS.
ColorSync is the Mac OS built-in Color Management System; so, when you select ColorSync,
color management is performed by Mac OS, and it is done based on the ICC profiles of the
specified paper type. ColorSync is available with the PCL3GUI driver only.
ColorSync can be selected under Mac OS X 10.4 from the Color Options panel: select
Use Embedded (ICC/ColorSync) from the Source Profile drop-down list. Under Mac
OS X 10.5 and 10.6, ColorSync can be selected from the Color Matching panel.

You are recommended to consult the Knowledge Center (see Knowledge Center on page 189) to see
how to use the color management options of your particular application.
To choose between Application-Managed Colors and Printer-Managed Colors:
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●

In the Windows driver dialog: select the Color tab.

●

In the Mac OS Print dialog: select the Color Options panel.

●

In some applications: you can make this choice in the application.
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If you want to print a particular job and to see approximately the same colors that you would get from
printing the same job on a different HP Designjet printer, you can use the emulation mode provided by
your printer.
NOTE: This option is available only when printing an HP-GL/2, PostScript or PDF job. It will work
correctly only when printing on plain, coated or heavyweight coated paper.
●

In the Windows HP-GL/2 or PostScript driver dialog: select the Color tab, then Printer
Managed Colors, then select Printer Emulation from the Source Profile list. You can then
select from the Emulated Printer list.

●

In the Mac OS Print dialog (T2300): select the Color Options panel, then Color
Management > Printer, then select Printer Emulation from the Source Profile list.

●

In the Mac OS Print dialog (T2300 PS): select the Color Options panel, then select from
the Printer Emulation list.

Color adjustment options
The aim of color management is to print accurate colors. If you perform color management correctly,
then you should be able to print accurate colors with no need of any manual color adjustments.
However, manual adjustments may be useful in the following situations:
●

If your color management is not working correctly for some reason

●

If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color
or in grayscale. If you are printing in pure black and white, there are no color adjustment options.

Printing in color
You can adjust the colors of your print in similar ways under Windows and Mac OS:
●

In the Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

●

In the Mac OS Print dialog (T2300): select the Color Options panel, select Color from the
Mode list, then press the Adjust button.

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): select the Color
Options panel, select Color from the Mode list, then press the Adjust button.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): select the Color Options
panel, then Lightness and Hue.

Under either operating system, you will then be able to make adjustments using a lightness slider and
three color sliders.
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Color management
●

The lightness slider simply makes the whole print lighter or darker.

●

The color sliders can be used to fade or emphasize each of the primary colors in the print. The
primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the
color model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can adjust the gray balance of your print in similar ways under Windows and Mac OS:
●

In the Windows driver dialog: select the Color tab, ensure that the Advanced color
adjustments box is checked, then press the Settings button beside it.

●

In the Mac OS Print dialog (T2300): select the Color Options panel, select Grayscale
from the Mode list, then press the Adjust button.

●

In the Mac OS X 10.5 and 10.6 PostScript Print dialog (T2300 PS): select the Color
Options panel, select Grayscale from the Mode list, then press the Adjust button.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): select the Color Options
panel, then Print in Grayscale, then the Gray balance tab.

Under either operating system, you will then be able to make adjustments using separate controls for
highlights, midtones and shadows.
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●

The lightness slider simply makes the whole print lighter or darker. This slider is available in the
same window as the other grayscale controls, except under Mac OS X 10.4, where it is available
by selecting Lightness and Hue.

●

The zone definition sliders can be used to define what you mean by highlight, midtone and
shadow.

●

The other controls for highlight, midtone and shadow can be used to adjust the gray balance of
highlights, midtones and shadows respectively.

The Reset button restores each control to its default setting.

Color management from printer drivers (T2300 PS)
This facility is available when printing with the PostScript driver.

HP Professional PANTONE Emulation
When you use a named PANTONE color in an image, your application will normally send to the
printer a CMYK or RGB approximation to that color. But the application does not take the printer or the
paper type into account, it merely produces a generic approximation of the PANTONE color, which
will look different on different printers and on different papers.
HP Professional PANTONE Emulation can do a much better job by taking into account the
characteristics of the printer and the paper type. The results look as similar to the original PANTONE
colors as is possible on a given printer using a given paper type. This technology is designed to
produce emulations similar to those set up manually by prepress professionals.
To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on
by default.
●

In the Windows PostScript driver dialog: go to the Color tab and select HP
Professional PANTONE Emulation.

●

In the Mac OS Print dialog: go to the Color Options panel and select HP Professional
PANTONE Emulation.

You can also use the Embedded Web Server to print a swatch book showing emulations of PANTONE
colors as made by your printer, together with a measure of the color difference (ΔE) between each
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emulation and the original PANTONE spot color. So HP Professional PANTONE Emulation not only
provides the closest match that can be achieved on your printer; it also gives clear information on how
close the emulation is to the original spot color. See Printing PANTONE swatch books on page 97.

Color emulation
Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and
CMYK devices such as presses and printers.
You can set color emulation in the following ways:
●

In the Windows PostScript driver dialog: select the Color tab, and Printer Managed
Colors.

●

In the Mac OS Print dialog: select the Color Options panel, then select Printer from the
Color Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The
standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide
the most common standards for the different devices.
The options are as follows.

CMYK color emulation
A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to
the printer, because different printers will produce different colors from the same CMYK data. If the
image file you are printing was not created specifically for your printer, it will require some
readjustment, which can be done using one of the following options provided with your printer.
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●

None (Native): no emulation. The printer will use its default internal conversion from CMYK to
RGB, without following any color standard. This does not imply that results will be bad

●

ISO Coated 2-ECI is based on the characterization dataset FOGRA39L.txt, applicable to the
following reference printing conditions according to the international standard ISO
12647-2:2004/Amd 1: commercial and specialty offset, paper type 1 and 2, gloss or matt
coated paper, positive plates, tone value increase curves A (CMY) and B (K), white backing.

●

Coated GRACoL 2006-ISO12647 provides GRACoL proofing and printing on Grade 1
coated paper, ISO 12647-2 Paper type 1.

●

PSO Uncoated ISO12647-ECI is based on the characterization data set FOGRA47L.txt,
applicable to the following reference printing condition according to the international standards
ISO 12647- 2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset,
paper type 4, uncoated white paper, positive plates, tone value increase curves C (CMY) and D
(K), white backing.

●

PSO LWC Improved-ECI is based on the characterization data set FOGRA45L.txt, applicable
to the following reference printing condition according to the international standards ISO
12647-2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset,
improved LWC paper (light weight coating), positive plates, tone value increase curves B (CMY)
and C (K), white backing.

●

Web Coated SWOP 2006 Grade 3 provides SWOP® proofing and printing on U.S. Grade
3 coated publication paper.

●

Web Coated SWOP 2006 Grade 5 provides SWOP® proofing and printing on U.S. Grade
5 coated publication paper.
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U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 350% total area of ink coverage, negative plate,
bright white offset stock.

●

U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using
U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate,
uncoated white offset stock.

●

U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations
using U.S. inks under the following printing conditions: 300% total area of ink coverage, negative
plate, coated publication-grade stock.

●

U.S. Web Uncoated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 260% total area of ink coverage, negative plate,
uncoated white offset stock.

●

Euroscale Uncoated 2 uses specifications designed to produce quality separations using
Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive
plate, uncoated white offset stock.

●

Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher
Association for digital proofing of images in the Japanese magazine/advertising market.

●

Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper.
It is designed to produce quality separations using 350% total ink coverage, positive film and
coated paper.

●

Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated)
paper. It is designed to produce quality separations using 310% total ink coverage, positive film
and uncoated paper.

●

Japan Color 2002 Newspaper uses the Japan Color 2002 for Newspapers specification. It
is designed to produce quality separations using 240% total ink coverage, positive film and
standard newsprint paper.

●

Japan Color 2003 WebCoated is for type 3 coated paper. It is designed to produce quality
separations for standard ISO printing using 320% total ink coverage, positive film, and coated
paper on heat-set web offset presses.

●

JMPA: Japanese standard for offset press.

●

Toyo is designed to produce quality separations for Toyo printing presses.

●

DIC is designed to produce quality separations for Dainippon Ink Company printing presses.

NOTE: These options have no effect if the application is defining its own CMYK space, known as
calibrated CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation
Your printer is provided with the following color profiles:
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●

None (Native): no emulation, for use when the color conversion is done by the application or
operating system, and therefore the data arrive at the printer already color-managed.

●

sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard
space is endorsed by many hardware and software manufacturers, and is becoming the default
color space for many scanners, printers and software applications.

Color management from printer drivers (T2300 PS)
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●

ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space
provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

●

Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety
of desktop publishing applications. Use this space for files that you plan to display on Apple
monitors, or for working with old desktop publishing files.

●

Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to
do print production work with a broad range of colors.

Color management from the Embedded Web Server
Submit Job options
When you send jobs to the printer using the Embedded Web Server's Submit Job page, you have
the following color management options.
If you leave an option set to Default, the setting saved in the job will be used. If the job contains no
setting, the front-panel setting in the printer will be used.
T2300 and T2300 PS options
●

Color/Grayscale: you can choose to print in color, in shades of gray or in pure black and
white.

●

Default RGB source profile: you can choose from a selection of RGB source profiles
recognized by the printer.

●

Printer emulation: you can choose to emulate a different HP Designjet printer. Default: Off (no
printer emulation).

T2300 PS options (with PostScript or PDF jobs)
●

Default CMYK source profile: you can choose from a selection of CMYK source profiles
recognized by the printer. Default: US Coated SWOP v2.

●

Rendering intent: you can select the rendering intent.

●

Black point compensation: you can turn black point compensation on or off.

●

HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation
on or off.

Rendering intent
Rendering intent is one of the settings used when doing a color transformation. As you probably know,
some of the colors you want to print may not be reproducible by the printer. The rendering intent allows
you to select one of four different ways of handling these so-called out-of-gamut colors.
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●

Saturation (graphics): best used for presentation graphics, charts or images made up of
bright, saturated colors.

●

Perceptual (images): best used for photographs or images in which colors blend together. It
tries to preserve the overall color appearance.

●

Relative colorimetric (proofing): best used when you want to match a particular color. This
method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will
be printed accurately. The other methods will probably provide a more pleasing range of colors
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but do not guarantee that any particular color will be printed accurately. It maps the white of the
input space to the white of the paper on which you are printing.
●

Absolute colorimetric (proofing): the same as relative colorimetric, but without mapping the
white. This rendering is also used mainly for proofing, where the goal is to simulate the output of
one printer (including its white point).

Perform black point compensation
The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the
source space is mapped into the full dynamic range of the destination space. It can be very useful in
preserving shadows when the black point of the source space is darker than that of the destination
space. This option is allowed only when the Relative colorimetric rendering intent is selected (see
Rendering intent on page 96).

Printing PANTONE swatch books
You can use the Embedded Web Server to print a swatch book showing emulations of PANTONE
colors as made by your printer, together with a measure of the color difference (ΔE) between each
emulation and the original PANTONE spot color.
To print a swatch book, select the Embedded Web Server's Main tab, then HP Professional
PANTONE Emulation. Select the PANTONE stock to emulate, and one or more strips of PANTONE
colors that you want to print. You can select color strips from more than one PANTONE stock. When
you have selected all the colors you want, press the Next button. The next window displays your
selection; you can press Print to print that selection, or Back to change the selection.
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Color management from the front panel
You can color-calibrate the loaded paper type from the front panel by pressing

, then

, then

Image quality maintenance > Calibrate color. See Color calibration on page 88.
The other color options in the front panel can all be found by pressing

, then

, then Setup >

Printing preferences > Color options.
NOTE: These front panel settings can all be overridden by the printer driver or by Embedded Web
Server job submission settings.
T2300 and T2300 PS options
●

Color/Grayscale: you can choose to print in color or in shades of gray. Default: Print in
color.

●

Select RGB source profile: you can choose from a selection of RGB source profiles recognized
by the printer. Default: sRGB (HP).

●

Emulate printer: you can choose to emulate a different HP Designjet printer. Default: Off (no
printer emulation).
TIP: If you have old HP-GL/2 or PostScript files made for a different HP Designjet printer, you
can send them to the printer and use the front panel to turn on the appropriate emulation mode.
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T2300 PS options (with PostScript or PDF jobs)
●

Select CMYK source profile: you can choose from a selection of CMYK source profiles
recognized by the printer. Default: US Coated SWOP v2.

●

Select rendering intent: you can select the rendering intent. Default: Perceptual.

●

Black point compensation: you can turn black point compensation on or off. Default: On.

●

HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation
on or off. Default: On.

Color management and the scanner
The files obtained from your scanner (TIFF, JPEG, PDF) contain an embedded ICC profile corresponding
to the type of paper selected prior to making the scan. When you load these files into any image
reader software application, the information of the ICC profile is automatically used for optimum color
appearance on your monitor. When you print a scanned image, or copy an original, the embedded
ICC profile is also automatically used by the printer for optimum printing results.
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●

Print a draft for revision with the correct scale

●

Print a project

●

Print a presentation

●

Print and scale from Microsoft Office
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Print a draft for revision with the correct scale
This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat
In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to
check the plot size.

2.

Select File > Print and ensure that Page Scaling is set to None.

Printing examples

1.

NOTE: The page size will not be automatically selected according to the drawing size.
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Press the Properties button and then select the Paper/Quality tab.

4.

Choose whatever Document Size and Print Quality you want to use. If you want to define a
new custom paper size, press the Custom button.

5.

Select the Features tab, and then Autorotate.

Printing examples

3.
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Click OK, and check that the print preview in the Print dialog box seems correct.

Printing examples

6.

Print a project
This section demonstrates how to print a project from AutoCAD and the Embedded Web Server.

Using AutoCAD

ENWW

1.

The AutoCAD window can show a model or layout. Normally a layout is printed rather than the
model.

2.

Click the Plot icon at the top of the window.

Print a project
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3.

The Plot window opens.

4.

You can see further options by pressing the circular button in the lower right corner of the window.

NOTE: The Quality option here does not refer to the final print quality but to the quality of
AutoCAD viewport objects that are sent for printing.
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Press the Properties button.

6.

Select the Device and Document Settings tab, and press the Custom Properties button.

Print a project

Printing examples

5.
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7.

In the Paper/Quality tab, check the Show preview before printing box, and select the
paper type that you intend to use.

Printing examples

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection on page 72).
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8.

Select the print quality (your own choice between speed and quality of printing).

9.

If you intend to print on roll paper, you must decide where the printer should cut the paper. Press
the Margins/Layout button and select Clip contents by margins.
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10. Select the Features tab, then select the Autorotate and Crop lines options. Autorotation can
help to avoid wasting paper, and the crop lines will show you where to cut the paper after
printing.

11. Press the OK button and save your configuration changes to a PC3 file.
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12. When you have pressed the OK button in the Plot window, the printer will construct a print
preview.

Printing examples

Using the Embedded Web Server to submit files
From the HP Utility or the Embedded Web Server, select Job Center > Submit Job. With some Web
browsers, you will see the window below; with other Web browsers, the mechanism for adding files is
slightly different.
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●

HP-GL/2

●

RTL

●

TIFF

●

JPEG

●

PDF (T2300 PS only)

●

PostScript (T2300 PS only)

NOTE: When you print to a file, the file should be in one of the above formats, but its name may
have an extension such as .plt or .prn.
If the files are not in one of these formats, they will not be printed successfully.
If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and the project will be sent to the printer.
If you need to specify printing settings, go to the Job settings section and select the options you need.
Each option has explanatory text on the right, so that you can understand the behavior of each setting.
Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job
contains no setting, the setting in the printer will be used.

Using printer emulation
Printer emulation can be requested by selecting Advanced settings > Color > Color
management > Printer emulation.
You can select Off (no printer emulation) or the name of the printer model that you want to emulate.
This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

Using clip contents by margins
You can select this margins option from Advanced settings > Paper > Layout/Margins > Print
with margins > Layout > Clip contents by margins.
Use this option when the contents to be printed have white borders and a size equal to that of the
paper you have selected. The printer will use the white border for its margins and you will get a page
of size equal to that which is selected in the driver.

Print a presentation
This section demonstrates how to print a presentation from AutoCAD and from Photoshop.
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Press the Add files button (or Choose File, Add another file) to choose the files from your
computer that you want to print. The files must be in one of the following formats:

Using AutoCAD

Printing examples
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1.

Open the AutoCAD file and select a layout.

2.

Click the Plot icon at the top of the window.

3.

Ensure that the correct printer is selected, then press the Properties button.
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Select the Device and Document Settings tab, and press the Custom Properties button.

5.

In the Paper/Quality tab, check the Show preview before printing box, and select the
paper type that you intend to use.

Printing examples

4.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection on page 72).
6.
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Select the print quality (your own choice between speed and quality of printing).

Print a presentation
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7.

If you intend to print on roll paper, you must decide where the printer should cut the paper. Press
the Margins/Layout button and select Clip contents by margins.

8.

If you are using photo or glossy paper, you can select Borderless printing.

9.

Select the Features tab, then select the Autorotate and Crop lines options. Autorotation can
help to avoid wasting paper, and the crop lines will show you where to cut the paper after
printing.
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10. Press the OK button and save your configuration changes to a PC3 file.

11. When you have pressed the OK button in the Plot window, the printer will construct a print
preview.
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Using Adobe Photoshop
1.

In Photoshop CS5, select File > Print and then select your printer.

Printing examples
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Choose from the available paper sizes.

Printing examples

2.

If you do not find the paper size that you intend to use, press the Custom button. Enter the width,
the length and the name of your custom paper size. Press the Save and OK buttons.
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Select Show preview before printing. You may also wish to change the default paper
source, paper type and print quality.

4.

In the Color tab, the default color management option is Printer managed colors, and this is
the correct option because you have already selected Printer Manages Colors in Photoshop.

Printing examples

3.

Print and scale from Microsoft Office
This section demonstrates how to print and scale from Microsoft Office.
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1.

Select the Office Button, then Print, and select the name of your printer.

2.

Select Properties > Features > Print document on to scale the document to a particular
size.

Print and scale from Microsoft Office

Printing examples

Using PowerPoint
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3.

Select the Paper/Quality tab, then select Paper Source and Paper Type.

4.

Select Margins/Layout, then select Clip contents by margins to keep the size.

Using Project
1.

118

Select File > Page Setup > Print.
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Select your printer's name, then Close.

3.

Select Page Setup, and choose the Paper Size you want.

4.

Select Options to go to the printer driver. The default options in the Paper/Quality tab are
probably suitable: Paper source: Printer auto select and Paper Type: Any.

Print and scale from Microsoft Office

Printing examples

2.
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5.

Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Project.

Printing examples

Using Excel
1.
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Select the Office Button, then Print. Select your printer's name, then click Close.
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Select the Page Layout tab, then Size, and choose the paper size you want.

3.

Select the Office Button, then Print > Properties to go to the printer driver. In the Paper/
Quality tab, select Paper source, Paper Type and Print Quality.

Printing examples

2.
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4.

Select Features > Print document on to scale the document to a particular size. Alternatively,
you can scale the document in Excel.

Printing examples
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13 Retrieving usage information

Get accounting information

●

Check usage statistics

●

Check usage statistics for a job

●

Request accounting data by E-mail

Usage information

●
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Get accounting information
There are various different ways of getting accounting information from your product.
●

View product usage statistics for the whole lifetime of the product, see Check usage statistics
on page 124.

●

View ink and paper usage for each of your recent jobs by using the HP Utility, see Check usage
statistics for a job on page 125. If the HP Utility is not available, see Access the HP Utility
on page 37.

●

Request accounting data by E-mail. The product sends data in XML at regular intervals to a
specified E-mail address; the data may be interpreted and summarized by a third-party
application, or displayed as an Excel spreadsheet. See Request accounting data by E-mail
on page 125.

●

Use a third-party application to request product status, product usage or job accounting data from
the product through the Internet. The product provides data in XML to the application whenever
requested. HP provides a Software Development Kit to facilitate the development of such
applications.

Usage information

Check usage statistics
There are various ways of checking your product's usage statistics.
NOTE: The accuracy of the usage statistics is not guaranteed.
From the Embedded Web Server
1.

Access the Embedded Web Server, see Access the Embedded Web Server on page 37.

2.

Go to the Main tab.

3.

Select History > Usage.

From the HP Utility
1.

Access the HP Utility, see Access the HP Utility on page 37.

2.

Under Windows, go to the Overview tab and click on the Printer usage link.
Under Mac OS, select Information > Printer Usage and click on the Lookup button.

From the front panel
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1.

Press

.

2.

Press

.

3.

Press Internal prints.

4.

Press User information prints.

5.

Press Print usage report.
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Check usage statistics for a job
There are two ways to check usage statistics for a particular job.
NOTE: The accuracy of the usage statistics is not guaranteed.

Accounting statistics with the HP Utility
1.

Access the HP Utility, see Access the HP Utility on page 37.

2.

Select Job center to view information regarding the most recent jobs.

3.

Under Windows, click on the Accounting link.
Under Mac OS, select Job Accounting and click on the Look Up button.

1.

Access the Embedded Web Server, see Access the Embedded Web Server on page 37.

2.

Go to the Main tab.

3.

Select History > Accounting.

Request accounting data by E-mail
1.

Obtain the IP address of the outgoing mail server (SMTP) from your IT department; this is required
in order to send e-mail messages.

2.

Ensure that the outgoing e-mail server is configured to enable relaying of e-mail messages that the
product will send.

3.

Open your Web browser and connect to the product’s Embedded Web Server.

4.

Select the Setup tab.

5.

From the Configuration menu in the left-hand column, select Date & Time.

6.

Ensure that the product's date and time have been set correctly.

7.

From the Configuration menu, select E-mail server..

8.

Enter the IP address of the outgoing mail server (SMTP).

9.

Specify an e-mail address for the product. The latter does not need to be a valid e-mail address,
because the product will not receive messages; but it should have the form of an e-mail address. It
serves to identify the product when it sends e-mail messages.

10. From the Configuration menu, select Printer settings.
11. In the Accounting section, if you set Require account ID to On, then every time someone sends
a print job to the product, he or she must provide an account ID: for example, an ID
corresponding to his or her department or to a specific project or client. If someone sends a job
without providing an account ID, the product will hold the unidentified job in the queue without
printing it until an account ID is provided.
If you set Require account ID to Off, then the product will print all jobs whether or not they
have an account ID.
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Accounting statistics with the Embedded Web Server

12. Set Send accounting files to Enabled.
13. Set Send accounting files to to the e-mail address (or addresses) to which you want the
accounting information sent. This may be an address that you have created specifically to receive
automatically generated messages from the product.
14. Set Send accounting files every to the frequency with which you want the information sent,
choosing a specific number of days or prints.
15. You may want to set Exclude personal information from accounting e-mail to On, so
that the accounting messages will not contain personal information. If this option is Off,
information such as user name, job name, and account ID will be included.
When you have completed the above steps, the product will send accounting data by E-mail with the
frequency that you specified. The data are provided in XML and can easily be interpreted by a thirdparty program. The data provided on each print job include when the job was submitted, when the job
was printed, the printing time, the type of image, the number of pages, the number of copies, the paper
type and size, the amount of each color of ink used and various other attributes of the job. Accounting
data are also provided on scan and copy jobs.
You can download an Excel template from HP's Web site (http://www.hp.com/go/designjet/
accounting/) that will enable you to display the XML data more readably in the form of a spreadsheet.

Usage information

Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of
your product. You can, for instance:
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●

Bill each customer for the total amount of ink and paper used by that customer over a particular
period.

●

Bill each customer separately per job.

●

Bill each customer separately for each project, broken down by job.
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About the ink cartridges
Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper.
To purchase additional cartridges, see Accessories on page 148.
CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive
devices (see the Glossary on page 197). Avoid touching pins, leads and circuitry.

Check the ink cartridges status
To view the ink levels of your ink cartridges, press

on the front panel, then

. There is a

Replace ink cartridges option on the ink information page in case you want to do so (see also
Remove an ink cartridge on page 128).
To get more information on your ink cartridges, you can press the color of the cartridge on which you
want information.
You can also get this information from the HP Utility.
For an explanation of the ink cartridge status messages, see Ink cartridge status messages
on page 169.

HP Utility procedures
●

In the HP Utility for Windows, go to the Overview tab, each cartridge's status is under
Supplies Status > Cartridges.

●

In the HP Utility for Mac OS, select Printer Status in the Information group.

Remove an ink cartridge
There are two occasions when you need to remove an ink cartridge.

Ink and printheads

●

The ink cartridge is very low and you want to replace it with a full cartridge for unattended
printing (you can use up the remaining ink in the first cartridge at a more convenient time).

●

The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION: Remove an ink cartridge only if you are ready to insert another one.
CAUTION: Make sure the product wheels are locked (the brake lever is pressed down) to prevent the
product from moving.
NOTE: When a cartridge runs out of ink, the current job is not automatically cancelled: unless you
cancel it manually, it will resume printing when the empty cartridge has been replaced. If there is a
delay in replacing the cartridge, you may see some banding on the print.
1.

From the front panel, press
Alternatively, press
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, then

, then

, then Replace ink cartridges.

, then Ink > Replace ink cartridges.
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2.

Open the ink cartridge cover on the left-hand side of the product.

3.

Grip the cartridge you wish to remove.

4.

Pull the cartridge straight up.

NOTE: Avoid touching the end of the cartridge that is inserted into the product, as there may be
ink on the connection.

5.

Ink and printheads

NOTE: Avoid storing partially used ink cartridges.

The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge
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1.

Before removing the cartridge from its wrapping, shake it vigorously.

2.

Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or
letters (in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on
the cartridge label.

Insert an ink cartridge
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3.

Insert the ink cartridge into its slot.

4.

Push the cartridge into the slot until it snaps into position. You should hear a beep and see
confirmation that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 169.
When all cartridges have been inserted, close the cover.

6.

The front-panel display confirms that all cartridges have been correctly inserted.

Ink and printheads

5.

About the printheads
The printheads are connected to the ink cartridges and jet ink onto the paper.
CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices
(see the Glossary on page 197). Avoid touching pins, leads and circuitry.
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Check the printhead status
The product automatically checks and services the printheads after each print. Follow the steps below to
get more information on your printheads.
1.

From the front panel, press

2.

The front panel displays:

then

, then the printhead on which you want information.

●

Colors

●

Product name

●

Product number

●

Serial number

●

Status, see Front-panel error messages on page 185

●

Volume of ink it has used

●

Warranty status

You can also get most of this information from the HP Utility.
For an explanation of the printhead status messages, see Printhead status messages on page 175.
If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the HP
Legal Information document provided with your product for details of the warranty implications.

Remove a printhead
Ink and printheads

CAUTION: Make sure the product wheels are locked (the brake lever is pressed down) to prevent the
product from moving.

CAUTION: Printhead replacement must be performed with the product powered on.
1.

From the front panel, press
Alternatively, press

2.

, then

, then

, then Replace printheads.

, then Ink > Replace printheads.

The printer moves the carriage into the correct position.
CAUTION: If the carriage is left in the removal position for more than three minutes without
inserting or removing any printheads, it tries to move back to its normal position in the right-hand
end.

3.

ENWW

When the carriage has stopped moving, the front-panel display asks you to lift the scanner.

Check the printhead status
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4.

Locate the carriage on the right side of the printer.

5.

Pull the handle up and toward you to release the wire loop.

6.

Push the handle back to raise the lid.

Ink and printheads
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This gives you access to the printheads.

8.

To remove a printhead, lift up the blue handle.

9.

Using the blue handle, use steady force to disengage the printhead.

Ink and printheads

7.

ENWW

Remove a printhead
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10. Pull the blue handle upward until the printhead is released from the carriage.
CAUTION:

Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

Insert a printhead
Remove the orange protective caps by pulling them down.

2.

The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check
that the colored label on the printhead matches the colored label of the carriage slot into which
the printhead is to be inserted.

Ink and printheads

1.
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3.

Insert the new printhead into its correct slot in the carriage.
CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you
insert it too fast, or at an angle, or if you rotate it as you insert it.

Push down as indicated by the arrow shown below.

CAUTION: When installing the new printhead there may be some resistance, so you need to
press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel
display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead
on page 169.
5.

ENWW

Insert all other printheads that need to be installed, and close the carriage lid.

Insert a printhead
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4.

6.

Ensure the end of the blue handle catches the wire loop on the near side of the carriage.

7.

Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer
beeps.
NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front-panel display, the printhead may need to be reinserted.

Ink and printheads
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8.

Lower the scanner.

9.

The front-panel display confirms that all printheads are correctly inserted. The printer starts
checking and preparing the printheads. The default routine process, when all printheads are
changed, takes 10 minutes. If the printer finds problems in preparing the printheads, it takes
longer, up to 45 minutes. For a single printhead insertion, the times vary between 2 and 40
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minutes. After all printheads are checked and prepared, the printhead realignment procedure runs
automatically if paper is loaded, see Align the printheads on page 173.

Ink and printheads

10. You are recommended to perform a color calibration after inserting a new printhead. See Color
calibration on page 88.
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Secure Disk Erase
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Check product status
You can check the current status of the product in various ways:
●

If you start the HP Utility and select your product, you see a page of information describing the
status of the product and its paper and ink supplies.

●

If you access the Embedded Web Server, you see information about the general status of the
product. The Supplies page in the Main tab describes the status of the paper and ink supplies.

●

At the front panel, you can press

for information about paper, ink levels, ink cartridges, and

printheads. If there is a current problem, you are taken automatically to the area with the most
urgent problem.
If there are any current alerts, the upper row of the home screen shows the top-priority alert. Press
the alert message to see a list of all current alerts.

Clean the exterior of the product
Clean the outside of the product and all other parts of the product that you regularly touch as part of
normal operation with a damp sponge or a soft cloth and a mild household cleaner such as nonabrasive liquid soap.
WARNING! To avoid an electric shock, make sure that the product is turned off and unplugged
before you clean it. Do not let water get inside the product.
CAUTION: Do not use abrasive cleaners on the product.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, replace a cartridge when it reaches its expiration date. The front panel
notifies you when any cartridge reaches its expiration date.
You can also check a cartridge's expiration date at any time: see Check product status on page 139.
See also Handling ink cartridges and printheads on page 127.

Clean the scanner’s glass plate
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1.

Turn off the product using the Power key at the front, then also turn off the power switch at the rear
and disconnect the power cable.

2.

There is a small lever at the rear left of the scanner. Slide the lever to the right and open the
scanner cover.

Check product status
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You are recommended to clean the scanner's glass plate periodically, depending on how often you use
the scanner.

3.

Gently wipe the glass plate and the surrounding area with a lint-free cloth dampened with water
and then wrung dry. A suitable cloth is provided with the product.
CAUTION: Do not use abrasives, acetone, benzene or fluids that contain these chemicals. Do
not spray liquids directly onto the scanner glass plate or anywhere else in the scanner.

Do not worry about tiny droplets of water left on the glass: they will evaporate.
4.

Optionally, for more thorough cleaning:
●

Remove the glass plate and clean it on both sides. See Replace the scanner’s glass plate
on page 141.

●

Clean the pressure rollers (between the feed rollers).

Product maintenance
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5.

Close the scanner cover and gently push it down to lock it into place.

6.

Clean the area immediately in front of the scanner, where the scanned sheet rests before
scanning.

7.

Reconnect the product's power cable, turn on the power switch at the rear, and turn on the
product using the Power key.

Replace the scanner’s glass plate
Over time, the condition of the glass plate can deteriorate. Small scratches on the surface of the glass
can reduce image quality. Contact HP Support (see Contact HP Support on page 191) to order a new
glass plate.

ENWW

Turn off the product using the Power key at the front, then also turn off the power switch at the rear
and disconnect the power cable.

2.

There is a small lever at the rear left of the scanner. Slide the lever to the right and open the
scanner cover.

3.

Remove the plastic insert.

4.

Remove four small parts as shown.

Product maintenance

1.

Replace the scanner’s glass plate
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5.

Press down the four white plastic tabs.

6.

Simultaneously, lever up the glass at each end with a small implement. (You may need several
people for this operation.)

7.

Remove the glass.

Product maintenance
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8.

Insert the new glass. Be very careful not to scratch it. Press the four white plastic tabs until they
click into place

9.

Replace the four parts that you removed initially, to keep the plastic tabs in place.

10. Close the scanner cover and gently push it down to lock it into place.

11. Reconnect the product's power cable, turn on the power switch at the rear, and turn on the
product using the Power key.

Your scanner has been calibrated at the factory, and theoretically CIS scanners do not need to be
recalibrated during their lifetimes. Nevertheless, because of environmental changes, your scanner may
start showing image defects that can be easily corrected by recalibrating the scanner. The whole
procedure takes less than 10 minutes, and you are recommended to recalibrate the scanner whenever
you see some undesired artifact or a lack of quality in scanned files or copies, bearing in mind the
limitations of CIS technology already explained in this guide. If you perform calibration successfully and
still have concerns about the image quality, please read the Image-quality troubleshooting guide in
order to detect whether you are facing a product limitation, and may want to consider buying a CCD
scanner.
To calibrate the scanner
1.

Clean the scanner. See Clean the scanner’s glass plate on page 139.

2.

Go to the front panel and press

, then

, then Image Quality Maintenance >

Calibrate scanner.
3.

ENWW

Follow the instructions in the front panel.

Calibrate the scanner
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Calibrate the scanner

The supplied maintenance sheet required to perform scanner calibration looks like this:

Load the maintenance sheet into the scanner face up, centered and with as little skew as possible.
Once the calibration is finished, the maintenance sheet should be carefully placed into its solid cover,
and saved in a fresh and dry place. Otherwise, it could be damaged, which could affect the operation
of your scanner in the future. Check that the maintenance sheet is not dirty, wrinkled, scratched or
folded before calibrating the scanner. If necessary, call HP support and ask for a new maintenance
sheet.
If calibration fails
1.

Ensure that the product is turned on and ready for normal operation.

2.

Ensure that the scanner is working correctly. To test it, scan a small document to file.

3.

Ensure that the scanner is clean before calibration. If in doubt, clean the scanner and restart the
calibration process.

4.

Eject and reload the calibration sheet, checking that it is clean and in good condition. The sheet
must be perfectly centered in the scanner for correct calibration.

5.

If the above steps do not help, eject the sheet and restart the product (turn off and on). When the
system has restarted, repeat the calibration.

6.

If you cannot perform the calibration successfully in three consecutive attempts, call HP support
and report the error code that appears in the front panel.

Move or store the product
If you need to move or store the product, prepare it correctly to avoid possible damage to it. To
prepare the product, follow the instructions below.

Product maintenance
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1.

Do not remove the ink cartridges or printheads.

2.

Make sure that no paper is loaded.

3.

Make sure that the product is idle.

4.

Disconnect any cables connecting the product to a network or a computer.

5.

Before moving the product through a doorway, remove the foot extensions.
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If you need to leave the product turned off for a long time, follow the additional steps below.
1.

Turn off the power using the Power key on the front panel.

2.

Also turn off the power switch at the rear of the product.

3.

Disconnect the product's power cable.

CAUTION: If you turn the product upside down, ink could escape into the product and cause serious
damage.
When the product is turned back on, it takes about three minutes to initialize itself and to check and
prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the
product has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.
CAUTION: If the product remains off for a long period of time, the printheads may become
unusable. In this case, you need to replace the printheads with new ones.
TIP: Because preparing and purging the printheads uses both time and ink, you are strongly
recommended to leave the product always on or in sleep mode, whenever possible, to maintain the
health of the printheads. In both cases, the product wakes up from time to time to maintain the
printheads. Thus you can avoid going through lengthy preparation processes before using your
product.

Update the firmware
The product's various functions are controlled by software that resides in the product, otherwise known
as firmware.

Firmware updates can be downloaded from the Internet and installed in your product in the following
ways; you can choose whichever you find most convenient.
NOTE: An administrator password may be required.

ENWW

●

Using a USB flash drive. Download the firmware file from the HP Web site into the USB flash drive
and insert it into the Hi-Speed USB host port beside the front panel. A firmware update assistant
will appear on the front panel to guide you through the update process.

●

Using the Embedded Web Server, select the Main tab and then Firmware update.

Update the firmware
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From time to time firmware updates will be available from Hewlett-Packard. These updates increase the
product's functionality and enhance its features.

●

Using the HP Utility under Windows, select your product, the Support tab and then Firmware
Update.

●

Using the HP Utility under Mac OS, select Firmware Update in the Support group.

When using the Embedded Web Server or the HP Utility, follow the instructions on your screen to
download the firmware file and store it on your hard disk. Then select the downloaded file and click
Update.
NOTE: Firmware upgrades are digitally signed by HP. You are not recommended to use unsigned
firmware upgrades. If you attempt to do so, the front panel will ask you to confirm.
If you experience very slow progress while uploading the firmware file to the product, the reason could
be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the
Embedded Web Server directly.
●

In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for
more precise control, click the Advanced button and add the product's IP address to the list of
exceptions, for which the proxy server is not used.

●

In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies:
Change Settings button. Add the product's IP address or its domain name to the list of
exceptions, for which the proxy server is not used.

The firmware includes a set of the most commonly used paper presets. Extra paper presets can be
downloaded separately; see Paper presets on page 50.
You can tell the printer to notify you if your firmware is more than six months old. To do so, select the
Setup tab in the Embedded Web Server, and then Printer settings > Firmware update >
Notification > Enabled. You must specify at least one e-mail address to which notifications should
be sent. If you specify more than one, they should be separated by a semicolon or comma.
NOTE: You must also ensure that the product's e-mail server is configured. See Request accounting
data by E-mail on page 125.

Update the software
To update printer drivers and other software for your product, go to http://www.hp.com/go/T2300/
drivers/.
If your operating system is Windows, HP Software Update regularly offers to update your software
automatically.

Product maintenance

Product maintenance kits
Four maintenance kits are available for your product, containing components that may need to be
replaced after long use. When one of them is needed, a message is displayed on the front panel and
by the HP Utility.
When you see the message, you should contact HP Support (see Contact HP Support on page 191)
and request the maintenance kit. The kits are installed by service engineers only.
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Secure Disk Erase
The product's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase
facility can completely erase your information from the hard disk to protect it from unauthorized access.
You can choose to erase particular files, or the whole hard disk.
Secure Disk Erase provides three different levels of security:
●

Non-Secure Fast Erase: all pointers to the information are erased. The information itself
remains on the hard disk until the disk space it occupies is needed for other purposes, and it is
then overwritten. While it remains on the disk, it is difficult for most people to access, but may be
accessed using software designed for the purpose. This is the normal method in which files are
erased on most computer systems; it is the fastest method but the least secure.

●

Secure Fast Erase: all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but
more secure. It may still be possible to access fragments of the erased information by using special
tools to detect residual magnetic traces.

●

Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense
5220-22.m requirements for clearing and sanitization of disk media. This is the default security
level when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based
print management software: see http://www.hp.com/go/webjetadmin/.
If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support: see
Contact HP Support on page 191.

Product maintenance

NOTE: If you choose to erase the whole hard disk, you may be asked to restart the product several
times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure
Sanitizing Erase.
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How to order supplies and accessories
There are two alternative ways to order supplies or accessories for your product:
●

Visit http://www.hp.com/go/T2300/accessories/ on the Web.

●

Contact HP Support (see Contact HP Support on page 191).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your product.
Table 16-1 Ink cartridges
Cartridge

Part number

HP 72 69 ml Photo Black Ink Cartridge

C9397A

HP 72 69 ml Cyan Ink Cartridge

C9398A

HP 72 69 ml Magenta Ink Cartridge

C9399A

HP 72 69 ml Yellow Ink Cartridge

C9400A

HP 72 69 ml Gray Ink Cartridge

C9401A

HP 72 130 ml Matte Black Ink Cartridge

C9403A

HP 72 130 ml Photo Black Ink Cartridge

C9370A

HP 72 130 ml Cyan Ink Cartridge

C9371A

HP 72 130 ml Magenta Ink Cartridge

C9372A

HP 72 130 ml Yellow Ink Cartridge

C9373A

HP 72 130 ml Gray Ink Cartridge

C9374A

HP 726 300 ml Matte Black Ink Cartridge

CH575A

Table 16-2 Printheads
Printhead

Part number

HP 72 Gray & Photo Black Printhead

C9380A

HP 72 Magenta & Cyan Printhead

C9383A

HP 72 Matte Black & Yellow Printhead

C9384A

Order paper
The following paper types are currently provided for use with your printer.
NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/T2300/accessories/.
NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.
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Key to availability:
●

(A) indicates papers available in Asia (excluding Japan)

●

(C) indicates papers available in China

●

(E) indicates papers available in Europe, the Middle East and Africa

●

(J) indicates papers available in Japan

●

(L) indicates papers available in Latin America

●

(N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.
Table 16-3 Roll paper
Paper type

g/m²

Length

Width

Part numbers

80

45.7 m (150 ft)

594 mm (23.39 in) (A1)

Q8003A (AJ)

610 mm (24 in)

Q1396A

914 mm (36 in)

Q1397A

1067 mm (42 in)

Q1398A

594 mm (23.39 in) (A1)

Q8004A (EAJ)

841 mm (33.11 in) (A0)

Q8005A (EAJ)

420 mm (16.54 in) (A2)

Q1446A (J)

594 mm (23.39 in) (A1)

Q1445A (EJ)

610 mm (24 in)

C1860A (LN),
C6035A (AEJ)

841 mm (33.11 in) (A0)

Q1444A (EJ)

914 mm (36 in)

C1861A (LN),
C6036A (AEJ)

91.4 m (300 ft)

914 mm (36 in)

C6810A

45.7 m (150 ft)

420 mm (16.54 in) (A2)

CG892A (E)

610 mm (24 in)

CG889A (EN)

914 mm (36 in)

CG890A (EN)

1067 mm (42 in)

CG891A (EN)

610 mm (24 in)

CG883A (EN)

914 mm (36 in)

CG884A (EN)

1067 mm (42 in)

CG885A (EN)

610 mm (24 in)

CG886A (EN)

914 mm (36 in)

CG887A (EN)

1067 mm (42 in)

CG888A (EN)

HP Bond and Coated Paper
HP Universal Inkjet Bond Paper

91.4 m (300 ft)

HP Bright White Inkjet Bond Paper

HP Recycled Bond Paper

HP Cockle-free Coated Paper

HP Cockle-free Heavyweight Coated
Paper

150
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80

100

170

45.7 m (150 ft)

45.7 m (150 ft)

30.5 m (100 ft)
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Paper type

g/m²

Length

Width

Part numbers

HP Universal Coated Paper

95

45.7 m (150 ft)

610 mm (24 in)

Q1404A (AEJN)

914 mm (36 in)

Q1405A (AEJN)

1067 mm (42 in)

Q1406A

420 mm (16.54 in) (A2)

Q1443A (J)

457 mm (18 in)

Q7897A (EJN)

594 mm (23.39 in) (A1)

Q1442A (EJ)

610 mm (24 in)

C6019B

841 mm (33.11 in) (A0)

Q1441A (EJ)

914 mm (36 in)

C6020B

1067 mm (42 in)

C6567B

91.4 m (300 ft)

914 mm (36 in)

C6980A

30.5 m (100 ft)

610 mm (24 in)

Q1412A (AEJN)

914 mm (36 in)

Q1413A

1067 mm (42 in)

Q1414A (AEJN)

610 mm (24 in)

C6029C (AEJN)

914 mm (36 in)

C6030C

1067 mm (42 in)

C6569C

67.5 m (225 ft)

1067 mm (42 in)

Q1956A (EN)

30.5 m (100 ft)

610 mm (24 in)

Q6626A (AEJN)

914 mm (36 in)

Q6627A (AEJN)

1067 mm (42 in)

Q6628A (AEJN)

HP Coated Paper

HP Universal Heavyweight Coated
Paper

HP Heavyweight Coated Paper

HP Super Heavyweight Plus Matte
Paper

90

120

131

210

45.7 m (150 ft)

30.5 m (100 ft)

HP Colored Paper Fluorescent
Yellow

100

45.7 m (150 ft)

914 mm (36 in)

Q1757A (E)

HP Colored Paper Yellow

92

45.7 m (150 ft)

914 mm (36 in)

Q1760A (EN)

90 m (295.3 ft)

594 mm (23.39 in) (A1)

Q6596A (E)

45.7 m (150 ft)

420 mm (16.54 in) (A2)

Q1440A (J)

594 mm (23.39 in) (A1)

Q1439A (J)

610 mm (24 in)

C3869A

841 mm (33.11 in) (A0)

Q1438A (J)

914 mm (36 in)

C3868A

610 mm (24 in)

C3860A (AJN)

914 mm (36 in)

C3859A (LN)

Accessories

Table 16-3 Roll paper (continued)

HP Technical Paper
HP Natural Tracing Paper

HP Translucent Bond
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90

67

45.7 m (150 ft)
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Table 16-3 Roll paper (continued)
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Paper type

g/m²

Length

Width

Part numbers

HP Vellum

75

45.7 m (150 ft)

610 mm (24 in)

C3862A (N)

914 mm (36 in)

C3861A (LN)

610 mm (24 in)

C3876A (AEJN)

914 mm (36 in)

C3875A

610 mm (24 in)

51642A (AEJN)

914 mm (36 in)

51642B

HP Film (Technical and Graphic)
HP Clear Film

HP Matte Film

174

160

22.9 m (75 ft)

38.1 m (125 ft)

HP Polyester Film White Matte

167

15.2 m (50 ft)

914 mm (36 in)

Q1736A (AEN)

HP Vivid White Glossy Polyester
Film

230

20.1 m (66 ft)

610 mm (24 in)

CG827A (EJN)

1067 mm (42 in)

CG828A (EJN)

610 mm (24 in)

Q6574A

914 mm (36 in)

Q6575A

1067 mm (42 in)

Q6576A

610 mm (24 in)

Q6579A

914 mm (36 in)

Q6580A

1067 mm (42 in)

Q6581A

HP Photographic Paper
HP Universal Instant-Dry Photo Gloss

HP Universal Instant-Dry Photo SemiGloss

190

190

30.5 m (100 ft)

30.5 m (100 ft)

TIP: The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for
more than two weeks, you should laminate them to achieve longer life.
HP Premium Plus Photo Gloss

280

15.2 m (50 ft)

610 mm (24 in)

Q5488A

HP Premium Plus Photo Satin

280

15.2 m (50 ft)

457 mm (18 in)

Q7920A

610 mm (24 in)

Q5491A

610 mm (24 in)

Q1426A (AEJN)

914 mm (36 in)

Q1427A (AEJN)

1067 mm (42 in)

Q1428A (AEJN)

610 mm (24 in)

Q1420A (AEJN)

914 mm (36 in)

Q1421A (AEJN)

1067 mm (42 in)

Q1422A (AEJN)

HP Universal High-Gloss Photo
Paper

HP Universal Semi-Gloss Photo
Paper

HP Photo Paper RC Matte

190

190

30.5 m (100 ft)

30.5 m (100 ft)

200

30.5 m (100 ft)

914 mm (36 in)

C7946A (AEN)

160

22.9 m (75 ft)

914 mm (36 in)

C7960A (AEJN)

22.9 m (75 ft)

914 mm (36 in)

Q1914A (AEN)

1067 mm (42 in)

Q1915A (AEN)

HP Backlit Material
HP Backlit Film Reverse Print Matte

HP Self-Adhesive Material and Laminate
HP Two-View Cling
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Paper type

g/m²

Length

Width

Part numbers

HP Indoor Paper Self-Adhesive

170

22.9 m (75 ft)

610 mm (24 in)

CG948A (EN)

914 mm (36 in)

Q1733A (EJN)

HP Matte Adhesive-back
Polypropylene

225

21.3 m (70 ft)

914 mm (36 in)

Q1908A (AEN)

HP Colorfast Adhesive Vinyl

328

12.2 m (40 ft)

914 mm (36 in)

C6775A

HP Adhesive-backed Polypropylene

128

50 m (164 ft)

914 mm (36 in)

Q8044A (C)

1067 mm (42 in)

Q8884A (C)

610 mm (24 in)

CG843A

914 mm (36 in)

CG824A

1067 mm (42 in)

CG825A

914 mm (36 in)

Q8834A

1067 mm (42 in)

Q8835A

HP Everyday Adhesive Matte
Polypropylene

HP Self-adhesive Gloss
Polypropylene

180

180

22.9 m (75 ft)

22.9 m (75 ft)
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Table 16-3 Roll paper (continued)

Table 16-4 Sheet paper
Paper type

g/m²

Length

Width

Part numbers

90

610 mm (24 in)

457 mm (18 in)

Q1961A (AEJN)

914 mm (36 in)

610 mm (24 in)

Q1962A (AEN)

483 mm (19 in)

330 mm (13 in)

Q5486A

610 mm (24 in)

457 mm (18 in)

Q5487A

483 mm (19 in)

330 mm (13 in)

Q5489A

610 mm (24 in)

457 mm (18 in)

Q5490A

HP Bond and Coated Paper
HP Coated Paper

HP Photographic Paper
HP Premium Plus Photo Gloss

HP Premium Plus Photo Satin

280

280

Order accessories
The following accessories can be ordered for your product.
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Name

Product number

HP Designjet PostScript Upgrade

CN500A

HP Designjet External Hard Disk Accessory

CN501A

HP Designjet T2300 44-in Spindle

Q6709A

HP Designjet T2300 Rear Deflector Extension

CN727-40043

HP Jetdirect 635n IPv6/IPsec Print Server

J7961A

HP Web Jetadmin

See http://www.hp.com/go/webjetadmin/

How to order supplies and accessories
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Introduction to the accessories
PostScript upgrade
The PostScript upgrade provides a PostScript interpreter, enabling you to send PostScript and PDF files
to the printer and save scanned images as PDF files. The PostScript upgrade should be plugged into the
Hi-Speed USB host port at the rear of the product.

External hard disk accessory
This external hard disk enables you to remove the hard disk for security reasons. It should be plugged
into the Hi-Speed USB host port at the rear of the product.
NOTE: Other external hard disk drives are not supported because they may exceed the USB
standard power supply requirements.

Spindle
With extra spindles, you can change rapidly from one paper type to another.

Jetdirect print server
Jetdirect print servers support extra connectivity and security options beyond those provided in the
standard Gigabit Ethernet interface built into the product.

HP Web Jetadmin
HP Web Jetadmin is an imaging and printing device management tool that helps optimize HP Designjet
utilization, control supplies costs, secure HP Designjets and streamline supplies management by
enabling remote batch configuration and management, proactive monitoring, troubleshooting and
usage reporting of HP Designjets.
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●

The paper cannot be loaded successfully

●

The paper type is not in the driver

●

The printer printed on the wrong paper type

●

An “on hold for paper” message

●

Paper jam in the printer

●

A strip stays on the output tray and generates jams

●

The printer displays out of paper when paper is available

●

Prints do not fall neatly into the basket

●

The sheet stays in the printer when the print has been completed

●

The paper is cut when the print has been completed

●

The cutter does not cut well

●

The roll is loose on the spindle

●

Recalibrate the paper advance

Paper issues

17 Troubleshooting printer paper
issues
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The paper cannot be loaded successfully
●

Ensure no paper is loaded.

●

Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.

●

Do not attempt to straighten the paper during the aligning process, unless instructed to do so by
the front-panel display. The printer automatically attempts to straighten the paper.

●

The paper may be crumpled, or warped, or may have irregular edges.

General unsuccessful roll load issues
Paper issues

●

If the paper does not load, the leading edge of the paper may not be straight or clean and needs
to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary
even with a new roll of paper.

●

Ensure the roll ends are tight against the spindle ends.

●

Check that the spindle is correctly inserted.

●

Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards
you.

●

Check that all roll end plugs have been removed.

●

Check that the paper is wound tightly on the roll.

●

Do not touch the roll or paper at during the alignment process.

●

When loading a roll, the roll cover must remain open until the front panel asks you to close it.

●

When loading the upper roll, avoid inserting the paper into the cut sheet slot.

Unsuccessful roll load
If the paper has not been inserted straight, the front panel displays the following instructions.
1.

When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to
straighten the roll.

2.

When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the roll is aligned, the printer asks you to close the roll cover, and you are now ready to print.
If the roll is still not aligned, the front panel displays an error and instructions to start again.
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If you would like to start the load process again, cancel the process on the front panel and rewind
the roll from the end of the spindle until the edge is removed from the printer.
NOTE: If the roll has become loose around the core, the printer cannot load the paper.

●

Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

●

Ensure that the sheet is aligned with the reference line on the roll cover.

●

Do not attempt to straighten the sheet during the loading process, unless instructed to by the frontpanel display.

●

Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, please follow the instructions given on the front-panel display.
If you would like to start the load process again, cancel the process on the front panel; the printer ejects
the sheet from the front of the printer.

Paper loading error messages
Here is a list of front-panel messages related to paper loading, with the suggested corrective action.
Front-panel message

Suggested action

Close the roll cover when the paper load
is finished

Close the roll cover when the paper load is finished.

Lever lifted

During the load process the blue lever was lifted. This prevents the printer from
loading the paper. Follow the instructions on the front-panel display.

Paper incorrectly loaded

The paper has not been loaded correctly. Lift the blue lever, remove the paper and
lower the lever.

Paper loaded with too much skew

During the paper load process the printer detected that the paper had too much
skew. Follow the instructions on the front-panel display.

Paper loose around core

The end of the roll has become loose around the core. Tighten the paper to the
core or insert a new roll.

Paper not detected

During the paper load process the printer did not detect any paper. Ensure the
paper is inserted fully and is not transparent.

Paper too big

During the load process the printer has detected that the paper is either too wide or
too long (sheet only) to be loaded correctly. Press

to stop the load process.

See Functional specifications on page 194.
Paper too small

During the load process the printer detected that the paper is too narrow or too
short to be loaded in the printer. Press

to stop the load process. See Functional

specifications on page 194.

ENWW

Roll cover closed during paper load
process

Do not close the roll cover until you are asked to do so by the front panel.

Upper roll load and paper is inserted
through the single sheet path

Avoid inserting roll paper into the cut sheet slot.

The paper cannot be loaded successfully
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Paper issues

Unsuccessful sheet load

The paper type is not in the driver
To work with a paper not in the driver, you can use your paper as one of the presets already in the
driver, however, you must identify whether your paper is transparent or translucent, glossy or matte.
NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print
well on glossy paper.

Transparent or translucent paper
Paper issues

If your paper is a transparent film (for example, a transparency), select paper type Film >
Transparent/Clear film.
If your paper is a translucent paper (for example, technical paper), select paper type Technical
paper > Natural Tracing Paper, Vellum or Translucent bond.

Glossy paper
If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select
paper type Photo Gloss Paper. For Semi-gloss, Satin, Pearl or Luster finishes, select paper type
Semi-gloss/Satin Paper.
To increase gamut on photo paper, select paper type HP Universal High-Gloss Photo Paper or
HP Universal Semi-Gloss Photo Paper, depending on the finish.

Matte Paper
Your paper type selection for matte paper depends on the paper’s ink absorption capacity. To select a
paper category and type, first identify if your paper is general purpose or photographic. Then select
the recommended paper types.

General-purpose paper
●

For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural
Tracing Paper > 65 g/m2, depending on the weight of the paper.

●

For thin papers (< 90 g/m2) uncoated papers (for example plain paper or bright white paper)
select paper type Bond and Coated Paper > Plain Paper.

●

For light coated papers (< 110 g/m2), select paper type Bond and Coated Paper > HP
Coated Paper.

●

For heavyweight coated papers (< 200 g/m2), select paper type Bond and Coated Paper >
Heavyweight Coated Paper.

●

For cockle-free very thick coated papers (> 200 g/m2), select paper type Bond and Coated
Paper > Super Heavyweight Coated Paper.

Photographic paper
For photographic paper, select paper type Photo Paper > Photo Matte Paper.

Black ink is easily removed when touched
This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select
paper type Photo Paper > Photo Gloss Paper.

158

Chapter 17 Troubleshooting printer paper issues

ENWW

After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used. To use less ink, select a thinner category. Matte paper
categories from thinnest to thickest are:
●

Plain Paper

●

Coated Paper

●

Heavyweight Coated Paper

●

Super Heavyweight Coated Paper

Paper issues

For other image quality problems, see Troubleshooting print-quality and scan-quality issues
on page 180.

The printer printed on the wrong paper type
If the printer prints your job before you were able to load your desired paper, you may have Any
selected for the Paper Type in the printer driver. When Any is selected the printer will print
immediately on whichever paper is loaded. Load your desired paper, see Printer paper handling
on page 41, and select your paper type specifically in the driver.
●

In the Windows driver dialog: select the Paper/Quality tab, then select your paper type
from the Paper Type list.

●

In the Mac OS Print dialog (T2300): select the Paper/Quality panel, then select your
paper type from the Paper Type list.

●

In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): select the Paper/
Quality panel, then select your paper type from the Paper Type list.

●

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): select the Image Quality
panel, then select your paper type from the Paper Type list.

NOTE: Any is the driver default.

An “on hold for paper” message
Based on a set of conditions that you can set when sending a job (see Paper mismatch action
on page 32), the printer will decide which of the loaded rolls of paper is more suitable to print the job.
If there is no roll of paper available that meets all the conditions, the printer will put the job on hold for
paper. You can manually resume the job, forcing it to print on a paper other than the one originally
specified, otherwise it will stay on hold.

Which criteria are used to decide on which roll a job will be
printed?
When a user sends a job, the desired paper type can be set (in the driver or in the Embedded Web
Server). The printer will print the job on a roll of paper of the chosen paper type that is large enough to
print the drawing without clipping. If there is more than one roll on which the job could be printed
meeting all the criteria, the roll will be chosen according to your preferences. These can be set from the
front panel: see Roll switching options on page 32.
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The printer printed on the wrong paper type
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When is a job put on hold for paper?
If the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 32), a job
is put on hold for paper in the following cases:
●

The paper type that has been selected by the user is not currently loaded on the specified roll—or
on either of the rolls, if no roll has been specified.

●

The paper type that has been selected by the user is loaded on the specified roll, but the drawing
is too large to fit on the roll—or on either of the rolls, if no roll has been specified.

Paper issues

If I load a new roll of paper, will jobs that were on hold for paper
be automatically printed?
Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for
paper that could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can I prevent it?
Yes, this can be done from the front panel: see Paper mismatch action on page 32.

I set the option “Paper mismatch action” to Print anyway, but
some jobs are still put on hold
If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are
put on hold until you have checked the preview and resumed the job. Check that the Show print
preview option is not checked in the driver, and that there are no pending preview windows waiting
for confirmation to continue printing.

My job is exactly as wide as the roll of paper that is loaded on the
printer, but is put on hold for paper
Margins are managed in different ways depending on the file type:
●

For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm
(36 in) HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be
put on hold for paper.

●

For other file formats, such as PostScript, PDF, TIFF or JPEG, the printer assumes that margins need
to be added outside the drawing (as, in many cases, these formats are used for photographs and
other images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the
printer needs to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed;
this would cause the job to be put on hold if the paper that is loaded on the printer is only 914
mm (36 in) wide.
If you wish to print these file formats without adding extra margins outside of the drawing, the
Clip contents by margins option can be used. This option will force the margins to be set
inside of the drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper
without being put on hold. However, if there is no white space already included in the drawing’s
borders, some contents could be clipped because of the margins.
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Paper jam in the printer
When a paper jam occurs, you normally see the Possible paper jam message in the front-panel
display.
Power off the product at the front panel and also switch it off at the rear.

2.

Lift the scanner.

3.

Try to move the printhead carriage out of the way.

Paper issues

1.

ENWW

Paper jam in the printer
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Paper issues

4.

Lift the blue lever as far up as it will go.

5.

Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

CAUTION:
6.
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Do not move the paper sideways, as it could damage the printer.

Rewind the roll. If the paper is stuck and cannot be rewound further, cut it from the roll.
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Remove all pieces of paper from the rear of the printer.

8.

Lower the blue lever.

9.

Lower the scanner.

Paper issues

7.

Paper jam in the printer
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10. Switch on the product.

Paper issues

11. Reload the roll, or load a new sheet see Printer paper handling on page 41.
NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the
procedure and carefully remove all pieces of paper.

A strip stays on the output tray and generates jams
If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a fullbleed print or after the front panel option Form feed and cut has been used, the cut strip remains in
the output tray. Only when the printer is not printing, reach into the tray and remove the strip.

The printer displays out of paper when paper is
available
If the roll has become loose from its core, it will not feed correctly and the printer will not load the
paper. If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket
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●

Ensure the basket is correctly installed.

●

Ensure the basket is open.

●

Ensure the basket not full.

●

Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll,
or remove prints manually as they are completed.
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The sheet stays in the printer when the print has
been completed
The printer holds the paper to allow the print to dry after printing, see Change the drying time
on page 52. If the paper is only partially ejected after the drying time, gently pull the sheet out of the
printer. If the automatic cutter is disabled, use the Form feed and cut option in the front panel, see
Feed and cut the paper on page 53.

The paper is cut when the print has been completed
Paper issues

By default the printer cuts the paper after the drying time has been completed, see Change the drying
time on page 52. You can disable the cutter, see Turn the automatic cutter on and off on page 52.

The cutter does not cut well
By default the printer is set to automatically cut the paper after the drying time has been completed.
If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any
obstacles.

The roll is loose on the spindle
The roll may need to be replaced or reloaded.

Recalibrate the paper advance
Accurate paper advance is important to image quality because it is part of controlling the proper
placement of dots on the paper. If the paper is not advanced the proper distance between printhead
passes, light or dark bands appear in the print and image grain may increase.
The printer is calibrated to advance correctly with all the papers appearing in the front panel. When
you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while
printing. However, if you are not satisfied with the default calibration of your paper, you may need to
recalibrate the rate at which the paper advances. See Troubleshooting print-quality and scan-quality
issues on page 180 for steps to determine if paper advance calibration will solve your issue.
You can check the paper advance calibration status of the currently loaded paper at any time by
and then
on the front panel. The status may be one of the following.
pressing
●

DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers in
the Front Panel have been optimized by default and unless you experience image quality
problems in your printed image such as banding or graininess it is not recommended to
recalibrate the paper advance.

●

OK: This status indicates that the loaded paper has been calibrated before. However you may
need to repeat the calibration if you experience image quality problems such as banding or
graininess in your printed image.
NOTE: Whenever you update the product’s firmware, the paper advance calibration values are
reset to factory default, see Update the firmware on page 145.
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CAUTION: Transparent papers and films must be calibrated by pressing

, then

, then

Image Quality Maintenance > Paper advance calibration > Adjust paper advance, from
step four in Recalibrating the paper advance procedure.

Recalibrating the paper advance procedure
1.

From the front panel, press

, then

, then Image Quality Maintenance > Paper

advance calibration > Calibrate paper advance. The printer automatically recalibrates the
paper advance and prints a paper advance calibration image.
2.

Wait until the front panel displays the status screen and re-print your print.

Paper issues

NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the
paper advance calibration image. The front-panel display shows any errors in the process.
If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration,
return to the default calibration, see Return to default calibration on page 167.
3.

If you would like to fine-tune the calibration or are using a transparent paper, press

, then

, then Image Quality Maintenance > Paper advance calibration > Adjust paper
advance.
4.

Select the percentage of change from –100% to +100%. To correct light banding, decrease the
percentage.

To correct dark banding, increase the percentage.
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5.

Press OK on the front panel, to save the value.

6.

Wait until the front panel displays the status screen and reprint your print.
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Return to default calibration
Returning to the default calibration sets all the corrections made by the paper advance calibration to
zero. To return to the default paper advance calibration value, you must reset the calibration.
1.

From the front panel, press

, then

, then Image Quality Maintenance > Paper

advance calibration > Reset paper advance.
Wait until the front panel displays the operation has completed successfully.

Paper issues

2.
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Recalibrate the paper advance
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●

Cannot insert an ink cartridge

●

Ink cartridge status messages

●

Cannot insert a printhead

●

The front-panel display recommends reseating or replacing a printhead

●

Clean the printheads

●

Clean the printhead drop detector

●

Align the printheads

●

Printhead status messages
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Cannot insert an ink cartridge
1.

Check that you have the correct type of cartridge (model number).

2.

Check that the colored label on the cartridge is the same color as the label on the slot.

3.

Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label
right-side up and readable.

CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages
●

OK: the cartridge is working normally, with no known problems.

●

Missing: there is no cartridge present, or it is not correctly connected to the product.

●

Low: the ink level is low.

●

Very low: the ink level is very low.

●

Empty: the cartridge is empty.

●

Reseat: you are recommended to remove the cartridge and then reinsert it.

●

Replace: you are recommended to replace the cartridge with a new cartridge.

●

Altered: there is something unexpected about the cartridge's status.

●

Expired: it is past the cartridge's expiration date.

Ink system issues

These are the possible ink cartridge status messages:

Cannot insert a printhead
1.

Check that you have the correct type of printhead (model number).

2.

Check that you have removed the two orange protective caps from the printhead.

3.

Check that the colored label on the printhead is the same color as the label on the slot.

4.

Check that the printhead is correctly oriented (compare with the others).

5.

Check that you have correctly closed and latched the printhead cover, see Insert a printhead
on page 134.

The front-panel display recommends reseating or
replacing a printhead
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1.

From the front panel, turn the power off then on.

2.

Check the front-panel display message, if it shows the ready message, the printer is ready to print.
If the problem remains continue with the next step.

3.

Remove the printhead, see Remove a printhead on page 131.

Cannot insert an ink cartridge
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4.

Clean the electrical connections on the backside of the printhead with a lint free cloth. You can
carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.
CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles
on the bottom side of the printhead, especially not with any alcohol.

Ink system issues

5.

Reinsert the printhead, see Insert a printhead on page 134.

6.

Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printheads
As long as the product is kept turned on, automatic cleaning is performed periodically. This ensures
there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy.
To clean the printheads, go to the front panel and press

, then

, then Image Quality

Maintenance > Clean printheads. If you have gone through the Image Quality Diagnostic print
process (see the Image-quality troubleshooting guide), you know which colors are failing. Select the
pair of printheads which contain the failing colors. If you are not sure which colors to clean, you can
also select to clean all printheads. Cleaning all printheads takes about nine minutes. Cleaning a single
pair of printheads takes about six minutes.
NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

Clean the printhead drop detector
The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in
order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces,
block the sensor print-quality is affected.
When the front panel displays a warning message that the clean process is needed, you are
recommended to clean the printhead drop detector. If you do not clean the printhead drop detector
immediately, the printer continues working normally, however, the front panel display continues to
show the warning.
CAUTION: Wear gloves to avoid getting ink on your hands.
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Turn off the product with the Power key.

2.

To avoid an electric shock, switch the product off and unplug it.

3.

Lift the scanner.

Ink system issues

1.

Clean the printhead drop detector
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Ink system issues
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4.

Find the printhead drop detector beside the stored printhead carriage.

5.

Remove any debris blocking the printhead drop detector.

6.

With a dry lint free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7.

Lower the scanner.
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8.

Plug in and switch on the product.

9.

Turn the product on using the Power key.

Align the printheads
Ink system issues

Precise alignment between printheads is essential for accurate colors, smooth color transitions and
sharp edges in graphical elements. Your printer has an automatic printhead alignment process which
runs whenever a printhead has been accessed or replaced.
In cases where the paper has jammed or you are experiencing problems with color accuracy, see
Color management on page 87; you may need to align the printheads.
NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the
realignment procedure by pressing
, then
, then Image Quality Maintenance > Align
printheads.
CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure
1.

If the realignment process is running and the wrong paper is loaded, press

on the front panel.

CAUTION: Do not print if the realignment process has been canceled. You can restart the
alignment by pressing
, then
, then Image Quality Maintenance > Align
printheads.
2.

Load the paper you wish to use, see Printer paper handling on page 41. You can use a roll that is
at least 610 mm (24 in) wide or a cut sheet that is A2 landscape or larger.
CAUTION:

3.
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Do not use transparent or semi-transparent paper to align the printheads.

Remove and re-insert all the printheads, see Remove a printhead on page 131 and Insert a
printhead on page 134. This starts the printhead alignment procedure.

Align the printheads
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4.

Ensure that the scanner is lowered, as a strong light source near the printer during printhead
realignment can affect alignment.

5.

The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.
NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel
display shows any errors in the process.

Ink system issues

Image Quality Maintenance menu procedure
1.

Load the paper you wish to use, see Printer paper handling on page 41. You can use a roll or cut
sheet, however, it must be A3 landscape or larger (420 by 297 mm).
CAUTION:

2.

Do not use transparent or semi-transparent paper to align the printheads.

From the front panel, press

, then

, then Image Quality Maintenance > Align

printheads. The printer checks to see if it has enough paper to run the realignment.
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3.

If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment
pattern. Ensure that the scanner is lowered, as a strong light source near the printer during
printhead realignment can affect alignment.

4.

The process takes about five minutes. Wait until the front-panel display shows the process
complete before using the printer.
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Scanning errors during alignment
If the alignment process fails, a Scanning problems message appears on the front panel. This means
that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment
should be repeated before printing with good image quality. The problem may be due to:
●

The paper used was not valid, repeat the alignment with valid paper.

●

Printhead health problems, clean printheads, see Clean the printheads on page 170.

●

The alignment was done with the scanner raised, repeat the alignment with the scanner lowered.

If the problem persists after using valid paper, cleaning the printheads and keeping the scanner
lowered, there may be a failure in the scanning system needing reparation or the printheads, although
clean, may not work and need to be replaced.

Printhead status messages
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●

OK: the printhead is working normally, with no known problems

●

Missing: there is no printhead present, or it is not correctly installed in the printer.

●

Test printhead separately: you are recommended to test the printheads individually to find
the failing printhead. Remove all the printheads and insert them alone one by one, closing the
latch and the carriage cover after every insertion. The front-panel display indicates the failing one
showing the reseat or replace message.

●

Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the
electrical connections, see The front-panel display recommends reseating or replacing a printhead
on page 169. If that fails, replace the printhead with a new printhead, see Remove a printhead
on page 131 and Insert a printhead on page 134.

●

Replace: the printhead is failing. Replace the printhead with a working printhead, see Remove a
printhead on page 131 and Insert a printhead on page 134.

●

Replacement incomplete: a printhead replacement process has not completed successfully, relaunch the replacement process and let it finish completely (it is not needed to change the
printheads).

●

Remove: the printhead is not a suitable type for use in printing.

Printhead status messages
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These are the possible printhead status messages:

19 Troubleshooting other printer
issues

The printer does not print
If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons
why a file you have sent from your computer may not start printing when expected:

Printer issues

●

You may have an electrical power problem. If there is no activity at all from the product, and the
front panel does not respond, check that the power cable is connected correctly and that there is
power available at the socket.

●

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic
fields or severe electrical disturbances, which can cause the product to behave strangely or even
stop working. In this case, turn off the product using the Power key on the front panel and unplug
the power cord, wait until the electromagnetic environment has returned to normal, then turn it on
again. If you still experience problems, please contact your customer service representative.

●

Nesting may be on and the printer is waiting for the specified nest wait time before calculating the
appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

●

You may have the wrong graphic language setting, see Change the printer's graphic language
setting on page 40.

●

You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

●

If you are printing on a sheet, you must specify Manual Feed as the paper source in your printer
driver.

●

The printer may be holding the job for paper or accounting information, see Job status messages
on page 85.

●

You may have requested a print preview from your printer driver. This is a function you can use to
check that the image is the one you want. In this case, the preview is displayed on your screen,
and you must click the Print button to start printing.

●

If you are using Mac OS with a USB connection, you may find that you need to change the data
, then
, then Setup > Printing preferences > PS >
encoding (T2300 PS only). Press
Select encoding > ASCII. Then configure your application to send ASCII data.
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The printer seems slow
Here are some possible explanations.
●

Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take
longer.

●

Did you specify the correct paper type when loading the paper? Some paper types require more
time for printing; for example, photo and coated papers require more drying time between
passes. To find out the printer's current paper type setting, see View information about the paper
on page 50.

●

If your printer is connected by network, check that all components used in the network (network
interface cards, routers, switches, cables) are capable of high-speed operation. Is there a lot of
traffic from other devices on the network?

●

If your printer is connected by USB, make sure that the USB host controller is Hi-Speed USB; and
check that the USB cables are Hi-Speed USB certified.

●

Did you specify Extended drying time in the front panel? Try changing the drying time to
Optimal.

Unavailable driver features when printing from
QuarkXpress
●

Print Preview

●

Rotation

●

Resizing

●

Microsoft Office features or paper saving options

●

Back to front printing

Printer issues

When you print from QuarkXPress, the following driver features are not available.

If you are using the HP-GL/2 and HP RTL driver, the following features are not available.
●

Print Preview

●

Back to front printing

To get the same results, use the equivalent features available in QuarkXPress.
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The printer seems slow
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20 Troubleshooting scanner issues

Cannot access the network folder
If you have set up a network folder (see Create a scan-to-network folder on page 26), but the product
cannot access it, try the following suggestions.
●

Check that you have filled in each field correctly.

●

Check that the product is connected to the network.

●

Check that the remote computer is switched on, working normally and connected to the network.

●

Check that the folder is shared.

●

Check that you can put files into the same folder from a different computer on the network, using
the product's logon credentials.

●

Check that the product and the remote computer are in the same network subnet; if they are not,
check that the network routers are configured to forward the CIFS protocol traffic (also known as
Samba).

Scanning to file is slow
Scanning large formats creates large files. This means that scanning to file can take time even under
optimal system configurations and conditions. This is especially true when scanning across a network.
However, if you think scanning to file with your system is unreasonably slow, the following steps may
help you to locate and solve the problem.

Scanner issues
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1.

Use the front panel to check the status of your scan job. If it is taking an intolerably long time, you
can select the job and then cancel it.

2.

Check that the Quality setting is right for the job. Not all scanning tasks require high resolutions.
If you lower the resolution, you will speed up the scanning process.

3.

Check your network configuration. Your network should be a Gigabit Ethernet or one of a higher
transfer rate in order to achieve optimal scanning speeds. If your network is a 10/100 Ethernet
configuration, you can expect slower transfer of the scan data and thus slower scanning speeds.

4.

Contact your network administrator for information about your network configuration, transfer
rates, scan-to-file destinations on the network and possible solutions for increasing the speeds.

5.

If scanning to files on the network is too slow and the network configuration cannot be amended
to correct this, improved speeds can be achieved by scanning to a USB flash drive.

6.

If scanning to a USB flash drive seems slow, check your USB flash drive interface compatibility.
Your system supports a Hi-Speed USB interface. Your USB flash drive should be compatible with
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Hi-Speed USB (sometimes known as USB 2). Also check that your USB flash drive contains enough
storage space for scanned large-format images.

Paper jam in the scanner
In the event of a paper jam in the scanner, the product will ask you to remove the paper.
If removing all of the paper does not solve the problem, the scanner's motor may be faulty.
1.

Open the scanner cover.

When the cover is fully open, underneath you should see red flashing lights, then green, then blue.
In the center of the scanner cover, between the flashing lights, are four small sensors. Put your
fingers over the R, G and B sensors simultaneously, and the scanner motor should advance.

3.

If there is no response from the scanner motor, contact HP Support (see Contact HP Support
on page 191) and explain the situation.

Scanner issues

2.

ENWW

Paper jam in the scanner
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Image-quality issues

21 Troubleshooting print-quality and
scan-quality issues

See the Image-quality troubleshooting guide.
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●

The product will not start

●

Communication failures between computer and product

●

Cannot access the HP Utility

●

Cannot access the Embedded Web Server

●

Automatic file system check

●

Alerts

General product issues

22 Troubleshooting general product
issues
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The product will not start
If the product will not start (the front panel is blank or the diagnostic LEDs are all off), you are
recommended to replace the firmware, in the following way.

General product issues

1.

Go to the Knowledge Center (see Knowledge Center on page 189) and download the firmware.

2.

Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and
formatted with the FAT filesystem.

3.

Ensure that the product is turned off. Connect the USB flash drive to the Hi-Speed USB host port
beside the front panel, then turn the product on.

4.

The product takes about a minute to read the firmware file, then asks you to remove the USB flash
drive.

5.

The product automatically installs the new firmware and restarts.

Communication failures between computer and
product
Some symptoms are:
●

The front-panel display does not show the Receiving message when you have sent an image to
the printer.

●

Your computer displays an error message when you are trying to print.

●

Your computer or product hangs (stays idle), while communication is taking place.

●

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

182

●

Ensure that you have selected the correct printer in your application, see Print from a computer
using a printer driver on page 61.

●

Ensure that the printer works correctly when printing from other applications.

●

Remember that very large prints may take some time to receive, process and print.

●

If the printer is connected to a network, try using it when connected directly to your computer
through a USB cable.

●

If your printer is connected to your computer through any other intermediate devices, such as
switch boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected
directly to your computer.

●

Try another interface cable.

●

Ensure that the graphic language setting is correct, see Change the printer's graphic language
setting on page 40.

●

If the printer is connected by USB cable, try disconnecting and reconnecting the USB cable. Also
try using a different USB port on the computer.
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Cannot access the HP Utility
If you have not done so already, please read Access the HP Utility on page 37.
From the front panel, press

, then

, then Setup > Connectivity > Advanced > Web

Services > Printer utility software > Enabled.
If you still cannot connect, switch the product off and back on with the Power key on the front panel.

General product issues

Cannot access the Embedded Web Server
If you have not done so already, please read Access the Embedded Web Server on page 37.
NOTE: If you connect directly to your product with a USB cable, use the HP Utility.
From the front panel, press

, then

, then Setup > Connectivity > Advanced >

Embedded Web Server > Allow EWS > On.
If you are using a proxy server, try bypassing the server and accessing the Web server directly.
●

In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for
more precise control, click the Advanced button and add the product's IP address to the list of
exceptions, for which the proxy server is not used.

●

In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies:
Change Settings button. Add the product's IP address or its domain name to the list of
exceptions, for which the proxy server is not used.

If you still cannot connect, switch the product off and back on with the Power key on the front panel.

Automatic file system check
When you turn on the product, you will occasionally see a front panel display similar to the one shown
below.

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.
CAUTION: If you turn the product off before the file system check has finished, the file system could
be seriously damaged, making the product's hard disk unusable. In any case, the file system check will
restart from the beginning whenever you turn the product on again.
A file system check is scheduled every 90 days, in order to maintain the hard disk's file system
integrity.
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NOTE: When the product is powered back on, it takes about three minutes to initialize and check
and prepare the printheads. However, it can take up to 40 under some conditions, for example, when
the product has not been used for a long period of time and requires more time to prepare the
printheads.

Alerts
Your product can communicate two types of alerts:

General product issues

●

Errors: Mainly alerting you to the fact that the product is unable to work normally. However, in
the printer driver, errors can also alert you to conditions that could ruin the print, such as clipping,
even if the printer is able to print.

●

Warnings: Alert you when the product needs attention either for an adjustment, such as a
calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your product's system.
●

Front-panel display: The front panel shows only the most relevant alert at a time. In the case of
a warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on
ink", that reappear when the product becomes idle and there is not another more severe alert.
TIP: From the front panel display you can configure paper mismatch alerts, see Paper suitability
options on page 32.

●

Embedded Web Server: The upper-right corner of the Embedded Web Server window shows
the product status. If there is an alert in the product, the status shows the alert text.

●

Driver: The driver shows alerts. The driver warns about job configuration settings that may
produce a problem in the final output. If the printer is not ready to print, it displays a warning.

●

HP Utility: To see alerts, go to the Overview tab and review the Items needing attention
list on the right-hand side.
By default, alerts are displayed only when you are printing or scanning. If alerts are enabled and
there is a problem that prevents a job from completing, you see a pop-up window, which explains
the reason for the problem. Follow the instructions to achieve your required result.
NOTE: There are environments that do not support bidirectional communication, for example: a
Windows computer connected to the product with USB. In those cases, alerts do not reach the job
owner.
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23 Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so,
please follow the advice in the Recommendation column.
If you see an error message that does not appear here, and you feel in doubt about the correct
response, contact HP Support. See Contact HP Support on page 191.
Table 23-1 Text messages

[Color] cartridge altered
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Recommendation
Check the cartridge.

Front-panel errors

Message

[Color] cartridge has expired

Replace the cartridge. See Handling ink cartridges and
printheads on page 127.

[Color] cartridge is low on ink

Ensure that you have a new cartridge of the same color
ready.

[Color] cartridge is missing

Insert a cartridge of the correct color. See Handling ink
cartridges and printheads on page 127.

[Color] cartridge is out of ink

Replace the cartridge. See Handling ink cartridges and
printheads on page 127.

[Color] cartridge is very low on ink

Ensure that you have a new cartridge of the same color
ready.

[Color] printhead #[n] error: not present

Insert the correct printhead. See Handling ink cartridges and
printheads on page 127.

[Color] printhead #[n] error: please remove

Remove the incorrect printhead and insert a new printhead of
the correct type (color and number). See Handling ink
cartridges and printheads on page 127.

[Color] printhead #[n] error: replace

Remove the non-functional printhead and insert a new
printhead of the correct type (color and number). See
Handling ink cartridges and printheads on page 127.

[Color] printhead #[n] error: reseat

Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead.
See The front-panel display recommends reseating or
replacing a printhead on page 169.

Cutter replacement advised

Contact HP Support to replace the cutter. See Contact HP
Support on page 191.

Job queue notification

Cancel, resume or delete the job. See Job queue management
on page 79.

Maintenance #1 advised

Contact HP Support. See Contact HP Support on page 191.

Maintenance #2 advised

Contact HP Support. See Contact HP Support on page 191.
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Table 23-1 Text messages (continued)
Message

Recommendation

Paper loaded incorrectly: remove paper

Remove the paper and try to reload it.

Paper mispositioned: remove paper

Remove the paper and try to reload it.

Paper path error: incorrectly loaded

Unload and reload the paper.

Paper path error: misaligned

Unload and reload the paper.

Printhead replacement incomplete. Restart it.

Restart the printhead replacement process.

Printheads need individual testing. Do replacement

Test the printheads using the Image Diagnostics Print (see the
Image-quality troubleshooting guide) and replace any that are
not working correctly.

Replace [color] cartridge

Replace the cartridge. See Handling ink cartridges and
printheads on page 127.

Reseat [color] cartridge

Remove and reinsert the same cartridge. See Handling ink
cartridges and printheads on page 127.

Table 23-2 Numerical error codes

Front-panel errors
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Error code

Recommendation

01.0, 01.1, 01.2

Restart the product. If the problem persists, contact HP Support. See Contact HP Support
on page 191.

08:04

Restart the product. If the problem persists, update the product's firmware. See Update the
firmware on page 145. If the problem still persists, contact HP Support. See Contact HP
Support on page 191.

08:08

Retry the operation that you were attempting. If it fails again, restart the product. If the problem
persists, update the product's firmware. See Update the firmware on page 145. If the problem
still persists, contact HP Support. See Contact HP Support on page 191.

09:01

Paper jam in the scanner. See Paper jam in the scanner on page 179.

09:02

Calibrate the scanner. See Calibrate the scanner on page 143.

09:03

Restart the product. If the problem persists, contact HP Support. See Contact HP Support
on page 191.

09:04

Restart the product. If the problem persists, update the product's firmware. See Update the
firmware on page 145. If the problem still persists, contact HP Support. See Contact HP
Support on page 191.

21, 21.1, 22.0, 22.1, 22.2,
22.3, 24

Restart the product. If the problem persists, contact HP Support. See Contact HP Support
on page 191.

61:01

The file format is wrong and the printer cannot process the job. Check the graphic language
setting of your printer (see Change the printer's graphic language setting on page 40). If you
are sending PostScript from Mac OS over a USB connection, select ASCII encoding in both the
driver and the application. Check for the latest firmware and driver releases.

62, 63, 64, 65, 67

Update your product's firmware. See Update the firmware on page 145.

63:01

The product has failed to get an IP address. Connect to another network or change the IPv4
configuration.

71.04

Out of memory. To avoid this, in the HP-GL/2 and HP RTL driver select the Advanced tab
and then Send job as a bitmap.
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Table 23-2 Numerical error codes (continued)
Error code

Recommendation

74:04

The firmware upgrade has failed. Press OK and try again. See Update the firmware
on page 145.

74.1

Try the firmware update again. Do not try to use your computer while the update is in
progress. If the problem persists, contact HP Support. See Contact HP Support on page 191.

74.8:04

The firmware upgrade has failed. Your firmware file may be incorrect; try to download it
again. See Update the firmware on page 145.

79:03

Restart the product. If the problem persists, contact HP Support. See Contact HP Support
on page 191.

79:04

Update your product's firmware. See Update the firmware on page 145.

81:01, 86:01

Please follow the instructions on the front panel. You may be asked to run a test procedure and
write down a numeric code before contacting HP Support. See Contact HP Support
on page 191.

94, 94.1

Restart color calibration. See Color calibration on page 88.

Front-panel errors

The system error log
The product saves a log of system errors that you can access in the following ways.
Using a USB flash drive
1.

Create an empty file named pdipu_enable.log in a USB flash drive.

2.

Insert the USB flash drive into the Hi-Speed USB host port at the front of the product. The log will
be automatically copied into the drive.

Using the Embedded Web Server

ENWW

1.

In your Web browser, go to http://printer IP address/hp/device/webAccess/log.html.

2.

The Embedded Web Server will send you a file called log.tar.gz containing the system error log.

The system error log
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Introduction
HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet,
providing comprehensive, proven support expertise and new technologies to give you unique end-toend support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair
and exchange services, phone and Web support, software updates and self-maintenance services. To
find out more about HP Customer Care, please visit us at:
http://www.hp.com/go/graphic-arts/
or call us on the telephone (see Contact HP Support on page 191). To register your warranty:
http://register.hp.com/

HP Professional Services
Knowledge Center
Enjoy a world of dedicated services and resources to ensure you always get the best performance from
your HP Designjet products and solutions.

●

Multimedia tutorials

●

Step-by-step how-to guides

●

Downloads — the latest product firmware, drivers, software, paper presets, etc.

●

Technical support — online troubleshooting, customer care contacts and more

●

Workflows and detailed advice for completing various printing tasks from particular software
applications

●

Forums for direct contact with the experts, both HP and your colleagues

●

Warranty tracking online, for your peace of mind

●

Latest product information — products, supplies, accessories, software, etc.

●

Supplies Center for all you need to know about ink and paper

HP Customer Care

Join the HP community at the Knowledge Center, your large-format printing community, for 24×7
access to:

The Knowledge Center can be found at the following locations, depending on your product:
●

http://www.hp.com/go/T2300/knowledgecenter/

●

http://www.hp.com/go/T2300ps/knowledgecenter/

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences, you decide the information you need.

HP Start-up Kit
The HP Start-up Kit is the DVD that comes with your product; it contains the product's software and
documentation.

ENWW
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HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your product's warranty beyond the
standard period.
They include remote support. On-site service is also provided if necessary, with two alternative
response-time options.
●

Next business day

●

Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/printservices/.

HP Installation
The HP Installation service unpacks, sets up and connects the product for you.
This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
printservices/.

HP Instant Support
HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic
information from your product and match it with intelligent solutions from HP's knowledge bases,
allowing you to resolve problems as quickly as possible.
You can start an HP Instant Support session by clicking on the link provided on the Troubleshooting
page of your product's Embedded Web Server. See Access the Embedded Web Server on page 37.
To be able to use HP Instant Support:

HP Customer Care

●

You must have a TCP/IP connection to your product, because HP Instant Support is accessible only
through the Embedded Web Server.

●

You must have access to the World Wide Web, because HP Instant Support is a Web-based
service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional
Chinese.
You can find more information about HP Instant Support at http://www.hp.com/go/ispe/.

HP Proactive Support
HP Proactive Support helps reduce costly product downtime by preemptively identifying, diagnosing
and resolving product issues before they become problems for you. HP's Proactive Support tool is
designed to help businesses of all sizes reduce support costs and maximize productivity—all with the
click of a mouse.
A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control
of your printing environment—with a clear focus on maximizing the value of your investment,
increasing product uptime and reducing product management costs.
HP recommends that you enable Proactive Support right away to save you time and prevent problems
before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for
software and firmware updates.
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You can enable Proactive Support in the HP Utility for Windows or the HP Printer Monitor for Mac OS,
where you can specify the frequency of connections between your computer and HP's Web server, and
the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To
change these settings:
●

In the HP Utility for Windows, select the Tools menu, then HP Proactive Support.

●

In the HP Printer Monitor for Mac OS, select Preferences > Monitoring > HP Proactive
Support.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the
problem and recommend a solution. In some cases, the solution may be applied automatically; in other
cases, you may be asked to perform some procedure to solve the problem.

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace
them. Using this program, you can replace parts at your own convenience.
Convenient, easy to use
●

An HP Support Specialist will diagnose and assess whether a replacement part is required to
address a defective hardware component.

●

Replacement parts are express-shipped; most in-stock parts are shipped the very same day you
contact HP.

●

Available for most HP products currently under warranty or contract.

●

Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair/.

HP Customer Care

Contact HP Support
HP Support is available to you by telephone. What to do before you call:
●

Review the troubleshooting suggestions in this guide.

●

Review the relevant driver documentation.

●

If you have installed third-party software drivers and RIPs, see their documentation.

●

If you call one of the Hewlett-Packard offices, please have the following information available to
help us answer your questions more quickly:
◦

The product you are using (the product number and the serial number, found on the label at
the back of the product)

◦

If there is an error code on the front panel, note it down; see Front-panel error messages
on page 185

◦

◦

ENWW

The product's Service ID: at the front panel, press

, then

, then

.

The computer you are using

Customer Self Repair
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◦

Any special equipment or software you are using (for example, spoolers, networks, switchboxes, modems or special software drivers)

◦

The cable you are using (by part number) and where you purchased it

◦

The type of interface used on your product (USB or network)

◦

The software name and version you are currently using

◦

If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, Usage Report and “all pages above” from Service Information
(see Internal prints on page 12)

Telephone number
Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/
country/us/en/wwcontact_us.html.

HP Customer Care
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Functional specifications
Table 25-1 HP 72 ink supplies
Printheads

Two inks in each printhead: gray and photo black, matte black and yellow, and
magenta and cyan

Ink cartridges

Cartridges containing 69 ml of ink: gray, photo black, yellow, magenta and cyan
Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow,
magenta and cyan
Cartridges containing 300 ml of ink: matte black only

Table 25-2 Paper sizes

Roll width

Minimum

Maximum

279 mm (11 in)

1118 mm (44 in)

Roll length

91.4 m (300 feet)

Sheet width (printer)

210 mm (8.3 in)

1118 mm (44 in)

Sheet length (printer)

279 mm (11 in)

1676 mm (66 in)

Sheet width (scanner)

914 mm (36 in)

Sheet length (scanner)

2378 mm (93.62 in)

Table 25-3 Printing resolutions
Print quality

Maximu
m detail

Driver

Rendering
resolution (ppi)

Printing
resolution (dpi)

Best (glossy paper*)

On

HP-GL/2, HP PCL3GUI

1200 × 1200

2400 × 1200

On

PostScript

600 × 600

2400 × 1200

Off

Any

600 × 600

1200 × 1200

Best (other papers)

Off

Any

600 × 600

1200 × 1200

Normal

Off

HP-GL/2

600 × 600

1200 × 1200

PostScript, HP PCL3GUI

300 × 300

1200 × 1200

HP-GL/2

600 × 600

1200 × 1200

PostScript, HP PCL3GUI

300 × 300

1200 × 1200

Fast

Off

Specifications

Economode (heavyweight coated
and glossy paper*)

Off

Any

300 × 300

1200 × 1200

Economode (other papers)

Off

Any

300 × 300

600 × 1200

* For a list of supported glossy papers, see Order paper on page 149.
Scanner resolutions: 200, 300, 600 ppi.
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Table 25-4 Printing margins
Top, right and left margins

5 mm (0.2 in)

Bottom margin (trailing edge)

5 mm (0.2 in) (roll)
17 mm (0.67 in) (sheet)

Table 25-5 Mechanical printing accuracy
±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0
printing material in Best or Normal mode with HP Matte Film roll feed.

Table 25-6 Graphic languages supported
HP Designjet

Languages

T2300 (printing)

HP PCL3GUI, HP-GL/2 and HP RTL, TIFF, JPEG, CALS

T2300 PS (printing)

HP PCL3GUI, HP-GL/2 and HP RTL, TIFF, JPEG, CALS, PDF, PostScript

T2300 (scanning)

TIFF, JPEG

T2300 PS (scanning)

TIFF, JPEG, PDF

Scanner file formats: TIFF, JPEG, PDF.

Physical specifications
Table 25-7 Product physical specifications
Weight

86 kg (189 lb)

Width

1770 mm (69.7 in)

Depth

Minimum: 692 mm (27.2 in)
Maximum: 722 mm (28.4 in)

Height

1046 mm (41.2 in) (1046 mm)

The depth is measured without the upper spindle; ink cover opened; roll covers and basket closed.

Memory specifications
HP Designjet

Dedicated file-processing
memory *

Hard disk

T2300

32 GB

160 GB

T2300 PS

32 GB

160 GB

Specifications

Table 25-8 Memory specifications

* 640 MB physical DRAM
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Power specifications
Table 25-9 Product power specifications
Source

100–240 V ac ±10%, auto-ranging

Frequency

50–60 Hz

Current

<2A

Consumption

< 200 W

Ecological specifications
This product complies with European Union WEEE and RoHS Directives. To determine the ENERGY
STAR qualification status of these product models, please go to http://www.hp.com/go/energystar/.
For the up-to-date ecological specifications of your product, please go to http://www.hp.com/ and
search for “ecological specifications”.

Environmental specifications
Table 25-10 Product environmental specifications
Temperature range

Humidity range

Operating for optimal print quality

15 to 35°C (59 to 95°F)

20 to 80%, non-condensing

Operating for standard printing

5 to 40°C (41 to 104°F)

20 to 80%, non-condensing

Product without consumables

–25 to 55°C (–13 to 131°F)

< 95%

Packed product without consumables

–40 to 70°C (–40 to 158°F)

< 95%

Acoustic specifications
Product acoustic specifications (declared according to ISO 9296).
Table 25-11 Product acoustic specifications
Idle sound power level

4.4 B (A)

Operating sound power level

6.3 B (A)

Idle sound pressure at bystander position

32 dB (A)

Operating sound pressure at bystander position

47 dB (A)

Specifications
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Glossary

AppleTalk
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends
TCP/IP and Bonjour networking instead. HP Designjet products no longer support AppleTalk.
Bonjour
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer
network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services
available on a local area network. It was originally known as Rendezvous.
CCD
Charge-Coupled Devices is a high-quality imaging technology based on charge transfer between adjacent pixels
or cells.
CIS
Contact Image Sensor is an imaging technology based on micro-lenses and LED illumination of each individual
pixel.
Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices
have a limited color gamut and may not be physically capable of matching certain colors precisely.
Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.
Color model
A system of representing colors by numbers, such as RGB or CMYK.
Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can
use the same color model: for instance, monitors generally use the RGB color model, but they have different color
spaces, because a particular set of RGB numbers results in different colors on different monitors.
Cutter
A printer component that slides back and forth across the platen to cut the paper.
ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the
cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic
discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some
precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may
reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type
of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD
sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic
charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum
when handling ESD sensitive devices. Also, avoid working in low humidity environments.
Ethernet
A popular computer networking technology for local area networks.
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Firmware
Software that controls your product's functionality and is stored semi-permanently in the product (it can be
updated).
Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.
Gigabit Ethernet
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet
interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet devices.
Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise
compatible with original USB. Most personal computers today use Hi-Speed USB.
HP RTL
Hewlett-Packard Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.
HP-GL/2
Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.
I/O
Input/Output: this term describes the passing of data between one device and another.
ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color
profiles.
Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.
IP address
May mean an IPv4 address (most likely) or an IPv6 address.
IPSec
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent
between nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications
are usually unaware whether IPSec is being used or not.
IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers
separated by full stops. Most networks in the world use IPv4 addresses.
IPv6 address
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8
groups of hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few
new networks in the world use IPv6 addresses.
Jetdirect
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.
LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.
MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lowerlevel identifier than the IP address. Thus, a device may have both a MAC address and an IP address.
Network
A network is a set of connections that pass data between computers and devices. Every device is able to
communicate with every other device in the same network. This allows data to be moved between computers and
devices, and allows devices such as printers to be shared between many computers.
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Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.
Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are
pulped, dried and pressed.
Platen
The flat surface within the printer over which the paper passes while it is being printed on.
Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.
Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and
deposits it on the paper, through a cluster of nozzles. In the HP Designjet T2300 series, each printhead prints two
different colors.
Rendezvous
Apple Computer's original name for its networking software later known as Bonjour.
Spindle
A rod that supports a roll of paper while it is being used for printing.
TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.
USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your product supports HiSpeed USB (sometimes called USB 2.0).
USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to
print to your product using a USB connection, the computer must be connected to the product's USB device port.
USB host port
A rectangular USB socket such as those on found on computers. A product can control USB devices that are
connected to such a port. Your product has two USB host ports, which it uses to control accessories and USB flash
drives.
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access control 34
accessories
order 153
account ID
requiring 34
accounting 124
accounting data by E-mail 125
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alerts
errors 184
turn on and off 33
warnings 184
B
banding problems 165
basket
output problems 164
black and white 68
black point compensation 97
brightness in front panel 38
buzzer on/off 38
C
calibration
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clean the product 139
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adjustment options 91
advantages 88
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CMYK 88
emulation 94
printer emulation 91
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RGB 88
color management
from drivers 90
from EWS 96
from front panel 98
from PS drivers 93
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options 90
process 88
scanner 99
communication ports 8
components of product 6
computer communication
product/computer
communications issues 182
configure 39
connect the product
choose a method 15
general 15
Mac OS network 19
Mac OS USB 22
Windows network 17
Windows USB 17
crop lines 69
Customer Care 189
Customer Self Repair 191
cutter
on/off 52
D
disk erase, secure 147
draft for revision, print 101
draft printing 66
driver features
QuarkXpress 177
driver preferences 35
drying time
change 52
E
ecological specifications
economize
on ink 72
on paper 70
Embedded Web Server
access 37
cannot access 183
job preview 84
job queue 83
language 38
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usage per job 125
usage statistics 124
environmental specifications 196
erase hard disk securely 147
error messages, front panel 185
external hard disk 154
F
features of product 5
file system check 183
firmware update 145
front panel
brightness 38
job preview 80
job queues 80
language 37
units 38
front panel option
adjust paper advance 166
align printheads 174
allow EWS 183
black point compensation 99
calibrate color 89
calibrate paper advance 166
clean printheads 170
CMYK source profile 99
color/grayscale 98
emulate printer 98
enable buzzer 38
enable crop lines 69
enable cutter 52
enable economode 67
enable maximum detail 68
enable merge 65
form feed and cut 53
modify configuration 39
move paper 51
PANTONE emulation 99
paper mismatch action 32
print quality 62
Printer utility software 183
printhead information 131
rendering intent 99
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replace ink cartridges 128
replace printheads 131
reset paper advance 167
resize 65
RGB source profile 98
roll protection 72
roll switching options 32
select display brightness 38
select drying time 52
select graphics language 40
select language 37
select paper size 62
select paper type 158
select units 38
select wait time 71
sleep mode wait time 38
unload paper 48
front view 6
functional specifications 194
G
graphic language for printing 40
graphic languages 0
gray shades 68
H
hard disk specification 195
hard disk, external 154
HP Care Packs 190
HP Customer Care 189
HP Installation 190
HP Instant Support 190
HP Proactive Support 190
HP Start-up Kit 189
HP Start-up Kit DVD 2
HP Support 191
HP Utility
access 37
cannot access 183
language 38
HP Web Jetadmin 154
I
ink

economical use of 72
usage 125
ink cartridge
about 128
cannot insert 169
insert 129
maintenance 139
order 149
remove 128
specification 0
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status 128
status messages 169
Instant Support 190
internal prints 12
IP address 38
IPSec 16
IPv6 16
J
Jetadmin 154
Jetdirect print server 154
job preview
Embedded Web Server 84
front panel 80
job queue
Embedded Web Server 83
front panel 80
K
Knowledge Center 189
L
language 37
load paper
cannot load 156
general advice 42
paper not in driver 158
roll cannot load 156
roll into printer 44
roll onto spindle 43
sheet 48
sheet cannot load 157
loading paper problems 156
M
main components 6
main features 5
maintenance kits 146
margins
none 68
specification 0
mechanical accuracy 0
memory specifications 195
Microsoft Office
print from 116
models, product 2
move the product 144
multiroll printer 54
N
nesting
turn on and off 32
network folder
cannot access 178

create 26
use 75
network settings 39
O
on hold for paper
enable/disable 160
message 159
order
accessories 153
ink cartridges 149
paper 149
printheads 0
overlapping lines 65
overnight printing 72
P
page size 62
PANTONE emulation 93
PANTONE swatch book 97
paper
advance 53
calibrate the paper
advance 165
cannot load 156
cut after printing 165
displaying information 51
download presets 50
economical use of 70
feed and cut 53
incorrect out of paper 164
jam due to cut strip 164
jam in printer 161
jam in scanner 179
loading error messages 157
maintenance 51
movement 51
not cut well 165
output problems in basket 164
paper not in driver 158
presets 50
print on loaded
paper 64, 159
printed on wrong paper 159
retained by printer 165
roll loose on spindle 165
select type 64
size 62
sizes (max and min) 0
usage 125
view information 50
paper mismatch action 32
paper not in driver 158
paper suitability 32

Index

201

paper types 149
physical specifications 195
ports 8
PostScript upgrade] 154
power
on/off 11
power specifications 196
preferences, Windows driver 35
presentation, print 109
preview a print 66
print from
computer direct 58
Embedded Web Server 60
HP Utility 60
printer driver 61
USB flash drive 57
print job
nesting 70
print preview 66
print quality
select 61
printer does not print 176
printer software
Mac OS uninstall 24
Windows uninstall 18
printhead
about 130
align 173
cannot insert 169
clean; purge 170
insert 134
order 0
remove 131
replace, reseat 169
specification 0
status 131
status messages 175
printhead cleaner
specification 0
printhead drop detector
clean 170
printing 56
printing resolutions 0
Proactive Support 190
product models 2
product status 139
product will not start 182
project, print 103
protect a roll 72
Q
quality, high 67
QuarkXpress, unavailable driver
features 177
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R
rear view 7
rendering intent 96
rescale a print 64
roll paper
load 44
spindle load 43
unload 47
roll protection 72
roll switching options 32
S
safety precautions 2
scale a print 64
scanner
calibration 143
can't access network
folder 178
clean glass plate 139
paper jam 179
replace glass plate 141
scan to file 75
slow scan 178
supported paper types 74
usage 125
secure disk erase 147
security 34
sheet paper
load 48
unload 49
sleep mode wait time 38
slow printing 177
software 10
software update 146
specifications
acoustic 196
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functional 194
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hard disk 195
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margins 0
mechanical accuracy 0
memory 195
paper size 0
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power 196
printing resolutions 0
spindle
roll load 43
statistics
ink cartridge 128

usage 124
usage per job 125
store the product 144
support services
HP Care Packs 190
HP Customer Care 189
HP Instant Support 190
HP Proactive Support 190
HP Start-up Kit 189
HP Support 191
Knowledge Center 189
product installation 190
warranty extensions 190
T
telephone number 192
two rolls 54
U
unattended printing 72
unload paper
roll 47
sheet 49
using this guide 2
W
warranty extensions 190
Web Jetadmin 154
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